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第 1 章 简介

IBM® System Storage™ DS3000 Storage Manager V10（本文档中称为 Storage Man-

ager 软件）是一款可用于管理存储子系统的主机软件。

本文档介绍如何在以下各个操作系统中准备、安装、配置及使用 Storage Manager 软件：

v IBM AIX® V5.2 和 IBM AIX V5.3 以及 IBM AIX V6.1

v Red Hat Enterprise Linux® 4（RHEL 4）

v Red Hat® Enterprise Linux 5（RHEL 5）

v SUSE Linux Enterprise Server 9（SLES 9）

v SUSE Linux Enterprise Server 10（SLES 10）和 SUSE Linux Enterprise Server 10

Service Pack 1

v Sun Solaris 10

注：Storage Manager 10.35 不包含可用于管理 DS3000 存储子系统的 Solaris 客户
机。关于如何设置 Solaris 10 Multiplexed I/O（MPxIO）故障转移驱动程序的信
息，请参阅第 115页的附录 C, 『Solaris 故障转移驱动程序』。

有关列出了 Storage Manager 软件所支持的操作系统的互操作性矩阵，请参阅以下 Web

站点：

v 对于 DS3200：http://www.ibm.com/systems/storage/disk/ds3000/ds3200/

v 对于 DS3300：http://www.ibm.com/systems/storage/disk/ds3000/ds3300/

v 对于 DS3400：http://www.ibm.com/systems/storage/disk/ds3000/ds3400/

从 IBM 支持 Web 站点获取文档
如果固件和文档更新可用，您可以从 IBM Support Web 站点进行下载。Storage Man-

ager 软件可能具有设备随附文档中未描述的功能，并且该文档可能不定期更新以包含这
些功能的相关信息，或者可能新增技术更新来提供存储子系统文档中未包含的其他信
息。要查看更新，请完成以下步骤：

1. 转至 http://www.ibm.com/servers/storage/support/。

2. 在 Select your product 下的 Product family 字段中，单击 Disk systems。

3. 在 Product 字段中，根据情况单击 IBM System Storage DS3200、IBM Sys-
tem Storage DS3300 或 IBM System Storage DS3400。

4. 单击 Go。

5. 完成以下选择：

v 要获取固件更新和自述文件，请单击 Download 选项卡。

v 要获取文档更新，单击 Install and use 选项卡。

注：IBM Web 站点会定期进行更改。查找固件和文档的过程可能与本文档中的描述略
有不同。
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本文档中的注意事项
本文档中使用以下注意事项：

v 注：这些注意事项提供重要的提示、指导或建议。

v 要点：这些注意事项提供的信息或建议可能会帮助您避免不便情况或出现问题。

v 注意：这些注意事项指出可能对程序、设备或数据造成的损坏。注意事项就在可能
会发生损坏的说明或情况之前列出。

Storage Manager 软件联机帮助和诊断
安装完毕后，请查看以下联机帮助系统：

v Enterprise Management 窗口帮助

通过该联机帮助系统可进一步了解如何使用整个管理域。

v Subsystem Management 窗口帮助

通过该联机帮助系统可进一步了解如何管理各个存储子系统。

您可以在 Storage Manager Client 中访问这些帮助系统。在 Enterprise Management 或
Subsystem Management 窗口中，单击 Help 或按 F1。

高级功能部件
高级功能部件提供一些增强功能，您可以使用这些功能执行使用基本型号的存储子系
统执行时受限制或无法执行的任务。要获取更多信息，请参阅第 105页的第 7 章, 『启
用和使用高级功能部件』。

您可以购买 DS3000 存储子系统的以下高级功能部件：

v DS3000 FlashCopy® 扩展许可证

v DS3000 卷拷贝许可证

v DS3000 FlashCopy 卷拷贝许可证

v DS3000 分区扩展许可证

FlashCopy
FlashCopy 功能部件支持创建和管理 FlashCopy 逻辑驱动器。FlashCopy 逻辑驱
动器是存储子系统中另一个逻辑驱动器的逻辑时间点映像，称为基本逻辑驱动
器。FlashCopy 映像是完整物理副本的逻辑等价物，但它的创建速度快很多并且
所需的磁盘空间更少。

由于 FlashCopy 映像是主机可寻址逻辑驱动器，所以您可以在基本逻辑驱动器
保持联机并可供用户访问的情况下使用 FlashCopy 映像执行备份。您还可以写
入 FlashCopy 逻辑驱动器进行应用程序测试或方案开发和分析。允许的最大
FlashCopy 逻辑驱动器数是控制器型号支持的逻辑驱动器总数的一半。

VolumeCopy
VolumeCopy 功能部件是一个基于固件的机制，用于在存储器阵列中复制逻辑驱
动器数据。这个功能部件设计为一个系统管理工具，用于执行将数据转移到其
他驱动器以实现硬件升级、性能管理、数据备份或 FlashCopy 逻辑驱动器数据
复原等任务。
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您可以通过指定两个兼容的驱动器来提交 VolumeCopy 请求。一个驱动器指定
作为“源驱动器”，而另一个指定作为“目标驱动器”。VolumeCopy 请求为持
久请求，因此复制进程的所有相关结果都会传递给您。

注：本文档、Storage Manager Client 程序界面和联机帮助中使用的术语
VolumeCopy 和逻辑驱动器复制可以互换。

分区扩展

您可以使用分区扩展功能，通过几个不同的分区向 SAN 提供存储子系统中的所
有已定义逻辑驱动器。只需将每个已定义分区中的各个逻辑驱动器映射到
LUN（0 - 31）即可实现这一目的。一个逻辑驱动器每次只能映射到一个分区。
在存储分区中，只有主机总线适配器的主机端口在该存储分区中进行了定义的
主机服务器才可以访问映射的逻辑驱动器。这个功能使 DS3000 存储子系统能
作为主机服务器的多重虚拟存储子系统。

分区扩展还允许多个使用不同操作系统且磁盘存储子系统设置各不相同的主机
同时连接到同一个 DS3000 存储子系统。这称为异构主机环境。

需了解的术语
要获取有关术语的更多信息，请参阅 Storage Manager Enterprise Management 窗口或
Storage Subsystem Management 窗口中的联机帮助。

阅读本文档时，您需要理解以下两个术语之间的区别。

管理站 管理站是一种用于管理 DS3000 存储子系统的系统。您可以通过以下任何一种
方法将管理站连接到存储子系统：

v 通过连接到存储子系统中控制器的 TCP/IP 以太网连接（频带外方法）

v 通过与主机服务器上安装的主机代理软件的 TCP/IP 连接，该服务器通过输入/

输出（I/O）路径直接连到存储子系统（频带内方法）

要获取更多信息，请参阅第 6页的『存储子系统管理方法』。

主机服务器
主机服务器是通过 I/O 通路直接连接到 DS3000 存储子系统的服务器。它用于
执行以下任务：

v 提供来自存储子系统的数据（通常以文件形式提供）

v 充当远程管理站存储子系统的连接点

注：

1. 本文档中使用的术语主机和主机服务器可以互换。

2. 主机服务器还能用作管理站。
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硬件要求
表 1 列出了安装 Storage Manager 2 软件的硬件要求。

表 1. Storage Manager 2 软件的硬件要求

硬件组件 要求

管理站（用于运行客户端软
件）

管理站计算机需要具备以下硬件：

v IBM System p® 或带 64 位 PowerPC® 体系结构的 IBM

BladeCenter® POWER™ 服务器

v CD 驱动器

v 鼠标或类似的定位设备

v 系统内存至少为 256 MB（建议 512 MB）

v 以太网网络接口适配器

v 视频适配器支持最低分辨率为 800 x 600。

v 显示器设置为 1024 x 768 像素，64 000 色。允许的最低显示
设置为 800 x 600 像素，256 色。

要点：某些服务器不是为运行图形密集型软件而设计的。如果您
的服务器无法正常显示 Storage Manager 用户界面，您可能需要
升级服务器视频适配器或使用命令行界面（CLI）。

要获取有关主机适配器、光纤网交换机和受管集线器的更多信息，请访问以下
ServerProven® 和互操作性 Web 站点：

http://www.ibm.com/servers/eserver/serverproven/compat/us/

http://www.ibm.com/systems/storage/disk/ds3000/ds3200/

http://www.ibm.com/systems/storage/disk/ds3000/ds3300/

http://www.ibm.com/systems/storage/disk/ds3000/ds3400/

AIX 软件需求
以下部分描述 Storage Manager 软件要求和 IBM AIX 操作系统要求。

Storage Manager 软件要求
第 5页的表 2 列出在 AIX 环境中安装 Storage Manager 软件所需的磁盘空间和管理员
权限。

4 针对 AIX、Linux on POWER 和 Sun Solaris 的 DS3000 Storage Manager 安装和支持指南

http://www.ibm.com/servers/eserver/serverproven/compat/us/
http://www.ibm.com/systems/storage/disk/ds3000/ds3200/
http://www.ibm.com/systems/storage/disk/ds3000/ds3300/
http://www.ibm.com/systems/storage/disk/ds3000/ds3400/


注：表 2 中列出的磁盘空间用于安装后的软件包。在每个软件包的安装过程中，您可能
需要 170 MB 可用磁盘空间。

表 2. AIX 的安装要求（按软件包）

软件包 AIX 的磁盘空间需求

SMclient 130 MB

MPIO 2 MB

SMagent 1 MB

50 MB（如果不安装 SMclient）

SMutil 2 MB

AIX 操作系统要求
管理站或主机服务器必须使用以下某种操作系统。

要点：要了解最新的受支持操作系统和主机软件版本，请阅读 Storage Manager 自述文
件并访问 http://www.ibm.com/servers/eserver/serverproven/compat/us/。

v IBM AIX V5.2

v IBM AIX V5.3

v IBM AIX V6.1

Linux on POWER 软件需求
以下部分描述 Storage Manager 软件要求和 Linux 操作系统要求。

Storage Manager 软件要求
表 3 列出在 Linux 环境中安装 Storage Manager 软件所需的磁盘空间。

表 3. Linux 的安装要求（按软件包）

软件包 磁盘空间要求

Storage Manager Client（SMclient） /opt 中 165 MB，/tmp 中 2 MB，/var 中 1

MB

Linux MPP 2 MB

Storage Manager Agent（SMagent） /opt 中 2 MB

Storage Manager Utility（SMutil） /opt 中 7 MB

Linux 操作系统要求
Linux 操作系统需要以下内核级别：

v 2.6 内核（RHEL 4、SLES 9 和 SLES 10）（适用于 RDAC 修订版 B）

v 2.6 内核（RHEL 5 和 SLES 10 SP1）（适用于 RDAC 修订版 C）

要了解最新的受支持 Linux 操作系统、关于设备驱动程序级别的详细信息以及 Linux 支
持多路径配置的指示信息，请参阅 Storage Manager 软件自述文件。
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存储子系统管理方法
Storage Manager 软件提供以下两种存储子系统管理方法：

v 主机代理（频带内）管理方法（仅适用于 DS3300 和 DS3400）

v 直接（频带外或以太网）管理方法

如果在多个管理站或主机与同一个 DS3000 存储子系统之间建立管理连接，虽然 DS3000

存储子系统同时支持八个活动的管理会话，但是与 DS3000 存储子系统之间最好在同一
时间只有一个活动的管理连接。

主机代理（频带内）管理方法
使用主机代理（频带内）管理方法时，通过主机的 I/O 通路来管理存储子系统。如图 1

所示，既可在主机内处理管理信息，也可以通过网络连接将这些信息传递到管理站。

通过主机代理管理存储子系统具有以下优点：

v 不需要将以太网电缆连接到控制器。

v 不需要动态主机配置协议/引导协议（DHCP/BOOTP）服务器即可将存储子系统连接
到网络。

v 不需要执行第 15页的第 2 章, 『准备安装』中描述的控制器网络配置任务。

v 只需为该主机、而不必为存储子系统中的各个控制器指定主机名或 IP 地址。如果主
机代理服务已安装且正在运行，系统将自动发现连接到该主机的存储子系统。

通过主机代理管理存储子系统具有以下缺点：

图 1. 主机代理（频带内）管理存储子系统
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v 主机代理需要一个称为访问逻辑驱动器的特殊逻辑驱动器来与存储子系统中的控制
器通信。因此，操作系统以及所用主机适配器可配置的逻辑驱动器数比允许的最大
数少一个。

v 如果主机与存储子系统之间通过 I/O 通路进行的连接已断开，就无法管理或监控存储
子系统。

注：访问逻辑驱动器又称为通用 Xport 设备。

要点：如果在主机中已配置最大数量的逻辑驱动器，请使用直接管理方法，或腾出一
个逻辑驱动器用作访问逻辑驱动器。要获取更多信息，请参阅第 14页的『支持
的逻辑驱动器数』。

必需的主机代理（频带内）管理活动
要建立主机代理（频带内）管理连接，请完成以下常规任务：

1. 在 DS3000 存储子系统与主机服务器之间建立 I/O 连接。

2. 在主机服务器上安装 TCP/IP 并确定主机 IP 地址。要获取有关主机管理系统的指示
信息，请参阅第 16页的『网络安装任务概述』。

3. 在主机服务器上安装主机总线适配器设备驱动程序、SMclient、RDAC（用于 AIX 的
MPIO 和用于 Linux 的 Linux MPP）以及 SMagent。

4. 确保 Storage Manager Agent Service 成功启动：

对于 AIX 和 Linux：输入 ps -elf | grep SMagent

5. 打开 Storage Manager Enterprise Management 窗口并将主机服务器的 IP 地址添加
到管理域中。Enterprise Management 窗口中将显示主机服务器识别出的所有 DS3000

设备。

直接管理（频带外）方法
使用直接管理（频带外）方法时，您在网络上通过与每个控制器的 TCP/IP 以太网连接
直接管理存储子系统。要通过以太网连接管理存储子系统，您必须为每个控制器定义 IP

地址和主机名。每个存储子系统控制器必须通过连接至 RJ-45 接口的电缆连接到一个以
太网络，如第 8页的图 2 所示。

下图所示的系统使用直接管理（频带外）方法来管理存储子系统。

第 1 章 简介 7



使用直接管理（频带外）方法管理存储子系统具有以下优点：

v 如果主机运行 Storage Manager 支持的任何一种操作系统，那么与控制器之间的以太
网连接使您能够通过 SMclient 管理站管理连接到该主机的存储子系统。

v 您不需要访问逻辑驱动器即可与控制器进行通信。可以配置操作系统以及所使用的
主机总线适配器支持的逻辑驱动器最大数。

v 当光纤通道、因特网 SCSI（iSCSI）或 SAS 链路出现问题时，您可以管理存储子系
统并对它进行故障诊断。

使用直接管理（频带外）方法管理存储子系统具有以下缺点：

v 在双控制器存储子系统配置中，您需要使用两根以太网电缆将存储子系统控制器连
接到网络。

v 添加设备时，必须为每个控制器指定 IP 地址或主机名。

v 需要执行网络准备任务。要获取准备任务的摘要信息，请参阅第 15页的第 2 章, 『准
备安装』。

要点：

v 为了省去 DHCP/BOOTP 服务器和网络任务，请使用控制器缺省 TCP/IP 地址
或为控制器指定静态 IP 地址（请参阅第 9页的表 4）。

v 创建一个独立于主生产网络的专用网络，用于管理 DS3000 存储子系统。

图 2. 直接管理（频带外）存储子系统
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定义控制器 TCP/IP 地址
下表显示存储子系统控制器的缺省设置。

表 4. 缺省控制器 TCP/IP 地址

控制器 IP 地址 子网掩码

A 192.168.128.101 255.255.255.0

B 192.168.128.102 255.255.255.0

要更改 DS3000 存储子系统控制器的缺省 TCP/IP 地址，您首先必须使用缺省 TCP/IP

地址与存储子系统建立直接管理连接。

要使用 Storage Manager Client 程序更改控制器缺省 TCP/IP 地址，请完成以下步骤：

1. 在 Enterprise Management 窗口中，双击要定义新控制器 TCP/IP 地址的存储子系统。
这时将打开 Subsystem Management 窗口。

2. 单击 Tools 选项卡。

3. 在 Tools 页面中，单击 Change Network Configuration。这时将打开 Change Net-

work Configuration 窗口。

4. 选择适当的控制器选项卡，并为控制器 A 和 B 输入相应的 TCP/IP 地址信息。

5. 单击 OK 应用新的 TCP/IP 地址。

要点：确保新的 TCP/IP 地址信息正确无误，因为将它们更改为不同的值后，您无法
再使用控制器缺省 TCP/IP 地址与存储子系统建立直接管理连接。

6. 关闭 Subsystem Management 窗口。

7. 在 Enterprise Management 窗口中，删除包含缺省 TCP/IP 地址的存储子系统条目。

8. 等待 5 分钟左右，然后使用新的 TCP/IP 地址与存储子系统重新建立管理连接。

图 3. Change Network Configuration 窗口
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注：可以首先 ping 新地址，确保与控制器的网络连接情况良好，然后将存储子系统
添加到 Enterprise Management 窗口中。

必需的直接管理（频带外）管理活动

要建立直接管理连接，请完成以下步骤：

1. 在 DS3000 存储子系统与以太网络之间建立以太网连接。

2. 按照第 16页的『网络安装任务概述』中直接管理系统的指示信息进行操作。

3. 安装 SMclient。

4. 启动 Storage Manager 软件并添加 DS3000 控制器（A 和 B）的 IP 地址。如果有
多个 DS3000 存储子系统，请将每个 IP 地址添加到域中。
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查看样本网络
下图显示一个网络示例，它包含直接管理存储子系统（网络 A）和主机代理管理存储子
系统（网络 B）。

直接管理存储子系统

在图 4 中，网络 A 是直接管理存储子系统。它包含以下组件：

v 一台 DHCP/BOOTP 服务器

v 一个用于简单网络管理协议（SNMP）陷阱的网络管理站（NMS）

v 一台通过光纤通道、iSCSI 或 SAS I/O 通路连接到存储子系统的主机

v 一个通过以太网电缆连接到存储子系统控制器的管理站

注：如果您使用控制器静态 TCP/IP 地址或缺省 TCP/IP 地址，就不必设置 DHCP/

BOOTP 服务器。

图 4. 使用直接管理和主机代理管理存储子系统的样本网络
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主机代理管理存储子系统

在第 11页的图 4 中，网络 B 是主机代理管理存储子系统。网络 B 包含以下组件：

v 一台通过有效 I/O 通路连接到存储子系统的主机

v 一个通过以太网电缆连接到主机服务器的管理站

创建 SAN 连接的配置（光纤通道）
本部分包含以下主题：

v SAN 连接的配置的设置步骤

v 在光纤通道交换机环境中连接主机总线适配器

设置 SAN 连接的配置
要设置 SAN 连接的配置，请完成以下步骤：

1. 将主机总线适配器连接到一个或多个交换机。

2. 将 DS3000 存储子系统连接到一个或多个交换机。

3. 根据具体情况，在一个或多个光纤通道交换机上设置所需区域。

注：要获取有关分区和启用区域的信息，请参阅交换机随附的文档。

4. 配置系统，然后登录交换机并查看系统来验证配置。

要获取有关设置 DS3000 存储子系统的更多信息，请参阅存储子系统随附的支持 CD 中
的 Quick Installation Guide 和其他文档。
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标准（非集群）配置
您可以在标准（非集群）配置中安装 Storage Manager 软件：

图 5 显示标准（非集群）配置样本。

图 5. 标准（非集群）配置样本
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支持的逻辑驱动器数
下表显示受 AIX 和 Linux on POWER 支持的逻辑驱动器。

表 5. 每个存储子系统的最大逻辑驱动器数

最大逻辑驱动器数
每个存储单元分区的最
大逻辑驱动器数

最大 FlashCopy 逻辑
驱动器数

最大逻辑驱动器副本
逻辑驱动器数

256 32（见注 1。） 128 255

注：

1. 基本型号的 DS3000 最多支持 4 个分区。要从 4 个分区升级至 16 个分区，您必
须购买 DS3000 分区扩展许可证。

2. 每个标准逻辑驱动器最多支持 4 个 FlashCopy 逻辑驱动器。

3. 主机代理管理方法使用一个称为访问逻辑驱动器的特殊逻辑驱动器来与存储子系统
中的控制器通信。访问逻辑驱动器使用一个可用的 LUN。因此，使用主机代理软件
管理存储子系统时，可配置的 LUN 比操作系统和主机适配器支持的最大数少一个。
访问逻辑驱动器又称为通用 Xport 设备。
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第 2 章 准备安装

本章提供相关信息，帮助您规划 Storage Manager 软件的安装。

请参阅本文档中的相应部分，以便在特定操作系统中安装 Storage Manager 2 Client 和
主机软件。完成 Storage Manager 2 软件组件安装过程后，执行第 71页的第 5 章, 『完
成 Storage Manager 软件的安装和配置』和第 103页的第 6 章, 『完成存储管理任务』
中的过程。

规划和准备 AIX 安装
表 6 显示 Storage Manager 软件组件的安装顺序，并提供相关信息帮助您规划 AIX 版
存储管理软件的安装。

表 6. AIX 环境中的软件组件安装顺序

系统类型 软件安装顺序

管理站（以及用作管
理站的任何主机服务
器）

Storage Manager Client（SMclient）

主机服务器 1. IBM AIX 5.2、AIX 5.3 或 AIX 6.1 以及所需的 APARS

2. IBM 主机总线适配器设备驱动程序

3. IBM AIX MPIO PCM（必需）

多路径 I/O（MPIO）路径控制模块（PCM）作为用于 AIX 的 RDAC

故障转移驱动程序进行安装。

4. Storage Manager 主机软件包，它可以安装以下组件：

v SMclient（可选）

如果要从主机服务器管理存储子系统，就需要 SMclient。

v MPIO（必需）

MPIO 作为用于 AIX 的 RDAC 故障转移驱动程序进行安装。

v SMagent（可选）

如果要使用主机代理（频带内）管理方法，就需要 SMagent。直接
（频带外）管理方法是 AIX 环境中的首选方法。

v SMutil（可选）

SMutil 包含 hot_add、SMdevices 和 SMrepassist 实用程序。
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规划和准备 Linux 安装
表 7 显示 Storage Manager 软件组件的安装顺序，并提供相关信息帮助您规划 Linux 版
存储管理软件的安装。

表 7. Linux 环境中的软件组件安装顺序

系统类型 软件安装顺序

管理站（以及用作管
理站的任何主机服务
器）

Storage Manager Client（SMclient）

主机服务器和集群节
点

1. IBM 主机总线适配器设备驱动程序（Linux 版）

2. Linux MPP（必需）

Linux MPP 作为用于 Linux 的 RDAC 故障转移驱动程序进行安装。

3. Storage Manager 主机软件包，它可以安装以下组件：

v SMclient（可选）

如果要从主机服务器管理存储子系统，就需要 SMclient。

v SMagent（可选）

如果要使用主机代理（频带内）管理方法，就需要 SMagent。您必须
先安装 Linux MPP（请参阅步骤 2）。直接（频带外）管理方法是
Linux 环境中的首选方法。

v SMutil（必需）

SMutil 包含 hot_add、SMdevices 和 SMrepassist 实用程序。

4. 主机总线适配器管理软件（可选）

注：Linux MPP 与 Storage Manager 主机软件包分别提供。Linux MPP 软件包有两个，
分别用于不同类型的内核：

v 2.6 内核（RHEL 4、SLES 9 和 SLES 10）（适用于 RDAC 修订版 B）

v 2.6 内核（RHEL 5 和 SLES 10 SP1）（适用于 RDAC 修订版 C）

网络安装任务概述
要开始安装存储管理软件，请确保网络组件已正确安装并且运行正常，同时已获得正
确运行软件所需的主机和控制器信息。

以下部分概述了为直接管理存储子系统和主机管理存储子系统设置网络安装需要执行
的任务。

直接管理存储子系统：网络安装概述
设置直接管理系统的网络安装需要完成以下常规任务：

1. 安装要连接到网络的所有硬件组件（主机服务器、存储子系统和电缆）。欲了解安
装信息，请参阅特定硬件设备随附的文档。

2. 为连接到网络的存储子系统制订命名约定。要获取更多信息，请参阅第 17 页的
『步骤 1：命名存储子系统』。
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3. 将存储子系统名称和管理类型记录在第 109页的附录 A, 『存储子系统和控制器信息
记录』中。第 18页的表 8 显示已完成信息记录的示例。

注：在后面的步骤中，返回到第 109页的附录 A, 『存储子系统和控制器信息记录』
并记录硬件以太网地址和 IP 地址等信息。

4. 如果使用缺省控制器 IP 地址，请转至步骤 6。否则，请从网络管理员处获取网络中
存储子系统各控制器的 TCP/IP 地址和主机名。请参阅第 19页的『步骤 3：指定主
机和控制器 IP 地址』。

5. 使用控制器静态 IP 地址（建议）；否则请设置一台 DHCP/BOOTP 服务器，提供
特定控制器的网络配置信息。

6. 确保已安装 TCP/IP 软件。要获取更多信息，请参阅第 19 页的『步骤 4：验证
TCP/IP 协议并设置主机或 DNS 表』。

7. 开启连接到网络的设备。

主机管理系统：网络安装概述
以下步骤概述了为主机管理系统设置网络安装需要执行的任务：

1. 安装要连接到网络的所有硬件组件（主机服务器、存储子系统和电缆）。欲了解安
装信息，请参阅特定硬件设备随附的文档。

2. 为连接到网络的存储子系统制订命名约定。要获取更多信息，请参阅『步骤 1：命名
存储子系统』。

3. 将存储子系统名称和管理类型记录在第 109页的附录 A, 『存储子系统和控制器信息
记录』中。第 18页的表 8 显示已完成信息记录的示例。

注：在后面的步骤中，返回到第 109页的附录 A, 『存储子系统和控制器信息记录』
并记录硬件以太网地址和 IP 地址等信息。

4. 从网络管理员处获取运行主机代理软件的主机服务器的 IP 地址和主机名。请参阅第
19页的『步骤 3：指定主机和控制器 IP 地址』。

注：只有 DS3300 和 DS3400 支持主机管理的存储子系统。

5. 确保已安装 TCP/IP 软件。要获取更多信息，请参阅第 19 页的『步骤 4：验证
TCP/IP 协议并设置主机或 DNS 表』。

6. 开启连接到网络的设备。

步骤 1：命名存储子系统
设置网络时，请确定存储子系统的命名约定。当您安装存储管理软件并第一次启动它
时，管理域中的所有存储子系统都显示为 <unnamed>。请使用 Subsystem Management 窗
口重命名各个存储子系统。

命名存储子系统时请注意以下几点：

v 名称有 30 个字符的限制。名称中的所有头部和尾部的空格都会被删除。

v 使用容易理解和记忆、独一无二并且有意义的命名规则。

v 避免使用可能很快失去意义的随意确定的名称。

v 软件在显示存储子系统名称时会添加前缀 Storage Subsystem。例如，如果将一个存
储子系统命名为 Engineering ，它显示为 Storage Subsystem Engineering。
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步骤 2：记录存储子系统名称
确定命名规则后，将存储子系统名称记录在第 109页的附录 A, 『存储子系统和控制器
信息记录』的空白信息记录表单中。

表 8 显示第 11页的图 4 中所示网络的信息记录样本。该网络包含使用直接管理和主机
代理管理方法管理的多个存储子系统。

表 8. 信息记录样本

存储子系统名称 管理方法 控制器：IP 地址和主机名 主机 IP 地址和主
机名控制器 A 控制器 B

Finance 直接管理 IP 地址 =

192.168.128.101

IP 地址 =

192.168.128.102

主机名 =

Denver_a

主机名 =

Denver_b

Engineering 主机代理管理 IP 地址 =

192.168.2.22

主机名 = Atlanta
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步骤 3：指定主机和控制器 IP 地址
如果准备使用频带外管理（直接管理）方法来管理存储子系统，请为网络中所有存储
子系统的每个控制器指定一个唯一的 IP 地址。在信息记录（第 109页的附录 A, 『存
储子系统和控制器信息记录』）中记下各个控制器的 IP 地址。

注：为了省去 DHCP/BOOTP 服务器和网络任务，请使用控制器缺省 TCP/IP 地址或为
控制器指定静态 IP 地址。如果无法使用控制器缺省 TCP/IP 地址指定静态 TCP/IP

地址，请参阅第 7页的『直接管理（频带外）方法』中的信息。

您可以对控制器 A 使用缺省 IP 地址 192.168.128.101，对控制器 B 使用
192.168.128.102，从而与 DS3000 存储子系统建立频带外管理连接。可通过 Storage Man-

ager Client Subsystem Management 窗口更改 IP 地址。

仅适用于主机代理管理：如果准备使用主机代理管理方法来管理 DS3300 或 DS3400 存
储子系统，请为将安装主机代理软件的每台主机分配 IP 地址。在第 109页的附录 A,

『存储子系统和控制器信息记录』中的信息记录中记下各台主机的 IP 地址；然后转至
『步骤 4：验证 TCP/IP 协议并设置主机或 DNS 表』。

步骤 4：验证 TCP/IP 协议并设置主机或 DNS 表
缺省安装过程将安装 TCP/IP 软件包。要确保成功安装了 TCP/IP 软件包，请打开 shell

提示符并输入 ifconfig。如果看见 eth0 或 eth1 界面，那么说明启用了 IP 协议。

要设置主机或 DNS 表，请完成以下步骤。确保控制器的主机名与其 IP 地址匹配。

1. 更新主机表或 DNS 表，指定主机名与 IP 地址关联。如果没有 DNS 表，请编辑
/etc/hosts 文件中的主机表。如果操作系统未安装在根目录下，那么您的目录可能有
所不同。

2. 要透过防火墙管理存储子系统，请将防火墙配置为向 TCP 数据打开端口 2463。

3. 尝试 ping /etc/hosts 文件中列出的某个控制器设备。

以下示例显示一个 Linux 主机文件。

# Do not remove the following line, or various programs
# that require network functionality will fail.

127.0.0.1 rh71_8500 localhost.localdomain
102.54.94.97 rhino.acme.com x.acme.com
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第 3 章 在 AIX 主机系统上安装和配置 Storage Manager 软件

本章描述了如何在 AIX 操作系统环境中安装 Storage Manager 软件。

AIX 主机系统的硬件和软件要求
本部分提供了 AIX 主机系统的硬件和软件要求的相关信息。

注：有关 Storage Manager 软件、AIX 文件集和硬件组件的最新安装要求，请参阅 Sys-

tem Storage DS3000 Support Software for AIX CD（AIX 主机配件支持 CD）上的
面向 AIX 的 Storage Manager 自述文件。

硬件要求
至少需要以下硬件。

注：有关最新的主机支持信息，请参阅最新的《DS3000 互操作性矩阵》。

DS3200 支持：

v 具有两个 IBM BladeCenter SAS 连接模块的 IBM BladeCenter H 机箱或 IBM

BladeCenter E 机箱

v 使用 IBM BladeCenter SAS 扩展卡（CFFv）的 IBM BladeCenter JS12、IBM

BladeCenter JS21 和 IBM BladeCenter JS22

v 一个 BladeCenter 单元只能连接一个 DS3200 存储子系统。

注：要配置一个 BladeCenter 单元和一个 DS3200 存储子系统，请将 DS3200 控制
器上的主机端口 1 连接到 BladeCenter 单元中的 BladeCenter SAS 连接模块。
将第二个 DS3200 控制器上的另一个主机端口 1 连接到 BladeCenter 单元中的
第二个 BladeCenter SAS 连接模块。其他外部设备不可连接到 SAS 连接模块。

DS3400 支持：

v 任何使用 IBM POWER4™、POWER5™ 或 POWER6™ 64 位 PowerPC 体系结构且
支持以下光纤通道主机总线适配器之一的 IBM System p 或 POWER 服务器：

– FC 6239

– FC 5716 / 1957 / 1977

– FC 5758 / 1905

– FC 5759 / 1910

– FC 5773

– FC 5774

v 使用 IBM Eserver BladeCenter 光纤通道扩展卡的 IBM BladeCenter JS21 和 IBM

BladeCenter JS22

软件要求
支持以下操作系统软件：

v AIX 5.2
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操作系统版本必须为 V5200-10-04-0750 或更高版本。

注：DS3200 存储子系统在 AIX 5.2 上不受支持。

v AIX 5.3

操作系统版本必须为 V5300-08-03-0831 或更高版本。

v AIX 6.1

操作系统版本必须为 V6100-01-02-0834 或更高版本。

注：AIX 的 Storage Manager 软件自述文件中列出所需的最小 APAR。
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AIX 限制
AIX 配置存在以下限制：

SAN 限制和连接限制

v AIX 对磁盘卷大小有以下限制：

– 32 位 AIX V5.2 为 1 TB

– 64 位 AIX V5.2（使用 LVM 坏区重定位时为 2 TB）为 2 ZB

在支持大容量卷的地方，AIX 引导逻辑卷必须位于该卷的前 2 TB 中。硬件
设备或供应商软件可能会对卷的大小有更多限制。要获取更多信息，请联系
您的硬件或软件供应商。

v 其他存储设备（如磁带设备）或磁盘存储器必须通过不同的 HBA 和 SAN 区
域连接。

启动系统时的限制

v 当您从 DS3000 设备启动系统时，指向 DS3000 存储子系统的两条路径都必
须激活并运行。

v 在 AIX 启动过程中，系统无法使用路径故障转移。在 AIX 主机启动后，故
障转移可以正常运行。

如果您正在从 SAN 启动系统，要获得最佳性能，请勿使用在 SATA 阵列上创
建的逻辑驱动器。

分区限制

v 每个 AIX 主机、每个 DS3000 存储子系统的最大分区数量为 3。

v 为 AIX 配置的所有逻辑驱动器必须映射到 AIX 主机组（不是带真实 DMP

的 AIX）。

要获取更多信息，请参阅第 78页的『配置主机访问』。

v 必须在每个控制器上至少配置一个标识介于 0 到 31 的 LUN，此 LUN 不
是 UTM 也不是访问逻辑驱动器。

v AIX 仅支持单个 DS3200 分区。

v AIX 仅支持双控制器 DS3200 型号，并且必须是从主机到每个 DS3200 控制
器的 I/O 路径。
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安装 DS3000 Storage Manager 软件
本部分描述 Storage Manager 软件的安装过程。

软件安装前的准备工作
在安装 Storage Manager 软件前，请确保您具备以下物品：

v 对于 AIX 操作系统，请确保您执行的是操作系统要求的维护级别。（请参阅要求的维
护级别及其他修订的列表的自述文件。）

v HBA 设备驱动程序

v 您特定存储子系统的最新的控制器固件，但以下固件和 NVSRAM 版本为最低要求：

DS3200：
控制器固件： 07.35.41.00

控制器 NVSRAM： N1726D32LR335V02（单控制器）
N1726D320R335V06（双控制器）

DS3400：
控制器固件： 07.35.41.00

控制器 NVSRAM： N1726D34LR335V02（单控制器）
N1726D340R335V05（双控制器）

v RAID 控制器的 IP 地址（仅限频带外管理）

v 交换机和 HBA的其他文档（如果需要）

v 适用的主机软件工具包。主机软件工具包使您有权连接使用了适用于 DS3000 存储子
系统的操作系统的主机服务器。该工具包有针对您特殊存储子系统的最新的 DS3000

软件和控制器固件。

v AIX 主机配件支持 CD，它包含了针对您的特定存储子系统的最新的 DS3000 软件和
控制器固件。

要获取最新的控制器固件，请访问 http://www.ibm.com/servers/eserver/support/

fixes/。

故障转移驱动程序
AIX 主机系统要求用于路径冗余的 AIX 多路径 I/O（MPIO）故障转移驱动程序。故障
转移驱动程序将监视 I/O 路径。如果某个 I/O 路径中出现组件故障转移，故障转移驱
动程序会将所有 I/O 重新传递到其他路径。

注：AIX 主机配件支持 CD 不包含 AIX MPIO 驱动程序文件。要安装这些文件，必须
从 http://www.ibm.com/systems/support/ 下载这些文件。

请确保安装了支持 DS3000 的 AIX 设备驱动程序。多路径 I/O 驱动程序（MPIO）是
在 AIX 系统上运行 DS3000 所必需的驱动程序。通过输入以下命令验证是否安装了此
驱动程序：

lslpp -i devices.common.IBM.mpio.rte

如果未安装此设备驱动程序，命令将返回“Fileset devices.common.IBM.mpio not

installed.”获取必需的 AIX 安装介质并使用 AIX SMIT 实用程序来安装 MPIO 程序
包。安装 MPIO 程序包后，请确保操作系统仍使用 oslevel -s 命令报告必需的操作系
统版本。
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准备 SAN 连接（仅限 DS3400）
AIX 支持对 DS3400 存储子系统的直接连接的配置或 SAN 连接的配置。

支持 DS3400 的 AIX 故障转移驱动程序是多路径　I/O 驱动程序（MPIO）。MPIO 驱
动程序使连接支持设备时可使用的连接方法更加灵活。

允许使用单个主机总线适配器配置。如果一个 SAN 连接的配置中有一个主机总线适配
器，那么控制器必须通过交换机以光纤通道连接方式连接到主机总线适配器，并且两
个控制器必须与双控制器存储配置的主机总线适配器位于同一个 SAN 区域中。

以下示例是使用 DS3400 时受支持的连接配置的一小部分。要查看更多配置示例，请参
阅《IBM System Storage DS3400 存储子系统安装、用户与维护指南》中的“将主机连
接至 DS3400”部分。

警告： 如果一个主机总线适配器配置中的路径发生故障，数据访问可能会丢失。

如果有 4 至 8 个路径，最好的操作是使用 2 至 4 个适配器。

示例 1
创建一个包含两个光纤通道 HBA 端口的区域，其中一个光纤通道端口位于 DS3400 的
控制器 A，另一个则位于控制器 B。

该配置提供四个指向 hdisk 的路径。与首选的存储控制器相关联的两个路径将在 DS3400

处于 Optimal 状态时维修 I/O。如果主机不能访问首选的控制器，请使用另两个路径。

注： h d i s k 的属性“算法”应该设置为 r o u n d _ r o b i n。如果此属性设置为
round_robin，hdisk 的属性“reserve_policy”必须设置为 no_reserve、pr_exclusive 或
pr_shared。

示例 2
为 HBA 端口与 DS3400 控制器的某一端口之间的连接创建区域。对于双控制器存储配
置，要求创建两个区域。一个区域包含 HBA 端口与控制器 A 的控制器端口。另一个
区域包含另一个 HBA 端口和控制器 B 的控制器端口。

此配置提供两个指向 hdisk 的路径。

注：无需更改属性“算法”和“hdisk 的算法”的缺省值。

示例 3
创建一个包含两个光纤通道 HBA 端口及 DS3400 的全部四个光纤通道端口的区域。

此配置提供八个指向 hdisks 的路径。与首选的存储控制器相关联的四个路径将在
DS3400 处于 Optimal 状态时维修 I/O。如果首选的控制器不可操作，请使用另外四个
路径。

注：hdisk 的属性“算法”应该设置为 round_robin。当此属性设置为 round_robin 时，
hdisk 的属性“reserve_policy”必须设置为 no_reserve、pr_exclusive 或 pr_shared。

准备连接至 BladeCenter 单元（仅限 DS3200）
AIX 仅支持将一个双控制器 DS3200 连接至 BladeCenter 单元。
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该连接需要两个 SAS 连接模块。一个 SAS 连接模块通过单根电缆连接到控制器 A 的
主机端口 1。第二个 SAS 连接模块通过单根电缆连接到控制器 B 的主机端口 1。其
他外部设备不可连接到 SAS 连接模块或 DS3200 控制器模块的主机端口 2 或 3。

使用安装向导安装 Storage Manager 软件
DS3000 Storage Manager 软件安装向导将在 AIX 主机上安装以下软件包：

v SMruntime

v SMclient

v SMagent

v SMutil

需求

v DS3000 Storage Manager V02.70 或更高版本

v xservices 必须可操作

如果您安装的是 Storage Manager 02.70，或者如果系统尚未安装图形卡，或者由于任何
原因您不想使用此向导来安装该软件，请跳过本部分并按照『以控制台方式安装 Stor-

age Manager 软件』中描述的步骤来安装独立主机软件包。

注：如果使用此向导来安装 Storage Manager 软件，可能需要增大某些分区的大小来适
应安装。

要使用此安装向导来安装 DS3000 Storage Manager 软件，请完成以下步骤。针对特定
安装对步骤进行必要的调整。

1. 将以下文件从 AIX 主机配件支持 CD 复制到系统上的某个目录下，或者从 DS3000

支持 Web 站点下载该文件到系统上的某个目录下：

SMIA-AIX-02.70.xx.xx.bin

2. 打开系统上的该文件。这时将打开 Storage Manager 安装向导“简介”窗口。

3. 按照每个向导窗口中的指示信息操作。选择安装类型时，可以选择以下某个选项：

v Typical (Full) Installation － 安装所有 Storage Manager 软件包

v Management Station － 安装 SMruntime 和 SMclient

v Host － 安装 SMruntime、SMagent 和 SMutil

v Custom － 允许您选择要安装的软件包

注：安装期间，将显示问题 Automatically Start Monitor?这将引用 Event Moni-

tor 服务。要启动 ESM 固件自动同步，必须启用 Event Monitor。要启用 Event

Monitor，请选择 Automatically Start Monitor。
DS3000 Storage Manager 软件就安装到系统上了。

以控制台方式安装 Storage Manager 软件
要在无图形界面情况下安装 Storage Manager 软件，请完成以下步骤：

1. 按照命令提示符，在运行 Storage Manager 安装程序包期间使用 - i 控制台参数来
强制以非图形方式安装程序包。例如，在 Linux 中，命令为：

# sh SMIA-LINUXPPC-02.70.A5.15.bin – i console

2. 选择位置（缺省值是 English）并按 Enter 键。
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3. 读取最终用户许可证协议（EULA）。要继续下一步，请按 Y（对于选择“是”）以
接受 EULA。

4. 选择安装类型，然后按 Enter 键：

v Typical

v Management Station

v Host

v Customize

5. 查看“预安装摘要”，然后按 Enter 键。安装完成。

6. 按 Enter 键以退出安装程序。

配置存储子系统
如果您已购买存储分区高级功能部件，请确保启用该高级功能部件。要获取更多信
息，请参阅第 105页的第 7 章, 『启用和使用高级功能部件』。

要配置用于 AIX 系统的 Storage Manager 软件，请执行以下部分中的步骤。您可以通
过在 AIX 或非 AIX 系统上运行的 Storage Manager Client 软件来配置 Storage Man-

ager 软件。

将存储子系统添加至 Storage Manager Client
要将存储子系统添加至 Storage Manager Client（SMclient），请执行以下步骤：

1. 要设置用于 AIX 和 SMclient 的存储子系统，必须物理上将存储子系统配置为可以
通过各控制器上的以太网连接进行直接管理。在配置存储子系统前安装 SMclient。

注：有关将 IP 地址指定给控制器的信息，请参阅第 19页的『步骤 3：指定主机和
控制器 IP 地址』。

2. 在网络上配置存储子系统后，通过选择 Storage Manager 图标或输入下列命令来启动
主机服务器上的 SMclient：

# /usr/SMclient/SMclient

这时将打开 Enterprise Management 窗口。

3. 完成以下步骤来指定控制器的 IP 地址：

a. 在 Enterprise Management 窗口中，单击 Edit → Add Storage Subsystem。

b. 在 Add Storage Subsystem 窗口中，键入存储子系统中各控制器的 IP 地址，然
后单击 Add。存储子系统的名称将显示在 Enterprise Management 窗口中。

注：无法添加两个控制器将导致生成一个部分受管的系统，所有功能在该系统
可能不可用。

4. 双击存储子系统名以打开其 Subsystem Management 窗口。

升级控制器固件和 NVSRAM
有关固件更新的下载详细步骤，请参阅第 89页的『下载控制器、NVSRAM、ESM 和硬
盘驱动器固件』。
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创建存储分区
创建存储分区之前，请确保您已创建了介于主机和存储子系统控制器之间的物理连
接，并在具有 SAN 交换机的情况下已连接了该交换机并对其进行了分区。如果您尚未
完成这些连接，Storage Manager 软件将无法在以下部分的步骤执行期间列出 HBA 的
WWPN。

记录服务器上的 HBA 的 WWPN
针对要用于安装的各 HBA 端口，输入以下命令。这将记录主机定义过程期间显示在
Storage Manager Client 中的 WWPN。

lscfg -vpl fcsX|grep Network

# lscfg -vpl fcs0|grep Network

Network Address.............10000000C94BC2A3

记录此信息以供定义主机和主机端口过程期间使用。

注：本文档发布时，AIX 不支持显示 SAS 适配器 WWPN。在 BladeCenter 单元硬件
VPD 菜单上显示的针对 SAS 扩展卡的 UUID 可用于确定第一个物理连接的主机
端口标识。要确定第二个主机端口标识，那么要在第一个主机端口标识上加 1。例
如，如果第一个主机端口标识以 5432 结尾，那么会更新第二个主机端口标识，使
其以 5433 结尾。

运行 cfgmgr 命令
运行 AIX 命令 cfgmgr -v。这将使 HBA 端口登录到存储器端口。这将使 Storage Man-

ager 软件可以在主机定义过程期间显示 WWPN。

定义主机和主机端口
要通过使用 Configure Host Access 向导来定义主机和主机端口，请完成以下步骤：

1. 选择 Subsystem Management 窗口上的 Configure 选项卡并选择以下某种方法：

v Create Host Access (Automatic)

v Create Host Access (Manual)

2. 如果已经添加也是在系统上运行主机代理的新主机，请选择 Create Host Access
(Automatic)。否则，请转至步骤 5。

3. 如果自动配置了任何主机，这些主机将作为可用主机显示在左列中。从可用主机
列表选择一个主机，然后单击 Add。

4. 在所有可用主机移至 Select Host 列后，单击 OK。定义了主机和主机端口，您
已完成此过程。

5. 选择 Create Host Access (Manual) 以手动定义主机和主机端口信息。

6. 从“特定主机名和主机类型”窗口输入主机名，然后从主机类型列表选择 AIX 作为
主机类型。单击 Next。

7. 从左窗格的“指定 HBA 主机端口”窗口选择用于定义主机的 HBA 主机端口的正
确 WWPN。单击 Add。

8. 在所有主机端口添加至 Selected HBA host port 列后，单击 Next。

9. 从“指定主机组”窗口选择以下某个选项：
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v 如果主机不与其他主机共享访问同一逻辑驱动器，请选择 No；然后单击 Next。

v 如果主机与其他主机共享访问同一逻辑驱动器，请选择 Yes。要么输入一个新的
主机组名，要么从列表中选择一个现有的主机组；然后单击 Next。

10. 查看主机定义详细信息，然后单击 Finish。

定义主机组
主机组是存储分区拓扑中的一个实体，它定义了主机的逻辑集合，这些主机要求对一
个或多个逻辑驱动器进行共享访问。您可以向已定义主机组中的个别主机授予独立于
主机组的对存储分区的访问权。

要定义主机组，请完成以下步骤：

1. 单击 Subsystem Management 窗口中的 Configure 选项卡。

2. 选择 Create Host Group。

3. 输入新的主机组名称（例如，AIX）并从左列中选择主机。单击 Add 以将主机添加
到主机组。

4. 当添加完主机组的所有主机后，单击 OK。

5. 这时将显示一条消息，说明已创建了新主机组。单击 OK。

将 LUN 映射到存储分区
本部分包含将 LUN 映射和添加到主机或主机组的步骤。这些步骤可用于将 LUN 映射
到新分区或将 LUN 添加至现有分区。

要映射 LUN，请完成以下步骤：

1. 选择 Subsystem Management 窗口中的 Configure 选项卡。

2. 选择 Create Host-to-Logical Drive Mapping。

3. 从“选择主机”窗口选择将映射逻辑驱动器的主机或主机组，然后单击 Next。

4. 从“选择逻辑驱动器”窗口选择要映射到步骤 3 中已选择的主机或主机组的逻辑驱
动器。

注：如果所有逻辑驱动器都将映射到同一主机或主机组，单击 Select all logical
drives 复选框。

选定逻辑驱动器后，指定一个介于 0 至 31 的逻辑单元号（LUN）给逻辑驱动器，
然后单击 Finish。

5. 这时将显示“主机至逻辑驱动器的映射过程”窗口。当映射完成后，单击 OK。

6. 映射完成。选择 Yes 以映射其他逻辑驱动器或选择 No 以关闭映射向导。

识别 AIX 主机上的设备
MPIO 驱动程序创建以下呈现DS3000存储子系统配置的设备：

dac 磁盘阵列控制器（dac）设备在存储子系统中表现为一台控制器。仅频带内管
理需要 Dac 设备。如果没有通过 Storage Manager 软件将访问 LUN 映射到系
统分区，那么将找不到 dac 设备。

hdisk 每个 hdisk 设备在 AIX 系统中表现为一个单独的逻辑驱动器。可使用以下命令
识别 DS3000 存储子系统拥有的逻辑驱动器。
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lsdev -Cc disk|grep DS3K

执行初始设备发现
开始前：确保正确设置 DS3000 存储子系统、完成适当的光纤通道分区、将 LUN 指定
给主机以及满足 AIX 软件和固件要求。

要执行初始设备发现，请完成以下步骤：

1. 输入以下命令以查找新设备：

# cfgmgr -v

注：在 SAN 配置中，这些设备将在您运行 cfgmgr 命令后登录到 SAN 交换机。

2. 输入以下命令：

# lsdev -Cc disk | grep DS3K

3. 检查 lsdev -Cc disk | grep DS3K 命令的输出以确保 AIX MPIO 软件将识别
DS3000 逻辑驱动器的正确编号。

下面的示例显示了用于一组 DS3400 LUN 的 lsdev -Cc disk | grep DS3K 命令
的输出：

# lsdev -Cc disk|grep DS3K
hdisk3 Available 00-08-01 MPIO Other DS3K Array Disk
hdisk4 Available 00-08-01 MPIO Other DS3K Array Disk
hdisk5 Available 00-08-01 MPIO Other DS3K Array Disk
hdisk6 Available 00-08-01 MPIO Other DS3K Array Disk
hdisk7 Available 00-08-01 MPIO Other DS3K Array Disk
hdisk8 Available 00-08-01 MPIO Other DS3K Array Disk
hdisk9 Available 00-08-01 MPIO Other DS3K Array Disk

验证安装和配置
在完成初始设备识别后，请执行下列步骤来验证 DS3000 的所有设备名和路径是否正
确，并验证 AIX 是否识别 dac 和 hdisk。

使用 mpio_get_config –Av 命令
使用 AIX mpio_get_config -Av 命令以执行下列验证任务：

1. 将 AIX hdisk 编号与 Storage Manager Client 中显示的逻辑驱动器名称相关联。

注：来自 Storage Manager Client 的逻辑驱动器名称将显示在“用户标签”标题下。

2. 确保逻辑驱动器在首选 DS3400 控制器（控制器 A 或 B）上。

3. 确保发现了存储控制器的正确数量：

控制器计数：1（说明是单控制器配置）
控制器计数：2（说明是双控制器配置）

4. 确保“分区计数”与已配置到 Storage Manager Client 上的系统的存储分区数量相匹
配。

下面的示例显示了用于双控制器 DS3400 存储子系统的 mpio_get_config –Av 命
令的输出：
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# mpio_get_config -Av
Frame id 0:

Storage Subsystem worldwide name: 60ab800374244000047064e0
Controller count: 2
Partition count: 2
Partition 0:
Storage Subsystem Name = 'Accounting_FEB'

hdisk LUN # Ownership User Label
hdisk35 0 B (preferred) E-1-S5
hdisk36 1 B (preferred) F-1-S5
hdisk37 2 B (preferred) G-1-S5
hdisk38 3 B (preferred) H-1-S5
hdisk39 4 A (preferred) E-2-S5
hdisk40 5 A (non-preferred) F-2-S5

使用 lspath 命令
使用 lspath 命令来为每个 DS3400 hdisk 验证下列信息：

1. 确保检测到预期的路径数量。

2. 验证是否启用了路径状态。

下面的示例显示了用于双控制器 DS3400 存储子系统的 lspath 命令的输出：

# lspath|sort

Enabled hdisk10 fscsi1
Enabled hdisk10 fscsi1
Enabled hdisk10 fscsi3
Enabled hdisk10 fscsi3
Enabled hdisk11 fscsi1
Enabled hdisk11 fscsi1
Enabled hdisk11 fscsi3
Enabled hdisk11 fscsi3
Enabled hdisk12 fscsi1
Enabled hdisk12 fscsi1
Enabled hdisk12 fscsi3
Enabled hdisk12 fscsi3

lspath 命令示例显示所有路径都处于“启用”状态，且每个 hdisk 都有四个路径。

使用 lsdev 命令
lsdev 命令显示设备及其特性。lsdev 命令还会显示启动时或上次运行 cfgmgr -v 命
令时设备的状态。

如果使用的是频带内管理，确保通过在 AIX 系统上使用 lsdev -C|grep dac 命令发
现 dac 设备的正确数量。

下面的示例显示了 lsdev -C|grep dac 命令的输出：

# lsdev -C |grep dac
dac0 Available 03-00-02 DS3/4K PCM User Interface
dac1 Available 08-08-02 DS3/4K PCM User Interface
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此 lsdev 命令示例显示两个 dac 设备。应该为 DS3400 存储子系统中的每个控制器检
测到一个 dac 设备。仅当访问 LUN 映射到此主机系统的存储分区时才检测到 Dac 设
备。

注：连接到 BladeCenter 单元中的 SAS 连接模块的 DS3200 存储子系统仅能发现一个
dac 设备。

每个 dac 具有自己的位置码或路径，由值 03-00-02 和值 08-08-02 表示。每个 AIX 系
统都有自己的一组位置码（包括主机和主机适配器位置），这些位置码描述了设备的
内部路径。

请参阅 IBM System p 服务器的服务手册以识别设备位置。

使用 lsattr 命令
lsattr 命令将显示设备属性和可能的值。仅在启动时或上次运行 cfgmgr -v 命令时更
新属性。

使用 lsattr –El hdisk 命令查看各 DS3000 相关 hdisk 的当前属性。确保将“算法”
和“reserve_policy”属性设置为期望值。

下面的示例显示了 lsattr –El hdisk30 命令的输出。在此示例中显示了 hdisk30 的当
前属性：

lsattr -El hdisk30
PCM PCM/friend/otherapdisk Path Control Module False
PR_key_value none 16 Bit LVD SCSI Disk Drive True
algorithm round_robin Algorithm True
clr_q no Device CLEARS its Queue on error True
cntl_delay_time 0 Controller Delay Time True
cntl_hcheck_int 0 Controller Health Check Interval True
cntl_hcheck_int 0 Controller Health Check Interval True
dist_err_pcnt 0 Distributed Error Percentage True
dist_tw_width 50 Distributed Error Sample Time True
hcheck_cmd inquiry Health Check Command True
hcheck_interval 60 Health Check Interval True
hcheck_mode nonactive Health Check Mode True
location Location Label True
lun_id 0x7000000000000 Logical Unit Number ID False
max_transfer 0x40000 Maximum TRANSFER Size True
node_name 0x200800a0b824581a FC Node Name False
pvid 000c27fe9a2184350000000000000000 Physical volume identifier False
q_err yes Use QERR bit True
q_type simple Queuing TYPE True
queue_depth 4 Queue DEPTH True
reassign_to 120 REASSIGN time out value True
reserve_policy no_reserve Reserve Policy True
rw_timeout 30 READ/WRITE time out value True
scsi_id 0x7a0700 SCSI ID False
start_timeout 60 START unit time out value True
ww_name 0x203800a0b824581a FC World Wide Name False

更改“算法”属性和“reserve_policy”属性
要正确使用计划的配置，算法属性和 reserve_policy 属性需要设置正确。
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使用第 25页的『准备 SAN 连接（仅限 DS3400）』中的示例 1，如果未将属性“算法”
更改为 round_robin，那么在第一个 HBA 出故障前仅使用一个 HBA。在第一个 HBA

出故障后，第二个 HBA 将维护 I/O。如果将“算法”设置为 round_robin，I/O 将在两
个 HBA 之间交替工作。

注：使用 chdev 命令来更改属性。

例如，要为 hdisk30 将算法的属性更改为 round_robin 以及将 reserve_policy 更改为
no_reserve，使用如下命令：

# chdev -l hdisk30 -a algorithm=round_robin –a reserve_policy=no_reserve

查看和设置对象数据管理器（ODM）属性
某些对象数据管理器（ODM）属性仅作参考之用。这些仅为参考性质的属性显示了
DS3000 存储子系统的配置方法或其当前状态。可以使用 SMIT 或使用 AIX chdev -p
命令来修改其他属性。

使用 lsattr 命令查看 ODM 属性
要查看 fcs、fscsi、dac 和 hdisk 的对象数据管理器（ODM）属性设置，请使用 lsattr
命令来执行以下任务：

v 要查看缺省设置，请输入 lsattr -Dl。

v 要查看当前设置在系统上的属性，请输入 lsattr -El。

下面的示例显示了 fcs 设备的属性。

# lsattr -El fcs0
bus_intr_lvl 305 Bus interrupt level False
bus_io_addr 0xff800 Bus I/O address False
bus_mem_addr 0xfff7e000 Bus memory address False
init_link al INIT Link flags True
intr_priority 3 Interrupt priority False
lg_term_dma 0x800000 Long term DMA True
max_xfer_size 0x100000 Maximum Transfer Size True
num_cmd_elems 200 Maximum number of COMMANDS to queue to the adapter True
pref_alpa 0x1 Preferred AL_PA True
sw_fc_class 2 FC Class for Fabric True

下面的示例显示了 fscsi 设备的属性。

# lsattr -El fscsi0
attach switch How this adapter is CONNECTED False
dyntrk no Dynamic Tracking of FC Devices True
fc_err_recov delayed_fail FC Fabric Event Error RECOVERY Policy True
scsi_id 0x7c0e00 Adapter SCSI ID False
sw_fc_class 3 FC Class for Fabric True
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下面的示例显示了 dac 设备的属性。

# lsattr -El dac0
PCM PCM/friend/ds4k-ui Path Control Module False
lun_id 0x1f000000000000 Logical Unit Number ID False
node_name 0x200400a0b83743b1 FC Node Name False
scsi_id 0xef SCSI ID False
ww_name 0x202400a0b83743b1 FC World Wide Name False

下面的示例显示了 hdisk 设备的属性。

# lsattr -El hdisk30

PCM PCM/friend/otherapdisk Path Control Module False
PR_key_value none 16 Bit LVD SCSI Disk Drive True
algorithm fail_over Algorithm True
autorecovery yes N/A True
clr_q no Device CLEARS its Queue on error True
cntl_delay_time 0 Controller Delay Time True
cntl_hcheck_int 0 Controller Health Check Interval True
cntl_hcheck_int 0 Controller Health Check Interval True
cntl_hcheck_int 0 Controller Health Check Interval True
cntl_hcheck_int 0 Controller Health Check Interval True
dist_err_pcnt 0 Distributed Error Percentage True
dist_tw_width 50 Distributed Error Sample Time True
hcheck_cmd inquiry Health Check Command True
hcheck_interval 60 Health Check Interval True
hcheck_mode nonactive Health Check Mode True
location Location Label True
lun_id 0x11000000000000 Logical Unit Number ID False
max_transfer 0x40000 Maximum TRANSFER Size True
node_name 0x200400a0b824588d FC Node Name False
pvid none Physical volume identifier False
q_err yes Use QERR bit True
q_type simple Queuing TYPE True
queue_depth 10 Queue DEPTH True
reassign_to 120 REASSIGN time out value True
reserve_policy single_path Reserve Policy True
rw_timeout 30 READ/WRITE time out value True
scsi_id 0x11100 SCSI ID False
start_timeout 60 START unit time out value True
ww_name 0x202400a0b824588d FC World Wide Name False

设置 hdisk 设备的队列深度
将 queue_depth 属性设置为适当值对于系统性能而言非常重要。如果您有一个配置了多
个逻辑驱动器和主机的大型 DS3400 配置，请使用此设置获取高性能。

本部分提供了计算此系统的最大队列深度的方法，可将此方法作为指导来帮助您确定
适用于您配置的最佳队列深度。

计算最大队列深度： 对于 DS3400 存储子系统，请使用下面的公式来确定最大队列深
度：

2048 /（主机数量 × 每台主机的 LUN 数量）
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例如，带四台主机且每台主机带 32 个 LUN 的系统的最佳队列深度为 16：

2048 / ( 4 × 32 ) = 16

设置队列深度属性： 您可以使用 chdev -l 命令来设置 queue_depth 属性，如以下示
例所示。

# chdev -l hdiskx -a queue_depth=y

其中 x 是 hdisk 的名称，y 是队列深度设置。

注：使用 -P 标志使定制设备对象类中的更改持久。

查看 hdisk 的容量
bosinfo -s <hdisk#> 命令可用于显示 hdisk 的当前容量。缺省情况下，以兆字节的形
式显示容量。bootinfo -s 命令显示了动态卷扩展操作后的更新容量。

其他 AIX 配置信息
以下部分描述了其他 AIX 配置信息。

为光纤通道设备使用快速 I/O 故障
当光纤通道适配器设备驱动程序检测到交换机和 DS3000 存储子系统之间的光纤网上发
生链接故障时，就出现了 I/O 故障转移。您可以通过将 fscsi 设备属性 fc_err_recov
设置为以下某个设置来更改故障转移特性。

fast_fail 启用快速 I/O 故障。

如果光纤通道适配器设备驱动程序检测到交换机和 DS3000 存储子系统
之间的链接丢失，它将等待数秒以启用光纤网来使链接稳定。如果指
定了 fast_fail，那么适配器在检测到设备不在光纤网上时将无法通过适
配器设备驱动程序中的所有 I/O。任何新 I/O 将立即出现故障或者对出
故障的 I/O 进行重试操作立即失败。

快速 I/O 故障可能在多路径配置中非常有用。它可以降低因存储设备和
交换机之间的链接丢失而引起的 I/O 故障次数，而且可支持更快的故障
转移以更改路径。

delayed_fail 缺省设置。

如果指定了 delayed_fail，那么会将 I/O 故障作为正常处理；重试操
作不会立即失败，且故障转移花费的时间比在指定 fast_fail 的情况下
花费的时间久。

在单路径配置（尤其是带有指向页面调度设备的单路径配置）中，应
使用 delayed_fail 设置。

示例：可以通过设置此属性来启用快速 I/O 故障，如以下示例所示。确保停止所有 I/O

并在设置此属性前将 fscsi 设备置为“已定义”状态。

chdev -l fscsi0 -a fc_err_recov=fast_fail

注：

1. fast_fail 属性仅影响交换机和 DS3000 存储子系统之间发生的故障转移。它不影响
主机和交换机之间发生的故障转移。
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2. 设置每个配置给 DS3000 存储子系统的 HBA 上的 fast_fail 属性。

3. 仅可在 SAN 环境中使用快速 I/O 故障。不能在直接连接的环境中使用快速 I/O 故
障。

使用光纤通道设备的动态跟踪
当光纤通道设备从交换机上的某个光纤通道端口移至另一个端口时，AIX 将动态跟踪这
些光纤通道设备。这将通过在移动发生期间暂挂 I/O 15 秒钟来启用光纤通道连接的动
态移动。如果电缆移动在 15 秒内完成，该功能将防止从建议路径移动逻辑驱动器。

您可以通过将 fscsi 设备属性 dyntrk 设置为以下某个设置来启用或禁用动态跟踪：

yes 启用动态跟踪。

如果启用动态跟踪，光纤通道适配器将检测到何时更改了光纤通道节点端口标
识。它在设备仍联机期间将用于该设备的流量重新传递给新的全球端口名
（WWPN）。

例如，可以在设备仍联机时将电缆从一个交换机端口移至另一个端口，而且，
如果在 15 秒钟内完成移动操作将不会发生故障转移。如果 15 秒后完成将发
生故障转移。

技巧：这些端口必须位于同一交换机的同一区域中。

no 缺省设置。

如果未启用动态跟踪，必须在将电缆从一个端口移动到另一个端口前使这些设
备处于脱机状态。否则将发生故障转移。

示例：可以通过设置此属性来启用动态跟踪，如以下示例所示。确保停止所有 I/O 并在
设置此属性前将 fscsi 设备置为“已定义”状态。

chdev -l fscsi0 -a dyntrk=yes

注：

1. 设置每个配置给 DS3000 存储子系统的 HBA 上的 dyntrk 属性。

2. 仅可在 SAN 环境中使用动态跟踪。不能在直接连接的环境中使用动态跟踪。

使用动态容量扩展和动态卷扩展
动态卷扩展（DVE）在 DS3000 存储子系统上是动态的，但要使 AIX 识别新的逻辑驱
动器容量则需要手动干预。本部分说明了如何使用带 AIX 的 DVE。

开始前：确保阵列中有足够的可用空闲容量。可以使用 DS3000 Storage Manager 软件
来确定空闲容量。在 Subsystem Management 窗口的 Summary/Arrays & Logical
Drives 视图中，展开希望的阵列并滚动至逻辑驱动器列表的底部。“可用空闲容量”是
逻辑驱动器列表中的一个条目。

如果没有足够的空闲容量和额外的驱动器供使用，请在执行 DVE 操作前执行动态容量
扩展（DCE）操作。DCE 操作将通过添加已安装在驱动器机箱中的未使用过的物理磁盘
来增加阵列的容量。

执行动态容量扩展操作
要执行动态容量扩展操作，请完成以下步骤：

1. 在“修改/添加空闲容量（驱动器）”视图中，选择要增加容量的阵列。
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2. 选择 Next。

3. 在“Add capacity to array”窗口中选择可用驱动器。

4. 选择 Finish。

注：此窗口中将显示可用的空闲磁盘及其容量。

启动操作后，在阵列的各逻辑驱动器帝将显示一个时钟，此时钟将一直显示到操作结
束。此过程可能持续几个小时，必须允许其在 AIX 干预前完成。

注：操作完成所需的时间取决于 I/O 活动、增加的容量、驱动器技术及其他因素。

执行动态卷扩展操作
执行动态卷扩展需要 Storage Manager 软件 SMcli 接口或 Storage Manager 软件脚本
编辑器。以下示例显示了通过 Engineering_FEB 逻辑驱动器上的脚本编辑器窗口运行动
态卷扩展所需的命令语法。增加的容量是 1 GB。

set logicalDrive ["Engineering_FEB"] addCapacity=1GB;

注：操作完成后，可以使用 bootinfo –s hdiskX 命令查看 AIX 系统的新容量。

要在 AIX 主机上执行 DVE，请完成以下步骤。要了解关于扩展逻辑卷管理器（LVM）
逻辑驱动器的更多信息，请参阅 chvg 命令的联机帮助页。

1. 通过输入以下命令从扩展的 LVM 逻辑驱动器组卸下文件系统：

umount mount_point

其中 mount_point 是正在被卸装的文件系统的名称。

2. 通过输入以下命令更改逻辑驱动器组：

chvg -g logical_drive_group_name

其中 logical_drive_group_name 是关联的 LVM 逻辑驱动器组的名称。

注：如果出现表示无法将逻辑驱动器组导入 AIX 5.1 或更早版本中的警告信息，请
忽略该警告消息。此错误消息不正确。

3. 安装文件系统。

注：

1. 您可能必须在逻辑驱动器组上运行 varyoffvg 命令，然后运行 varyonvg 命令，以
便 LVM 查看磁盘的大小变化。但是，新容量可供操作系统使用。

2. 当逻辑驱动器组在常规或增强的并发方式中处于激活状态时，您可能无法重新调整
逻辑驱动器的大小。

3. 您可能无法调整根逻辑驱动器组的大小。

使用 AIX 自动恢复功能部件
AIX 支持在纠正错误之后针对首选路径由主机发出的逻辑驱动器的恢复。可以通过将
hdisk 属性 Autorecovery 设置为 yes，以启用自动恢复特性。hdisk 的 Autorecovery 属
性的缺省值为 No。

要针对 hdisk20 启用自动恢复，请输入以下命令。

# chdev -l hdisk20 -a autorecovery=yes
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注：要使自动恢复机制正常运行，逻辑驱动器在出现路径故障之前必须位于其首选路
径上。

更换热插拔 HBA
本部分描述了在 AIX 主机上热插拔光纤通道主机总线适配器（HBA）的过程。

热插拔过程要求您了解以下领域：

v AIX 管理

v 用于 PCI 适配器更换的 AIX 硬件过程

v DS3000 Storage Manager 软件

v 光纤通道分区过程（如果要使用交换机来实现 DS3000 存储子系统和 AIX 主机之间
相连接，且分区基于 WWPN，那么需要了解此过程）

警告： 如果不了解本部分记录的这些步骤，数据可用性丢失可能会发生。确保在开始
HBA 热插拔过程前阅读并理解本部分的所有要求和步骤。-swap procedure.

了解问题和限制
在执行热插拔操作前，请阅读以下问题和限制：

警告： 与这些备注和过程的任何背离都会导致数据可用性丢失。

v 必须使用相同型号的 HBA 替换有缺陷的 HBA，并将新的安装在同一 PCI 插槽中。

即使后来发现此 HBA 并不是真的有缺陷，也勿将其插入任何其他系统。始终将 HBA

退回 IBM。

要点：当前不支持更换场景的其他变体。

v 如果更换 HAB 会除去上一个指向任何 hdisk 的路径，那么不支持热插拔 HBA。

收集系统数据
要搜集来自系统的数据，请完成以下步骤：

1. 输入以下命令：

# lsdev -C |grep fcs

输出类似以下示例。

fcs0 Available 17-08 FC Adapter
fcs1 Available 1A-08 FC Adapter

2. 输入以下命令：

# lsdev -C |grep dac

输出将类似于下面的示例：

# lsdev -C |grep dac
dac0 Available 00-08-01 DS3/4K PCM User Interface
dac1 Available 00-08-01 DS3/4K PCM User Interface

3. 为各 fcs 设备输入以下命令：
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# lscfg -vpl fcsx

其中 x 是 fcs 设备的编号。输出类似以下示例。

lscfg -vpl fcs0
fcs0 U0.1-P1-I1/Q1 FC Adapter

Part Number.................09P5079
EC Level....................A
Serial Number...............1C21908D10
Manufacturer................001C
Feature Code/Marketing ID...2765
FRU Number..................09P5080
Network Address.............10000000C92D2981
ROS Level and ID............02C03951
Device Specific.(Z0)........2002606D
Device Specific.(Z1)........00000000
Device Specific.(Z2)........00000000
Device Specific.(Z3)........03000909
Device Specific.(Z4)........FF401210
Device Specific.(Z5)........02C03951
Device Specific.(Z6)........06433951
Device Specific.(Z7)........07433951
Device Specific.(Z8)........20000000C92D2981
Device Specific.(Z9)........CS3.91A1
Device Specific.(ZA)........C1D3.91A1
Device Specific.(ZB)........C2D3.91A1
Device Specific.(YL)........U0.1-P1-I1/Q1

PLATFORM SPECIFIC

Name: fibre-channel
Model: LP9002
Node: fibre-channel@1
Device Type: fcp
Physical Location: U0.1-P1-I1/Q1

更换热插拔 HBA
完成第 38页的『收集系统数据』中的过程后，请执行以下步骤以更换热插拔 HBA：

1. 通过输入以下命令将要更换的 HBA 置于“已定义”状态：

# rmdev -Rl fcsx

其中 x 是 HBA 编号。输出类似以下示例。

rmdev -Rl fcs0
fcnet0 Defined
dac0 Defined
fscsi0 Defined
fcs0 Defined

2. 在 AIX SMIT 菜单中，通过选择 smit → Devices → PCI Hot Plug Manager →
Replace/Remove a PCI Hot Plug Adapter 启动热插拔 HBA 所需的过程。

3. 在“Replace/Remove a PCI Hot Plug Adapter”窗口中，选择目标 HBA。这时将打
开一个窗口，显示 HBA 的更换说明。

4. 按以下 SMIT 说明来更换 HBA。
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注：请勿在此时重新安装光纤通道电缆。

5. 如果成功完成本过程中 第 39页的1 至 第 39页的4 的步骤，请确保取得了以下结
果：

v 从系统上卸下了有缺陷的 HBA。

v 已开启更换光纤通道 HBA。

v 关联的 fcsx 设备处于“已定义”状态。

6. 在 HBA 替换件上安装光纤通道回环。

7. 通过输入以下命令将 HBA 置于“活动”状态：

# cfgmgr

8. 通过以下命令验证 fcs 设备现在是否可用：

# lsdev -C |grep fcs

9. 通过输入以下命令验证替换的 HBA 上的固件，或将其升级到可用级别：

# lscfg -vpl fcsx

其中 x 是 fcs 的编号。

注：您可以通过参考在此部分，即第 38页的『收集系统数据』中的开头部分中过
程期间收集的 fcsx 设备数据来确定 HBA 固件的级别。

10. 记录与网络地址相关的 16 位编号，您在步骤 9 中使用过的命令的输出中曾显示过
此编号。在下一过程中可使用该网络地址编号手动将替换的 HBA WWPN 映射到
存储子系统。

11. 通过输入以下命令将 HBA 回置到“已定义”状态。

# rmdev -Rl fcsX

完成此过程后，继续下一过程，即『将新的 WWPN 映射到 DS3000 存储子系统』。

将新的 WWPN 映射到 DS3000 存储子系统
对于受热插拔过程影响的各 DS3000 存储子系统，要将新 HBA 的全球端口名
（WWPN）映射到存储子系统，请完成以下步骤：

1. 启动 DS3000 Storage Manager 软件并打开 Subsystem Management 窗口。

2. 在 Subsystem Management 窗口中，选择 Modify 选项卡。

3. 找到有缺陷的 HBA，选择 HBA，然后单击 Replace HBA。

4. 从列表中找到新的 HBA WWPN，修改别名（如果您想改），然后单击 OK 以使更
改生效。

完成 HBA 热插拔过程
要更换热插拔 HBA，请完成以下步骤：

1. 拔下光纤通道回环插头，并插入先前连接到要卸下的 HBA 上的光纤通道电缆。

2. 如果 HBA 已连接到光纤通道交换机，而且分区基于 WWPN，请修改分区信息以将
卸下的 HBA 的 WWPN 替换为 HBA 替换件的 WWPN。（此时运行 cfgmgr 命
令以使 HBA 在光纤通道交换机中注册其 WWPN。）
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要点：如果 HBA 直接连接到 DS3000 存储子系统或者光纤通道交换机分区基于端
口号而不是 WWPN，那么跳过此步骤。如果需要修改分区，修改操作失败将
阻止 HBA 访问存储子系统。

3. 运行 cfgmgr 命令。

4. 使用 lsdev –C 命令验证已替换的 fcsx 设备及其关联的 dac 是否置于“可用”状
态。请参阅以下示例中的输出。

# lsdev -C |grep fcs
fcs0 Available 00-08 FC Adapter
fcs1 Available 00-09 FC Adapter
fcs2 Available 05-08 FC Adapter
fcs3 Available 05-09 FC Adapter

5. 除非 hdisk 的 autorecovery 属性设置为“Yes”，否则使用 Storage Manager Client

手动将逻辑驱动器再分发到首选路径。

autorecovery 功能将启动再分发驱动器，这些驱动器在检测到链接可持续 5 分钟正
常后都不在首选路径上。

要手动再分发逻辑驱动器，请执行以下步骤：

a. 单击 Support 选项卡。

b. 依次选择 Manage Controllers 和 Redistribute Logical Drives。

6. 通过以下一种或两种方式确保磁盘处于首选路径上：

使用 AIX 系统
运行 mpio_get_config -Av 命令且确保驱动器处于预期路径上。

使用 Storage Manager 软件
在 Enterprise Management 窗口中，确保存储子系统是“Optimal”。如果它
们不是 Optimal，请确保任何作为与热插拔过程有关的存储子系统的部分的
驱动器都未列举在 Recovery GURU 中。

7. 使用 AIX 系统，运行 lspath 命令以确保启用指向 hdisk 的所有路径。

DS3000 错误日志消息
本部分描述了 AIX 错误日志可能报告的错误。您可以通过运行 errpt -a 命令来查看
AIX 错误日志。

您可能需要验证您的配置或更换有缺陷的硬件来纠正错误。

注：当在 DS3000 存储子系统中报错时，以下列表中的快照参考资料相当于 FlashCopy。

v SC_DISK_PCM_ERR1: Subsystem Component Failure

存储子系统已返回一个错误，错误显示存储子系统的某个组件（硬件或软件）出故
障了。详细的检测数据将识别有故障的组件和所需的恢复操作。有故障的硬件组件
还应显示在 Storage Manager 软件中，因此错误日志中显示的这些错误是报告，且可
协助技术支持代表解决问题。

v SC_DISK_PCM_ERR2: Array Active Controller Switch
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与存储子系统相关的一个或多个 hdisk 的活动的控制器已改变。这是为了响应 AIX 主
机执行的某些间接操作（故障转移或自动恢复）。此消息与引起故障转移的一套故障
条件相关，或者是在故障转移成功后，与将路径恢复到具有自动恢复属性设置为
“Yes”的 hdisk 上的首选控制器相关。

v SC_DISK_PCM_ERR3: Array Controller Switch Failure

尝试切换到活动的控制器失败。这将留下一个或多个与控制器无关的路径。AIX MPIO

PCM 将多次重试该错误以便找到能指向控制器的路径。

v SC_DISK_PCM_ERR4: Array Configuration Changed

hdisk 的活动的控制器已更改，通常引起更改的操作不是该主机发出的。这可能是另一
个主机针对共享 LUN 而发出的故障转移或恢复操作，如来自 Storage Manager 软件
的再分发操作、Storage Manager 软件中首选路径的更改、某个控制器正脱机或者是任
何能引起控制器所有权更改的其他操作。

v SC_DISK_PCM_ERR5: Array Cache Battery Drained

存储子系统高速缓存电池快没电了。高速缓存中的所有剩余数据都将被转储，在转
储前数据很容易就会丢失。通常不允许使用快没电的电池进行高速缓存，除非管理
员在 Storage Manager 软件中启用了该电池。

v SC_DISK_PCM_ERR6: Array Cache Battery Charge Is Low

存储子系统高速缓存电池电量低，需要充电或更换。

v SC_DISK_PCM_ERR7: Cache Mirroring Disabled

已在受影响的 hdisk 上禁用高速缓存镜像。通常所有高速缓存的写数据都会保存在两
个控制器的高速缓存中，因此如果一个控制器出故障，该数据仍然会有另一完好的
副本。这是一条警告消息，表示单个控制器的丢失将造成数据丢失。

v SC_DISK_PCM_ERR8: Path Has Failed

指向控制器的 I/O 路径已出问题或脱机。

v SC_DISK_PCM_ERR9: Path Has Recovered.

指向控制器的 I/O 路径已恢复或已联机。

v SC_DISK_PCM_ERR10: Array Drive Failure

存储阵列中的物理驱动器已出故障，应该将其更换。

v SC_DISK_PCM_ERR11: Reservation Conflict

PCM 操作由于保存冲突已失败。该错误不是当前发出的。

v SC_DISK_PCM_ERR12: Snapshot Volume’s Repository Is Full

快照卷存储库已满。在解决存储库问题前将无法对快照卷进行写操作。

v SC_DISK_PCM_ERR13: Snapshot Op Stopped By Administrator

管理员已中断了快照操作。

v SC_DISK_PCM_ERR14: Snapshot repository metadata error

存储子系统报告快照元数据有问题。

v SC_DISK_PCM_ERR15: Illegal I/O - Remote Volume Mirroring
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将引导 I/O 到作为远程卷镜像对（目标卷而不是源卷）的部分的违规目标。

v SC_DISK_PCM_ERR16: Snapshot Operation Not Allowed

已尝试不允许的快照操作。

v SC_DISK_PCM_ERR17: Snapshot Volume’s Repository Is Full

快照卷存储库已满。在解决存储库问题前将无法对快照卷进行写操作。

v SC_DISK_PCM_ERR18: Write Protected

hdisk 处于写保护状态。该情况通常在快照卷存储库已满时出现。

v SC_DISK_PCM_ERR19: Single Controller Restarted

恢复了指向单控制器存储子系统的 I/O。

v SC_DISK_PCM_ERR20: Single Controller Restart Failure

未恢复指向单控制器存储子系统的 I/O。AIX MPIO PCM 将继续尝试重新启动指向
存储子系统的 I/O。

再分发逻辑驱动器以避免出故障
如果您已在 AIX 主机上启用自动恢复，那么无需在控制器故障转移之后手动再分发逻
辑驱动器。但是，如果您有不同种类的主机环境，可能需要手动再分发逻辑驱动器。
不支持某些格式的自动恢复的主机或者已禁用自动恢复的 AIX 主机将不会自动将逻辑
驱动器重新引导至首选路径。

要手动将逻辑驱动器再分发到它们的首选路径，请执行以下步骤：

1. 修复或更换任何有问题的组件。要获取更多信息，请参阅适用于 DS3000 存储子系
统的《安装、用户与维护指南》。

2. 要将逻辑驱动器再分发到它们的首选路径，在 Subsystem Management 窗口中选择
Support 选项卡。选择 Manage controller，然后选择 Redistribute Logical
Drives。

注：如果 DS3000 存储子系统上配置的逻辑驱动器的数量太多，再分发逻辑驱动器
可能要花上 2 小时或更长的时间来完成，这取决于系统的活动程度。

3. 在 AIX 系统上，运行 mpio_get_config -Av 命令以确保所有的逻辑驱动器都位于
首选控制器上，如以下示例所示。

# mpio_get_config -Av
Frame id 3:

Storage Subsystem worldwide name: 60ab80024585d000047fdb68
Controller count: 2
Partition count: 1
Partition 0:
Storage Subsystem Name = 'C4'

hdisk LUN # Ownership User Label
hdisk53 0 B (preferred) A-1-S5
hdisk54 1 A (preferred) A-10-S1
hdisk55 2 B (preferred) A-11-S0
hdisk56 3 A (preferred) A-12-S0
hdisk57 4 A (preferred) A-2-S5
hdisk58 5 B (preferred) A-3-S5
hdisk59 6 A (preferred) A-4-S5
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不在首选路径上的逻辑驱动器将在“所有权”标题下显示“（非首选）”。
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第 4 章 在基于 POWER 的 Linux 主机系统上安装和配置
Storage Manager 软件

您可以在以下 POWER-based 主机操作系统的 Linux 分发版上使用 DS3000 Storage Man-

ager 软件：

v SUSE Linux Enterprise Server 9（SLES 9）

v SUSE Linux Enterprise Server 10（SLES 10）

v Red Hat Enterprise Linux 4（RHEL 4）

v Red Hat Enterprise Linux 5（RHEL 5）

注：本章任务开始之前，有关 Linux 分发版的系统要求，请参阅『SUSE Linux Enter-

prise Server 系统要求』和 第 47页的『Red Hat Enterprise Linux 系统要求』。

有关 Linux on POWER 和 IBM System p 支持的更多信息，请参阅以下 Web 站点：

Linux on POWER 资源中心
http://www.ibm.com/servers/enable/linux/power/

Linux on System p 支持
http://www.ibm.com/servers/eserver/pseries/linux/

在光纤通道交换机环境中连接主机总线适配器
当您在光纤通道交换机环境中将主机服务器中的光纤通道主机总线适配器连接到 DS3000

存储子系统主机端口时，您应该在主机总线适配器与 DS3000 主机端口之间建立一对一
的区域关系。如果多个适配器或控制器端口在同一个区域中，由于会在整个区域中传
播设备复位，因此您可能会遇到扩展性故障转移延迟或其他的故障转移问题。

要获取在光纤通道交换机中设置区域的指示信息，请参阅光纤通道交换机随附的文
档。

您可以在 http://www.ibm.com/servers/storage/support/san/index.html 找到交换机文档的链
接。

SUSE Linux Enterprise Server 系统要求
本部分列出 POWER-based 主机的最低硬件和软件需求以运行连接到 DS3000 存储子系
统且受 Storage Manager 软件托管的 SLES 9 或 SLES 10。

要点：有关 UTM LUN 限制的信息，请参阅适用于 Linux on POWER 的 Storage Man-

ager 软件自述文件。要获取自述文件，请参阅第 1页的『从 IBM 支持 Web 站
点获取文档』。
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主机硬件需求
至少需要以下硬件。

注：有关最新的主机支持信息，请参阅最新的《DS3000 互操作性矩阵》。

v DS3200 支持：

– 具有两个 IBM BladeCenter SAS 连接模块的 IBM BladeCenter H 机箱或 IBM

BladeCenter E 机箱

– 使用 IBM BladeCenter SAS 扩展卡（CFFv）的 IBM BladeCenter JS12、IBM

BladeCenter JS21 和 IBM BladeCenter JS22

– 一个 BladeCenter 单元只能连接一个 DS3200 存储子系统。

注：要配置一个 BladeCenter 单元和一个 DS3200 存储子系统，请将 DS3200 控
制器上的主机端口 1 连接到 BladeCenter 单元中的 BladeCenter SAS 连接模
块。将第二个 DS3200 控制器上的另一个主机端口 1 连接到 BladeCenter 单
元中的第二个 BladeCenter SAS 连接模块。其他外部设备不可连接到 SAS 连
接模块。

v DS3300 支持：

使用 IBM Eserver BladeCenter QLogic iSCSI 扩展卡的 IBM BladeCenter JS21 和
IBM BladeCenter JS22

v DS3400 支持：

– 任何使用 IBM POWER4、POWER5 或 POWER6 64 位 PowerPC 体系结构且支
持以下光纤通道主机总线适配器之一的 IBM System p 或 POWER 服务器：

- FC 6239

- FC 5716 / 1957 / 1977

- FC 5758 / 1905

- FC 5759 / 1910

- FC 5773

- FC 5774

– 使用 IBM Eserver BladeCenter 光纤通道扩展卡的 IBM BladeCenter JS21 和 IBM

BladeCenter JS22

v Storage Manager 软件管理站

您可以将 SLES 主机用作 Storage Manager 软件管理站。

– 对于 Microsoft® Windows® 或基于 i386 的 Linux 管理站，有关针对这些操作系
统列出的最低需求，请参阅《Microsoft Windows Server、Linux、Novell NetWare 和
VMware ESX Server 版 IBM System Storage DS3000 Storage Manager V10 安装
和支持指南》。

– 对于 AIX 或 RHEL 管理站，请参阅本文档应用程序章节中所列出的最低需求。

软件要求
有关 SUSE Linux 操作系统的最新支持版本和主机总线适配器设备驱动程序的支持版
本，请参阅 Linux on POWER 的 Storage Manager 软件自述文件。

注：要获取自述文件，请参阅第 1页的『从 IBM 支持 Web 站点获取文档』。
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Red Hat Enterprise Linux 系统要求
本部分列出 POWER-based 主机的最低硬件和软件需求以运行连接到 DS3000 存储子系
统且受 Storage Manager 软件托管的 RHEL 4 或 RHEL 5。

要点：有关 UTM LUN 限制的信息，请参阅适用于 Linux on POWER 的 Storage Man-

ager 软件自述文件。要获取自述文件，请参阅第 1页的『从 IBM 支持 Web 站
点获取文档』。

主机硬件需求
至少需要以下硬件：

v DS3200 支持：

– 支持的 BladeCenter 单元：具有两个 IBM BladeCenter SAS 连接模块的 IBM

BladeCenter H 机箱或 IBM BladeCenter E 机箱

– 支持的刀片服务器：使用 IBM BladeCenter SAS 扩展卡（CFFv）的 IBM

BladeCenter JS12、IBM BladeCenter JS21 和 IBM BladeCenter JS22

– 一个 BladeCenter 单元只能连接一个 DS3200 存储子系统。

注：要配置一个 BladeCenter 单元和一个 DS3200 存储子系统，请将 DS3200 控
制器上的主机端口 1 连接到 BladeCenter 单元中的 BladeCenter SAS 连接模
块。将第二个 DS3200 控制器上的另一个主机端口 1 连接到 BladeCenter 单
元中的第二个 BladeCenter SAS 连接模块。其他外部设备不可连接到 SAS 连
接模块。

v DS3300 支持：

使用 IBM Eserver BladeCenter QLogic iSCSI 扩展卡的 IBM BladeCenter JS21 和
IBM BladeCenter JS22

v DS3400 支持：

– 任何使用 IBM POWER4、POWER5 或 POWER6 64 位 PowerPC 体系结构且支
持以下光纤通道主机总线适配器之一的 IBM System p 或 POWER 服务器：

- FC 6239

- FC 5716 / 1957 / 1977

- FC 5758 / 1905

- FC 5759 / 1910

- FC 5773

- FC 5774

– 使用 IBM Eserver BladeCenter 光纤通道扩展卡的 IBM BladeCenter JS21 和 IBM

BladeCenter JS22

v Storage Manager 软件管理站

您可以将 RHEL 主机用作 Storage Manager 软件管理站。

– 对于 Windows 或基于 i386 的 Linux 管理站，有关针对这些操作系统列出的最低
需求，请参阅《Microsoft Windows Server、Linux、Novell NetWare 和 VMware ESX

Server 版 IBM System Storage DS3000 Storage Manager V10 安装和支持指南》。

– 对于 AIX 或 RHEL 管理站，请参阅本文档应用程序章节中所列出的最低需求。
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软件要求
有关 Red Hat Enterprise Linux 操作系统的最新支持版本和主机总线适配器设备驱动程
序的支持版本，请参阅 Linux on POWER 的 Storage Manager 软件自述文件。

注：要获取自述文件，请参阅第 1页的『从 IBM 支持 Web 站点获取文档』。

Linux 主机限制
在开始使用 Storage Manager 软件之前，请阅读以下限制。除非另有说明，否则这些限
制作用于 SLES 和 RHEL 操作系统。

要点：有关 UTM LUN 限制的信息，请参阅适用于 Linux on POWER 的 Storage Man-

ager 软件自述文件。要获取自述文件，请参阅第 1页的『从 IBM 支持 Web 站
点获取文档』。

FC SAN 和连接限制

v 仅使用 IBM RDAC 故障转移驱动程序时支持双路径配置。

v 允许单切换配置，但每个 HBA 和 DS3000 控制器组合必须位于不同的 SAN

区域或 VLAN。

v 对于光纤通道，其他存储设备（如磁带设备）或磁盘存储器必须通过不同的
HBA 和 SAN 区域连接。

v 本文档发布时，不支持集群。

BladeCenter 单元和 DS3200 连接限制：
AIX 仅支持将一个双控制器 DS3200 连接至 BladeCenter 单元。

该连接需要两个 SAS 连接模块。一个 SAS 连接模块通过单根电缆连接到控制
器 A 的主机端口 1。第二个 SAS 连接模块通过单根电缆连接到控制器 B 的
主机端口 1。其他外部设备不可连接到 SAS 连接模块或 DS3200 控制器模块
的主机端口 2 或 3。

Linux RDAC 限制（AVT/ADT）
该 Linux RDAC 发行版不支持自动卷传输/自动磁盘传输（AVT/ADT）方式。
Linux 存储分区主机类型中缺省情况下禁用 AVT/ADT。针对 Linux 分区使用
Linux 存储分区主机类型。

分区限制

v 仅使用 IBM RDAC 故障转移驱动程序时支持双路径配置。

v Linux SCSI 层不支持跳过的（稀疏）LUN。如果映射的 LUN 不是相连的，
Linux 内核不会扫描任何出现在跳过的 LUN 后面的 LUN，因此剩余的 LUN

对主机服务器来说不可用。因此，从 LUN 0 开始，始终使用连续数字映射
LUN。

例如，将 LUN 映射到数字 0、1、2、3、4、5 等，不跳过任何数字。

v 必须在每个分区上映射一个 LUN 0。

v 必须在每个控制器上至少配置一个 LUN 介于 0 到 31 的分区，此 LUN 不
是 UTM 也不是访问逻辑驱动器。
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安装 Storage Manager 软件
本部分描述 Storage Manager 软件的安装过程。

软件安装前的准备工作
在安装 DS3000 Storage Manager 软件前，您可能需要为安装准备以下内容：

v 对于 Linux on POWER 操作系统，请确保您执行的是操作系统要求的维护级别。（请
参阅要求的维护级别及其他修订的自述文件。）

v HBA 驱动程序

v 适用于您特殊存储子系统的最新控制器固件，已在第 45页的『SUSE Linux Enter-

prise Server 系统要求』或第 47页的『Red Hat Enterprise Linux 系统要求』中列出
过.

v 用于 RAID 控制器的 IP 地址（仅适用于频带外管理）

v 交换机和 HBA的其他文档（如果需要）

v 适用的主机软件工具包。主机软件工具包使您有权连接使用了适用于 DS3000 的操
作系统的主机服务器。该工具包有针对您特殊存储子系统的最新的 DS3000 软件和控
制器固件。

v 操作系统适用的主机连接支持 CD，它包含了针对您的特定存储子系统的最新的
DS3000 软件和控制器固件。

要获取最新的控制器固件，请访问 http://www.ibm.com/servers/storage/support/disk/。

最佳实践：当启动主机以准备安装 Storage Manager 软件包时，确保 DS3000 设备尚未
连接到主机系统。配置主机前连接 DS3000 设备会增加系统启动时间，可能
会使安装过程复杂化。在完成本部分中的过程之后，以及在安装 Storage

Manager 软件之前连接 DS3000 设备。

故障转移驱动程序
Linux on POWER 主机系统需要 RHEL 或用于 I/O 路径冗余的 SLES 冗余磁盘阵列
控制器（RDAC）故障转移驱动程序。故障转移驱动程序将监视 I/O 路径。如果某个 I/O

路径中出现组件故障转移，故障转移驱动程序会将所有 I/O 重新传递到其他路径。

有关安装 RDAC 多路径驱动程序的信息，请参阅第 55页的『安装 RDAC 多路径代理
驱动程序』。

配置 Linux 主机
在安装 Linux 操作系统之后和安装 Storage Manager 软件之前，请完成本部分描述的步
骤以配置适用于 DS3000 存储子系统的 Linux 主机。

安装 HBA 设备驱动程序和实用程序包
需要的 HBA 设备驱动程序的类型取决于您的配置。光纤通道、SAS 和 iSCSI 主机总
线适配器适用的驱动程序不同。SLES 和 RHEL 操作系统适用的设备驱动程序也可能不
同。

注：有关以下程序包的最新支持版本，请参阅适用于 Linux on POWER 的 DS3000 Stor-

age Manager 自述文件。
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具有 SP1 或 RHEL 5 HBA 驱动程序支持的 SLES 10
对于使用带 SP1 或 RHEL 5 的 SLES 10 的系统，除非另有说明，否则使用
操作系统随附的 HBA 设备驱动程序。

SLES 9 和 RHEL 4 HBA 驱动程序支持
您可以从 DS3000 支持 Web 站点下载以下项：

v 驱动程序软件包

编译配置文件（/etc/lpfc.conf）中的更改

v 应用程序软件包

监视 HBA 并实现轻松下载 HBA 固件。

v 发行说明

包含升级设备驱动程序的说明。

要安装 HBA 驱动程序，请完成以下步骤：

1. 为 HBA 驱动程序软件包创建目录。

2. 转至 http://www.ibm.com/servers/storage/support/disk/ 并将适用的驱动程序软件包下载
到刚才创建的目录下。

3. 通过输入以下命令解压文件：

# tar -zxvf package_name.tgz

注：如果 RDAC 已安装在系统上，那么必须在安装 HBA 设备驱动程序前卸载或删
除 RDAC 驱动程序。请勿使用 modprobe 内核模块实用程序装入或卸装 RDAC

驱动程序堆栈，该堆栈包含 mpp_Upper 和 mpp_Vhba 工具以及低级主机总线
适配器设备驱动程序。不支持对 RDAC 驱动程序堆栈使用 modprobe 实用程
序。也不支持使用 rmmod 依次除去 RDAC 驱动程序堆栈中的所有驱动程序。
在每次必须卸载驱动程序堆栈时，请重新启动系统。

4. 要升级物理 HBA 驱动程序，请完成以下步骤：

a. 获取 MPP 支持的最新 HBA 驱动程序。

b. 安装驱动程序。

c. 安装驱动程序后，返回到 Linux RDAC 的初始安装路径，使用以下命令重新安装
RDAC 驱动程序：

# make clean
# make uninstall
# make
# make install

5. 重新启动服务器。

安装可选应用程序配件
要安装可选应用程序配件，请完成以下步骤：

1. 为应用程序软件包创建目录。

2. 转至 http://www.ibm.com/servers/storage/support/disk/ 并将适用的驱动程序软件包下载
到刚才创建的目录下。

3. 通过输入以下命令解压文件：

# tar -zxvf package_name.tgz
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4. 在此目录中，找到 readme.txt 文件，按照说明安装驱动程序软件包。

5. 重新启动服务器。

记录 HBA 全球端口名
在安装过程期间，需要知晓 HBA 全球端口名。要查看和记录光纤通道 HBA WWPN 或
iSCSI HBA IQN，请针对基于 Emulex 的 HBA 或基于 QLogic 的 HBA 完成以下步
骤。

对于基于 Emulex 的 HBA：

1. 输入以下命令以查看 HBA：

# ls /proc/scsi/lpfc

这时将显示一张列表，包含了系统上发现的所有 HBA 的指定编号。

2. 在此列表中，识别连接到 DS3000 存储子系统的 HBA 的主机编号并通过输入以下
命令转至该目录：

# cd /sys/class/scsi_host/host#

其中 # 是在步骤 1 中发现的指定 HBA 编号。

3. 输入以下命令以查看 HBA 的 WWPN 和连接的 DS3000 控制器：

# cat port_name

其中 port_name 是指定的 HBA 编号。port_name 值等于 WWPN。

对于基于 QLogic 的 HBA：

1. 输入以下命令以查看 HBA：

# ls /proc/scsi/qla2*

或

# ls /proc/scsi/qla4*

这时将显示一张列表，包含了系统上发现的所有 HBA 的指定编号。

2. 对于连接到 DS3000 存储子系统的各 HBA，输入以下命令：

# cat /proc/scsi/qla2300/x

其中 x 是在步骤 1 中发现的指定 HBA 编号。

将显示以下信息：

scsi-qla#-adapter-port-xxxxxxxxxxxxxx

适配器端口值 xxxxxxxxxxxxxx 提供了光纤通道 WWPN 或 iSCSI IQN。

Storage Manager 的安装和配置
完成主机配置过程后，请完成本部分中的下列步骤来安装和配置 Storage Manager 软件。

注：在开始安装 Storage Manager 软件前，确保 DS3000 设备连接到主机上。

您可以通过使用 Storage Manager 软件安装向导来自动安装所有 Storage Manager 软件
包，您还可以通过使用静默方式安装来安装个别软件包。

第 4 章 在基于 POWER 的 Linux 主机系统上安装和配置 Storage Manager 软件 51



使用安装向导安装 Storage Manager
Storage Manager 软件安装向导是一种基于 Java 的交互式方法，使用它选择要自动安装
到主机系统上的软件包。安装向导将在主机上安装以下软件包：

v SMruntime

v SMclient

v SMagent

v SMutil

要求：

v DS3000 Storage Manager V02.70 或更高版本

v xservices 必须可操作

如果您安装的是 Storage Manager 02.70，如果系统尚未安装图形卡，或者由于任何原因
您不想使用此向导来安装该软件，请跳过本部分并按照『以控制台方式安装 Storage

Manager 软件』中描述的步骤来安装独立主机软件包。

注：如果使用此向导来安装 Storage Manager 软件，可能需要增大某些分区的大小来适
应安装。

要使用此安装向导来安装 DS3000 Storage Manager 软件，请完成以下步骤。针对特定
安装对步骤进行必要的调整。

1. 将 Storage Manager 软件 SMIA 软件包文件从 System Storage DS3000 Support soft-

ware for Linux on POWER CD 复制到系统上的某个目录下，或者从 DS3000 支持
Web 站点下载该软件包文件到系统上的某个目录下。

2. 通过输入以下命令打开系统上的文件：

# sh SMIA-LINUXPPC-02.70.A5.xx.bin

这时将打开 Storage Manager 安装向导“简介”窗口。

3. 按照每个向导窗口中的指示信息操作。选择安装类型时，可以选择以下某个选项：

v Typical (Full) Installation － 安装所有 Storage Manager 软件包

v Management Station － 安装 SMruntime 和 SMclient

v Host － 安装 SMruntime、SMagent 和 SMutil

v Custom － 使您能够选择要安装的软件包

DS3000 Storage Manager 软件就安装到系统上了。

注：安装期间，将显示问题“Automatically Start Monitor? ”这将引用 Event Monitor 服
务。要启动 ESM 固件自动同步，必须启用 Event Monitor。要启用 Event Moni-

tor，请选择 Automatically Start Monitor。

以控制台方式安装 Storage Manager 软件
要在无图形界面情况下安装 Storage Manager 软件，请执行以下步骤。

1. 按照命令提示符，在运行 Storage Manager 安装程序包期间使用 - i 控制台参数来
强制以非图形方式安装程序包。例如，在 Linux 中，命令为：

# sh SMIA-LINUXPPC-02.70.A5.15.bin – i console

2. 选择位置（缺省值是 English）并按 Enter 键。
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3. 读取最终用户许可证协议（EULA）。要继续下一步，请按 Y（对于选择“是”）以
接受 EULA。

4. 选择安装类型：

v Typical

v Management Station

v Host

v Customize

按 Enter 键。

5. 查看“预安装摘要”，然后按 Enter 键。

6. 安装完成。按 Enter 键以退出安装程序。

配置存储子系统
如果您已购买存储分区高级功能部件，请确保启用该高级功能部件。要获取更多信
息，请参阅第 105页的第 7 章, 『启用和使用高级功能部件』。

要配置用于 Linux on POWER 系统的 Storage Manager 软件，请执行以下部分中的步
骤。您可以通过在 Linux on POWER 或非 Linux on POWER 系统上运行的 Storage

Manager Client 软件来配置 Storage Manager 软件。

将存储子系统添加至 Storage Manager Client
要将存储子系统添加至 Storage Manager Client（SMclient），请执行以下步骤：

1. 要设置用于 Linux on POWER 和 SMclient 的存储子系统，必须物理上将存储子系
统配置为可以通过各控制器上的以太网连接进行直接管理。在配置存储子系统前安
装 SMclient。

注：有关将 IP 地址指定给控制器的信息，请参阅第 19页的『步骤 3：指定主机和
控制器 IP 地址』。

2. 在网络上配置存储子系统后，通过选择 Storage Manager 图标或输入下列命令来启动
主机服务器上的 SMclient：

# /opt/IBM_DS3000/SMclient

这时将打开 Enterprise Management 窗口。

3. 完成以下步骤来指定控制器的 IP 地址：

a. 在 Enterprise Management 窗口中，单击 Edit → Add Storage Subsystem。

b. 在 Add Storage Subsystem 窗口中，键入存储子系统中各控制器的 IP 地址，然
后单击 Add。存储子系统的名称将显示在 Enterprise Management 窗口中。

注：无法添加双控制器存储子系统中的两个控制器将导致生成一个部分受管的
系统，所有功能在该系统可能不可用。

存储子系统的名称将显示在 Enterprise Management 窗口中。

升级控制器固件和 NVSRAM
有关固件更新的下载详细步骤，请参阅第 89页的『下载控制器、NVSRAM、ESM 和硬
盘驱动器固件』。
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创建存储分区
要创建存储分区，请执行以下部分中的步骤。

存储分区概述
在使用本部分中的步骤创建存储分区前，请阅读以下信息：

v 本部分的这些步骤将假定您已创建了介于主机和存储子系统控制器之间的物理连
接，还假定在存在 SAN 交换机的情况下已连接了该交换机并对其进行了分区。如果
您尚未完成这些连接，Storage Manager 软件将无法在这些步骤执行期间列出 HBA 的
WWPN 或 IQN。在这种情况下，您必须在执行步骤期间在适当的字段中键入 WWPN

或 IQN 以便定义主机和主机端口。

v 在存储子系统级别创建 Linux on POWER 主机组。不要在缺省组级别创建主机组。

v 自动卷传输/自动磁盘传输（AVT/ADT）由 Linux RDAC 驱动程序管理。为防止争
用，必须禁用 AVT/ADT。缺省情况下，禁用 AVT/ADT。选择 Linux 主机类型将自
动禁用 AVT/ADT。

定义主机和主机端口
要通过使用 Configure Host Access 向导来定义主机和主机端口，请完成以下步骤：

1. 选择 Subsystem Management 窗口上的 Configure 选项卡并选择以下某种方法：

v Create Host Access (Automatic)

v Create Host Access (Manual)

2. 如果已经添加也是在系统上运行主机代理的新主机，请选择 Create Host Access
(Automatic)。否则，请转至步骤 5。

3. 如果自动配置了任何主机，这些主机将作为可用主机显示在左列中。从可用主机
列表选择一个主机，然后单击 Add。

4. 在所有可用主机移至 Select Host 列后，单击 OK。定义了主机和主机端口，您
已完成此过程。

5. 选择 Create Host Access (Manual) 以手动定义主机和主机端口信息。

6. 从“特定主机名和主机类型”窗口输入主机名，然后从主机类型列表选择 Linux 作
为主机类型。单击 Next。

7. 从左窗格的“指定 HBA 主机端口”窗口选择将用于定义主机的 HBA 主机端口的
正确 WWPN、SAS 地址或 IQN。单击 Add。

注：如果主机和 DS3000 控制器之间没有物理连接，将不会显示 WWPN。在这种
情况下，必须通过完成以下步骤来手动输入正确的 WWPN、SAS 地址或 IQN

信息：

a. 单击 New。

b. 输入光纤通道 WWPN、SAS 地址或 iSCSI IQN 信息。

c. 输入主机端口别名。

d. 单击 Add。

8. 在所有主机端口添加至 Selected HBA host port 列后，单击 Next。

9. 从“指定主机组”窗口选择以下某个选项：

No: 如果主机不与其他主机共享访问同一逻辑驱动器。

Yes: 如果主机与其他主机共享访问同一逻辑驱动器
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如果选择 No，请单击 Next。
如果选择 Yes，要么输入一个新的主机组名，要么从列表中选择一个现有的主机
组，然后单击 Next。

10. 查看主机定义详细信息，然后单击 Finish。

定义了主机和主机端口。

定义主机组
主机组是存储分区拓扑中的一个实体，它定义了主机的逻辑集合，这些主机要求对一
个或多个逻辑驱动器进行共享访问。您可以向已定义主机组中的个别主机授予独立于
主机组的对存储分区的访问权。

要定义主机组，请完成以下步骤：

1. 单击 Subsystem Management 窗口中的 Configure 选项卡。

2. 选择 Create Host Group。

3. 输入新的主机组名称（例如，Linux）并从左列中选择主机。单击 Add 以将主机添
加到主机组。

4. 当添加完主机组的所有主机后，单击 OK。

5. 这时将显示一条消息，说明已创建了新主机组。单击 OK。

将 LUN 映射到存储分区
本部分包含将 LUN 映射和添加到主机或主机组的步骤。这些步骤可用于将 LUN 映射
到新分区或将 LUN 添加至现有分区。

要映射 LUN，请完成以下步骤：

1. 选择 Subsystem Management 窗口中的 Configure 选项卡。

2. 选择 Create Host-to-Logical Drive Mapping。

3. 从“选择主机”窗口选择将映射逻辑驱动器的主机或主机组，然后单击 Next。

4. 从“选择逻辑驱动器”窗口选择要映射到步骤 3 中已选择的主机或主机组的逻辑驱
动器。

注：如果所有逻辑驱动器都将映射到同一主机或主机组，单击 Select all logical
drives 复选框。

选定逻辑驱动器后，指定一个介于 0 至 31 的逻辑单元号（LUN）给逻辑驱动器，
然后单击 Finish。

5. 这时将显示“主机至逻辑驱动器的映射过程”窗口。当映射完成后，单击 OK。

6. 映射完成。选择 Yes 以映射其他逻辑驱动器或选择 No 以关闭映射向导。

完成主机配置
安装 Storage Manager 软件后，请完成本部分中描述的主机配置过程。

安装 RDAC 多路径代理驱动程序
本部分描述了如何为基于 POWER 的双路径 Linux 配置安装 RDAC 驱动程序。
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要点：在安装 DRAC 前，确保配置及指定了分区和 LUN，且安装了正确的 HBA 驱动
程序。

要安装 RDAC，请完成以下步骤：

1. 从 IBM DS3000 支持 Web 站点下载 RDAC 驱动程序软件包。

适用于 SLES 9、SLES 10 和 RHEL 4 的 RDAC 软件包：
rdac_LINUX_09.01.B5.xx_source_tar_gz

适用于带 SP1 和 RHEL 5 的 SLES 10 的 RDAC 软件包
rdac_LINUX_09.01.C5.xx_source_tar_gz2

2. 在主机上创建一个目录，并将 RDAC 驱动程序软件包下载到该目录。

3. 通过输入以下命令解压文件：

# tar -zxvf rdac-LINUX-package_version-source.tar.gz

其中 package_version 是在步骤 1中指定的 SLES 或 RHEL 软件包版本号。

将创建 linuxrdac-version#（SLES 9、SLES 10、RHEL 4 和 RHEL 5）的目录。

4. 打开包含在 linuxrdac-version# 目录中的自述文件。

5. 在自述文件中，找到构建和安装驱动程序的说明，并按说明完成步骤，其中有一步
是重新启动服务器。

注：请确保在继续步骤 6 前重新启动服务器。

6. 输入以下命令以列出已安装的模块：

# lsmod

7. 确保这些模块条目包含在 lsmod 列表中，如下所示：

v mppVhba

v mppUpper

v lpfc 或 qla2xxx

注：如果未显示 mpp_Vhba 模块，通常是因为在指定 LUN 之前就重新启动了服务
器，因此未安装 mpp_Vhba 模块。如果是这个原因引起，请立即指定 LUN，重
新启动服务器，然后重复执行步骤 7。

8. 输入以下命令以验证驱动程序版本：

# mppUtil -V
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9. 输入以下命令以验证设备是否配置了 RDAC 驱动程序：

# ls -1R /proc/mpp

将显示与以下示例相类似的输出。

# ls -1R /proc/mpp
/proc/mpp:
total 0
dr-xr-xr-x 4 root root 0 Oct 24 02:56 DS3400-sys1
crwxrwxrwx 1 root root 254, 0 Oct 24 02:56 mppVBusNode

/proc/mpp/ DS3400-sys1:
total 0
dr-xr-xr-x 3 root root 0 Oct 24 02:56 controllerA
dr-xr-xr-x 3 root root 0 Oct 24 02:56 controllerB
-rw-r--r-- 1 root root 0 Oct 24 02:56 virtualLun0
-rw-r--r-- 1 root root 0 Oct 24 02:56 virtualLun1
-rw-r--r-- 1 root root 0 Oct 24 02:56 virtualLun2
-rw-r--r-- 1 root root 0 Oct 24 02:56 virtualLun3
-rw-r--r-- 1 root root 0 Oct 24 02:56 virtualLun4
-rw-r--r-- 1 root root 0 Oct 24 02:56 virtualLun5

/proc/mpp/ DS3400-sys1/controllerA:
total 0
dr-xr-xr-x 2 root root 0 Oct 24 02:56 lpfc_h6c0t2

/proc/mpp/ DS3400-sys1/controllerA/lpfc_h6c0t2:
total 0
-rw-r--r-- 1 root root 0 Oct 24 02:56 LUN0
-rw-r--r-- 1 root root 0 Oct 24 02:56 LUN1
-rw-r--r-- 1 root root 0 Oct 24 02:56 LUN2
-rw-r--r-- 1 root root 0 Oct 24 02:56 LUN3
-rw-r--r-- 1 root root 0 Oct 24 02:56 LUN4
-rw-r--r-- 1 root root 0 Oct 24 02:56 LUN5

/proc/mpp/ DS3400-sys1/controllerB:
total 0
dr-xr-xr-x 2 root root 0 Oct 24 02:56 lpfc_h5c0t0

/proc/mpp/ DS3400-sys1/controllerB/lpfc_h6c0t2:
total 0
-rw-r--r-- 1 root root 0 Oct 24 02:56 LUN0
-rw-r--r-- 1 root root 0 Oct 24 02:56 LUN1
-rw-r--r-- 1 root root 0 Oct 24 02:56 LUN2
-rw-r--r-- 1 root root 0 Oct 24 02:56 LUN3
-rw-r--r-- 1 root root 0 Oct 24 02:56 LUN4
-rw-r--r-- 1 root root 0 Oct 24 02:56 LUN5

注：安装 RDAC 驱动程序后，下列命令和联机帮助页就可用了：

v mppUtil

v mppBusRescan

v mppUpdate

v RDAC

执行初始设备识别
本部分中的初始设备识别过程适用于所有 SLES 和 RHEL 分发，且会说明例外情况。

请按以下顺序完成本部分中的过程：

1. 第 58页的『查看 SCSI 总线』
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2. 『将各 HBA WWPN 与其指定主机端口相关联』

3. 第 60页的『查看 LUN』

4. 第 61页的『将系统 LUN 设备与 DS3000 LUN 相关联』

查看 SCSI 总线
要查看 SCSI 总线，根据系统上是否安装 RDAC，完成以下某个过程。

v 安装了 RDAC：

输入以下命令：

# mppBusRescan

v 未安装 RDAC：

除去模块并将它们重新装入。

输入以下命令以除去这些模块：

# rmmod hba_device_driver

输入以下命令以重新装入这些模块：

# modprobe hba_device_driver

将各 HBA WWPN 与其指定主机端口相关联
要将各 HBA WWPN 与其指定主机端口相关联，请完成以下步骤：

1. 输入以下命令。

对于基于 Emulex 的 HBA：

# cd /proc/scsi/lpfc
# ls

对于基于 QLogic 的 HBA：

# cd /proc/scsi/qla2xxx
# ls

这时将显示 HBA 列表，如以下示例所示。

... 5 4 3 2
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2. 对目录中的各 HBA，输入以下命令：

# cat hba#

其中 hba# 是目录中的 HBA。这时将显示 HBA 属性，如以下示例所示。

[root@x3650 /]# cat /proc/scsi/qla2xxx/2
QLogic PCI to Fibre Channel Host Adapter for QLE2462:

Firmware version 4.00.23 [IP] , Driver version 8.01.06
ISP: ISP2432
Request Queue = 0xbee80000, Response Queue = 0xbee40000
Request Queue count = 4096, Response Queue count = 512
Total number of active commands = 0
Total number of interrupts = 206796

Device queue depth = 0x20
Number of free request entries = 2212
Number of mailbox timeouts = 0
Number of ISP aborts = 0
Number of loop resyncs = 0
Number of retries for empty slots = 0
Number of reqs in pending_q= 0, retry_q= 0, done_q= 0, scsi_retry_q= 0
Host adapter:loop state = <READY>, flags = 0x1e13
Dpc flags = 0x4080000
MBX flags = 0x0
Link down Timeout = 030
Port down retry = 035
Login retry count = 035
Commands retried with dropped frame(s) = 0
Product ID = 0000 0000 0000 0000

SCSI Device Information:
scsi-qla0-adapter-node=200000e08b854260;
scsi-qla0-adapter-port=210000e08b854260;
scsi-qla0-target-0=203500a0b81d2b95;
scsi-qla0-target-1=203400a0b81d2b95;
FC Port Information:
scsi-qla0-port-0=200400a0b81d2b95:203400a0b81d2b95:0000e4:0;

3. 检查输出以验证与控制器的连接性。前一个示例中的输出显示一个带 scsi-qla0-
target-0 和 scsi-qla0-target-1 两个目标以及带 203500a0b81d2b95和
203400a0b81d2b95 WWPN 的 DS3000 连接到 HBA。
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查看 LUN
通过输入以下命令查看 LUN：

# cat/proc/scsi/scsi

这时将显示 LUN 属性，如以下示例所示：

[root@x3650 /]# cat /proc/scsi/scsi
Attached devices:
Host: scsi2 Channel: 00 Id: 01 Lun: 00

Vendor: IBM Model: 1726-4xx FAStT Rev: 0670
Type: Direct-Access ANSI SCSI revision: 05

Host: scsi2 Channel: 00 Id: 01 Lun: 01
Vendor: IBM Model: 1726-4xx FAStT Rev: 0670
Type: Direct-Access ANSI SCSI revision: 05

Host: scsi2 Channel: 00 Id: 01 Lun: 02
Vendor: IBM Model: 1726-4xx FAStT Rev: 0670
Type: Direct-Access ANSI SCSI revision: 05

.....
Host: scsi3 Channel: 00 Id: 01 Lun: 00

Vendor: IBM Model: 1726-4xx FAStT Rev: 0670
Type: Direct-Access ANSI SCSI revision: 05

Host: scsi3 Channel: 00 Id: 01 Lun: 01
Vendor: IBM Model: 1726-4xx FAStT Rev: 0670
Type: Direct-Access ANSI SCSI revision: 05

Host: scsi3 Channel: 00 Id: 01 Lun: 02
Vendor: IBM Model: 1726-4xx FAStT Rev: 0670
Type: Direct-Access ANSI SCSI revision: 05

.....
Host: scsi4 Channel: 00 Id: 00 Lun: 00

Vendor: IBM Model: VirtualDisk Rev: 0670
Type: Direct-Access ANSI SCSI revision: 05

Host: scsi4 Channel: 00 Id: 00 Lun: 01
Vendor: IBM Model: VirtualDisk Rev: 0670
Type: Direct-Access ANSI SCSI revision: 05

Host: scsi4 Channel: 00 Id: 00 Lun: 02
Vendor: IBM Model: VirtualDisk Rev: 0670
Type: Direct-Access ANSI SCSI revision: 05

前面的示例显示了三个 LUN，它们已指定给一个带有二个用于双路径的 HBA 的分区，
且该分区已安装 RDAC。

注：

1. 每个 LUN 都将显示在其配置的两个路径上。指定的活动 HBA 是数字 2 和 3。

2. VirtualDisk 是 RDAC 逻辑盘。不管可用路径的数量有多少，每个 LUN 都有一个
VirtualDisk。

3. 如果已安装 RDAC，但在输出中看不到任何 VirtualDisk，最有可能的原因是未安装
mpp_Vhba 模块。（如果在配置所有 LUN 之前就安装了 RDAC 驱动程序，那么会
出现这种情况。）使用 lsmod 命令验证是否安装了 mpp_Vhba 模块。如果它没有出
现在模块列表中，请确保配置了 LUN，然后重新启动主机。

SLES 9 和 SLES 10：仅可以在 SLES 操作系统上使用 lsscsi 命令而非 cat/proc/
scsi/scsi 查看 LUN。使用 lsscsi 命令的优点是输出更易读，如以下示例中所示：
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[root@x3650 /]# lsscsi
[02:0:0:0] disk IBM 1726-4xx FAStT 0270 –
[02:0:0:1] disk IBM 1726-4xx FAStT 0270 –
[12:0:0:2] disk IBM 1726-4xx FAStT 0270 –
...
[03:0:0:0] disk IBM 1726-4xx FAStT 0270 –
[03:0:0:1] disk IBM 1726-4xx FAStT 0270 –
[03:0:0:2] disk IBM 1726-4xx FAStT 0270 –
...
[04:0:0:0] disk IBM VirtualDisk 0270 /dev/sdb
[04:0:0:1] disk IBM VirtualDisk 0270 /dev/sdc
[04:0:0:2] disk IBM VirtualDisk 0270 /dev/sdd

第四列显示了 DS3000 模型类型，第六列显示了 Linux 指定的设备号。在此示例中，
仅给虚拟 RDAC 设备指定系统设备名。如果未安装 RDAC，将为输出中列出的所有
设备显示系统设备名。

将系统 LUN 设备与 DS3000 LUN 相关联
要将系统 LUN 设备与 DS3000 lun 相关联，请输入以下命令：

# SMdevices

这时将显示设备属性，如以下示例所示：

[root@x3650 /]# /opt/IBM_DS3000/util/SMdevices
IBM System Storage DS4000/FAStT Storage Manager Devices, Version 09.17.A5.01
Built Wed Mar 28 11:53:31 CST 2007
(C) Copyright International Business Machines Corporation, 2003-2007 Licensed Ma
terial - Program Property of IBM. All rights reserved.

/dev/sdb (/dev/sg1) [Storage Subsystem DS3K_SATA_Test, Logical Drive data-1,
LUN 0,
Logical Drive ID <600a0b80001d2b9500004d80469bbb18>, Preferred Path
(Controller-A): In Use]

/dev/sdc (/dev/sg2) [Storage Subsystem DS3K_SATA_Test, Logical Drive data-2,
LUN 1,
Logical Drive ID <600a0b80001d2b9500004d82469bbb20>, Preferred Path
(Controller-A): In Use]

/dev/sdd (/dev/sg3) [Storage Subsystem DS3K_SATA_Test, Logical Drive data-3,
LUN 2,
Logical Drive ID <600a0b80001d2b9500004d7e469bbaa0>, Preferred Path
(Controller-A): In Use]

前面的示例显示了与 DS3000 存储子系统名称相关联的指定系统设备号，以及存储器指
定的 LUN 标识，它们显示在 DS3000 存储子系统上。

在 SLES 和 RHEL 操作系统上，可以执行以下步骤而不是使用 SMdevices 来显示设
备属性。

从 linuxrdac 目录输入以下命令：

# lsvdev
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以下是 lsvdev 命令的输出示例：

[root@x3650 mpp]# ./lsvdev
Array Name Lun sd device
-------------------------------------
DS3K_SATA_Test 0 -> /dev/sdb
DS3K_SATA_Test 1 -> /dev/sdc
DS3K_SATA_Test 2 -> /dev/sdd
DS3K_SATA_Test 3 -> /dev/sde
DS3K_SATA_Test 4 -> /dev/sdf
DS3K_SATA_Test 5 -> /dev/sdg

执行常见维护任务
本部分描述了一些常见的系统管理任务。本部分中的过程适用于 SLES 和 RHEL 安装。
会说明例外情况。

检查 LUN 大小
要检查 LUN 的大小，请完成以下步骤：

1. 输入以下命令：

#cd /sys/block/sdxx
# cat size

其中 xx 是设备名。

这时将显示一个数字，如以下示例所示。

8388608

2. 将此数字乘以 512（字节）以计算 LUN 的大小，如以下示例中所示。

8388608 × 512 = 4294967296 (~ 4GB)

计算结果就是 LUN 的大小。在此示例中，LUN 的大小约为 4 GB。

使用动态容量扩展和动态卷扩展
本部分描述了如何在 Linux on POWER 上使用动态卷扩展（DVE）。

动态卷扩展（DVE）增加了逻辑驱动器的大小。要执行 DVE，阵列上必须有可用空闲容
量。如果没有，您可以先执行动态容量扩展（DCE）以通过添加驱动器来增大阵列容
量。

开始前：确保阵列中有足够的可用空闲容量。可以使用 DS3000 Storage Manager 软件
来确定空闲容量。在 Subsystem Management 窗口的 Summary/Arrays & Logical Drives

视图中，展开希望的阵列并滚动至逻辑驱动器列表的底部。“可用空闲容量”是逻辑
驱动器列表中的一个条目。

执行动态容量扩展操作
要执行动态容量扩展操作，请完成以下步骤：

1. 在“修改/添加空闲容量（驱动器）”视图中，选择要增加容量的阵列。

2. 选择 Next。

3. 在“Add capacity to array”窗口中选择可用驱动器。
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4. 选择 Finish。

注：此窗口中将显示可用的空闲磁盘及其容量。

启动操作后，在阵列的各逻辑驱动器帝将显示一个时钟，此时钟将一直显示到操作结
束。此过程可能持续几个小时，必须允许其在继续下一步前完成。

注：操作完成所需的时间取决于 I/O 活动、增加的容量、驱动器技术及其他因素。

执行动态卷扩展操作
执行动态卷扩展需要 Storage Manager 软件 SMcli 接口或 Storage Manager 软件脚本
编辑器。

以下示例显示了通过 Engineering_FEB 逻辑驱动器上的脚本编辑器窗口运行动态卷扩展
所需的命令语法。增加的容量是 1 GB。

set logicalDrive ["Engineering_FEB"] addCapacity=1GB;

要了解关于扩展逻辑卷管理器（LVM）逻辑驱动器的更多信息，请参阅 chvg 命令的联
机帮助页。

要在 Linux 主机上执行 DVE，请完成以下步骤：

1. 停止要增加大小的逻辑驱动器的 I/O。

2. 如果安装有逻辑驱动器，请卸下该逻辑驱动器。

3. 从 Storage Manager 软件 SMcli 接口或 Storage Manager 软件脚本编辑器输入以下
命令：

set logicalDrive [logical_drive_name] addCapacity=xGB;

其中 logical_drive_name 是要增加大小的逻辑驱动器的名称，而 x 是该逻辑驱动器
增大的大小数量。

注：在开始任何主机干预前，必须等此过程完成。如果存储子系统忙碌，此过程可
能要花上几个小时才能完成。

4. 当 LVE 过程完成时，在主机上通过输入以下命令重新查找逻辑驱动器：

# cd /sys/block/sdxx/device
# echo 1 > rescan

其中 xx 是设备名。

5. 执行第 62页的『检查 LUN 大小』中描述的步骤来检查逻辑驱动器的大小。

6. 重新安装逻辑驱动器。

使用 SMdevices 实用程序查找关于 LUN 的信息
SMutil 具有一个重要的实用程序功能，即 SMdevices，您可以使用它将主机为各 LUN

指定的设备名映射回其对应的 DS3000 存储子系统设备。

在 SMdevices 输出中，您可以查看 DS3000 存储子系统信息，它显示在 SMclient 上。

注：列表中的这些示例参考 SMdevices 输出样本。

以下示例显示了存储子系统 DS3K_SATA_Test 的 SMdevices 输出样本。
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[root@x3650 /]# /opt/IBM_DS3000/util/SMdevices
IBM System Storage DS4000/FAStT Storage Manager Devices, Version 09.17.A5.01
Built Wed Mar 28 11:53:31 CST 2007
(C) Copyright International Business Machines Corporation, 2003-2007 Licensed Ma
terial - Program Property of IBM. All rights reserved.

/dev/sdb (/dev/sg1) [Storage Subsystem DS3K_SATA_Test, Logical Drive data-1, LUN 0,
Logical Drive ID <600a0b80001d2b9500004d80469bbb18>, Preferred Path (Controller-A):
In Use]

/dev/sdc (/dev/sg2) [Storage Subsystem DS3K_SATA_Test, Logical Drive data-2, LUN 1,
Logical Drive ID <600a0b80001d2b9500004d82469bbb20>, Preferred Path (Controller-A):
In Use]

/dev/sdd (/dev/sg3) [Storage Subsystem DS3K_SATA_Test, Logical Drive data-3, LUN 2,
Logical Drive ID <600a0b80001d2b9500004d7e469bbaa0>, Preferred Path (Controller-A):
In Use]

v 主机指定的名称：/dev/sdb

v DS3000 存储子系统名称：DS3K_SATA_Test

v 逻辑驱动器名称：data-1

v LUN 标识：LUN 0

v 首选的控制器所有者，以及控制器当前是否控制逻辑驱动器

查看或更改队列深度和“no device timeout”选项
将 queue_depth 属性设置为适当值对于系统性能而言非常重要。如果您有一个配置了多
个逻辑驱动器和主机的大型 DS3400 配置，请使用此设置获取高性能。

针对运行 Linux 操作系统并使用 Emulex FC HBA 的 System p 服务器将 『no device

timeout』 选项设置为 144 秒。更改此参数可以改进使用 RDAC 时的错误处理。请参
阅 Emulex 自述文件，了解有关非 RDAC 配置的首选设置信息。

本部分提供了计算系统的最大队列深度的方法，可将此方法作为指导来帮助您确定适
用于您配置的最佳队列深度。

计算最大队列深度
在 DS3400 存储子系统上，请使用下面的公式来计算系统的最大队列深度：

2048 /（主机数量 × 每台主机的 LUN 数量）

例如，带四台主机且每台主机带 32 个 LUN 的系统的最佳队列深度为 16：

2048 / ( 4 × 32 ) = 16

要点：

v 在所有情况下，最大队列深度可能不是最佳设置。将此最大队列深度作为指导，针
对您特定配置对设置进行相应调整。

v 在连接有一个或多个 SATA 设备的系统中，可能需要将队列深度属性设置为一个比最
大队列深度小的值。

查看当前队列深度
要查看各 LUN 的队列深度，请输入以下命令：

# cat /proc/scsi/sg/{device_hdr,devices}
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查看当前的“no device timeout”选项
要查看每个 HBA 的“no device timeout”选项，请输入以下命令：

# cat /sys/class/scsi_host/hostx/lpfc_nodev_tmo

注：如果已安装 RDAC，显示在输出中的队列深度数值将不同于队列深度的主机设置
值，因为 RDAC 驱动程序将为每个 LUN 采用两个队列。例如，在以下样本输出
中，被映射到主机 11 的 LUN 的队列深度将设置为 10；因为已安装 RDAC，因
此输出显示队列深度为 8。

#cat /proc/scsi/sg/device_hdr devices
host chan id lun type opens qdepth busy online
0 0 1 0 5 0 2 0 1
0 0 8 0 0 3 8 0 1
11 0 4 0 0 0 8 0 1
11 0 4 1 0 0 8 0 1
11 0 4 2 0 0 8 0 1
11 0 4 3 0 0 8 0 1
11 0 4 4 0 0 8 0 1

更改队列深度和“no device timeout”选项
要更改队列深度和“no device timeout”选项，请完成以下步骤：

1. 使用 vi 编辑器，根据操作系统打开以下某个配置文件以便进行编辑：

v SLES 9 和 SLES 10：
/etc/modprobe.conf.local

v RHEL 4 和 RHEL 5：
/etc/modprobe.conf

2. 根据 HBA 的类型将以下某个选项参数添加到配置文件：

v 基于 Emulex 的 HBA： options lpfc_lun_queue_depth=xx lpfc_nodev_tmo=144

v 基于 QLogic 的 HBA： ql2xmaxqdepth=xx

其中 xx 是新的队列深度值。

3. 设置新的队列深度值，如下：

v 安装了 RDAC：
输入 mppUpdate 命令，然后重新启动服务器。

v 未安装 RDAC：
卸载可用的 HBA 驱动程序，然后将其重新装入。

示例：要在带有基于 Emulex 的 HBA 和基于 QLogic 的 HBA 的 RHEL 4 系统上将
队列深度值更改为 10，并将“no device timeout”选项更改为 144，请输入以下
命令：

# vi /etc/modprobe.conf
options lpfc lpfc_lun_queue_depth=10 lpfc_nodev_tmo=144
options qla2xxx ql2xmaxqdepth=10

更换系统上的 IBM 主机总线适配器
该部分提供了通过使用 PCI 热插拔工具，更换运行 SLES 9 SP4、SLES 10 SP1、RHEL

4.6 或 RHEL 5.1 的 System p 服务器中 IBM 主机总线适配器的要求和过程。
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要求
PCI 热插拔工具：

确保以下工具安装在 /usr/sbin 目录中：

v lsslot

v drslot_chrp_pci

要安装这些工具，请完成以下步骤：

1. 确保从 SLES 9 介质安装 rdist-6.1.5-792.1 和 compat-2004.7.1-1.2。

2. 从以下一个 Web 站点下载 PCI 热插拔工具 rpm 文件：

SLES 9：

https://www14.software.ibm.com/webapp/set2/sas/f/lopdiags/suselinux/other/

SLES 10：

https://www14.software.ibm.com/webapp/set2/sas/f/lopdiags/suselinux/other/sles10.html

RHEL 4：

https://www14.software.ibm.com/webapp/set2/sas/f/lopdiags/redhat/other/rhel4.html

RHEL 5：

https://www14.software.ibm.com/webapp/set2/sas/f/lopdiags/redhat/other/rhel5.html

要浏览这些地址，请完成以下步骤：

a. 转至 http://www.ibm.com/systems/support/。

b. 在 Product support 下单击 Power。

c. 在 Popular links 下单击 Firmware updates。

d. 在 Other microcode-related services 下单击 Download hardware ser-
vice aids for Linux on Power。

e. 在 Red Hat 或 Suse Linux 下单击 on other servers。

f. 单击这些选项卡以显示适用服务和生产力工具的列表。

3. 针对以下工具下载 rpm 文件：

v 平台支持库

v PCI 热插拔工具

4. 输入以下命令以安装每个 rpm 文件：

# rpm -Uvh filename.rpm

其中 filename 是 rpm 文件的名称。

主机总线适配器：

该过程不支持刀片服务器中安装的主机总线适配器。

PCI 内核：

要确保 PCI 内核已装入系统，请输入以下命令：
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# ls -l /sys/bus/pci/slots

如果已装入 PCI 内核，那么输出类似以下示例。

elm17c224:/usr/sbin # ls -l /sys/bus/pci/slots
total 0
drwxr-xr-x 8 root root 0 Sep 6 04:29 .
drwxr-xr-x 5 root root 0 Sep 6 04:29 ..
drwxr-xr-x 2 root root 0 Sep 6 04:29 0000:00:02.0
drwxr-xr-x 2 root root 0 Sep 6 04:29 0000:00:02.4
drwxr-xr-x 2 root root 0 Sep 6 04:29 0000:00:02.6
drwxr-xr-x 2 root root 0 Sep 6 04:29 0001:00:02.0
drwxr-xr-x 2 root root 0 Sep 6 04:29 0001:00:02.6
drwxr-xr-x 2 root root 0 Sep 6 04:29 control

如果未显示 /sys/bus/pci/slots 目录，那么未装入 PCI 内核。

rpaphp 驱动程序：

要确保 rpaphp 驱动程序已装入系统，请输入以下命令：

ls -l /sys/bus/pci/slots/*

如果已装入 rpaphp 驱动程序，那么输出类似以下示例。

elm17c224:/usr/sbin # ls -l /sys/bus/pci/slots/*
/sys/bus/pci/slots/0000:00:02.0:
total 0
drwxr-xr-x 2 root root 0 Sep 6 04:29 .
drwxr-xr-x 8 root root 0 Sep 6 04:29 ..
-r--r--r-- 1 root root 4096 Sep 6 04:29 adapter
-rw-r--r-- 1 root root 4096 Sep 6 04:29 attention
-r--r--r-- 1 root root 4096 Sep 6 04:29 max_bus_speed
-r--r--r-- 1 root root 4096 Sep 6 04:29 phy_location
-rw-r--r-- 1 root root 4096 Sep 6 04:29 power

列出有关 I/O 插槽的信息
使用 PCI 热插拔工具更换 HBA 之前，可以使用 lsslot 工具列出有关 I/O 插槽的信
息。本部分描述如何使用 lsslot 工具，并提供了示例。

lsslot 命令的语法： lsslot 工具具有以下语法：

v 语法：lsslot [ -c slot | -c pci [ -a | -o]] [ -s drc-name ] [ -F delimiter ]

v 选项：

No options 显示所有 DR 插槽

-c slot 显示所有 DR 插槽

-c pci 显示所有 PCI 热插拔插槽

-c pci -a 显示所有可用（空）PCI 热插拔插槽

-c pci -o 显示所有已用 PCI 热插拔插槽

-F 使用定界符划分列

使用 lsslot 命令列出 PCI 热插拔插槽： 本部分显示可用于列出 PCI 热插拔插槽的
命令行。
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注：在命令行输出的 Device(s) 列中，插槽中的 PCI 设备如 xxxx:yy:zz.t 所列。（例
如：0001:58:01.1）

列出所有 PCI 热插拔插槽： 输入以下命令以列出所有 PCI 热插拔插槽：

# lsslot -c pci -a

所得的输出类似以下示例。

# Slot Description Device(s)
U7879.001.DQD014E-P1-C1 PCI-X capable, 64 bit, 133MHz slot Empty
U7879.001.DQD014E-P1-C2 PCI-X capable, 64 bit, 133MHz slot 0002:58:01.0
U7879.001.DQD014E-P1-C3 PCI-X capable, 64 bit, 133MHz slot 0001:40:01.0
U7879.001.DQD014E-P1-C4 PCI-X capable, 64 bit, 133MHz slot Empty
U7879.001.DQD014E-P1-C5 PCI-X capable, 64 bit, 133MHz slot Empty
U7879.001.DQD014E-P1-C6 PCI-X capable, 64 bit, 133MHz slot 0001:58:01.0
0001:58:01.1

列出所有空 PCI 热插拔插槽： 输入以下命令以列出所有空 PCI 热插拔插槽：

# lsslot -c pci -a

所得的输出类似以下示例。

# Slot Description Device(s)
U7879.001.DQD014E-P1-C1 PCI-X capable, 64 bit, 133MHz slot Empty
U7879.001.DQD014E-P1-C4 PCI-X capable, 64 bit, 133MHz slot Empty
U7879.001.DQD014E-P1-C5 PCI-X capable, 64 bit, 133MHz slot Empty

列出所有已用 PCI 热插拔插槽： 输入以下命令以列出所有已用 PCI 热插拔插槽：

# lsslot -c pci -o

所得的输出类似以下示例。

# Slot Description Device(s)
U7879.001.DQD014E-P1-C2 PCI-X capable, 64 bit, 133MHz slot 0002:58:01.0
U7879.001.DQD014E-P1-C3 PCI-X capable, 64 bit, 133MHz slot 0001:40:01.0
U7879.001.DQD014E-P1-C6 PCI-X capable, 64 bit, 133MHz slot 0001:58:01.0
0001:58:01.1

显示有关特定设备的详细信息： 从 # lsslot -c pci -o 命令的输出中选择一个设备号，
如以上输出示例所示。输入以下命令以显示有关该特定设备的详细信息：

# lspci | grep xxxx:yy:zz.t

其中 xxxx:yy:zz.t 是 PCI 热插拔设备的编号。所得的输出类似以下示例。

0001:40:01.0 Ethernet controller: Intel Corp. 82545EM Gigabit
Ethernet Controller (Copper) (rev 01)

更换 PCI 热插拔 HBA

drslot_chrp_pci 命令的语法： drslot_chrp_pci 工具具有以下语法：

v 语法：drslot_chrp_pci -c slot {-r | -a | -R | -i } -s slot-name

v 选项：
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-r 除去

-a 添加

-R 更换

-i 识别

更换 HBA： 要通过使用 drslot_chrp_pci 命令更换 PCI 热插拔 HBA，请完成以下步
骤：

注：在以下过程中，变量 slot-name 是包含正在更换的 HBA 的插槽。

警告： 卸下 HBA 之前，必须拔掉与其连接的光纤通道电缆。光纤通道电缆断开连接至
少 5 分钟，以确保将所有 I/O 活动都传输到备用通道。未拔掉光纤通道电缆可能会导
致意外的结果。

1. 要识别 PCI 热插拔插槽，请输入以下命令。

# drslot_chrp_pci -i -s slot-name

其中 slot-name 是正在更换的 HBA 的插槽名称。（例如，U7879.001.DQD014E-P1-

C3。）

插槽 slot-name 的指示灯开始闪烁，并显示以下消息：

The visual indicator for the specified
PCI slot has been set to the identify
state. Press Enter to continue or
enter x to exit.

2. 要从插槽热插拔 HBA，请完成以下步骤：

a. 拔掉连接到该 HBA 的光纤通道电缆，然后等待完成故障转移。

b. 完成故障转移之后，请输入以下命令：

# drslot_chrp_pci -r -s slot-name

将显示以下消息：

The visual indicator for the specified
PCI slot has been set to the identify
state. Press Enter to continue or
enter x to exit.

c. 按 Enter 键。将显示以下消息：

The visual indicator for the specified
PCI slot has been set to the action state.
Remove the PCI card from the identified slot
and press Enter to continue.

d. 按 Enter 键。

e. 从插槽中实际卸下 HBA。

f. 输入以下命令以确保插槽为空：

# lsslot -c pci -s slot-name
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如果插槽为空，那么所得的输出类似以下示例。

# Slot Description Device(s)
U7879.001.DQD014E-P1-C3 PCI-X capable, 64 bit, 133MHz slot Empty

3. 要通过热插拔操作将 HBA 直接插入插槽，请完成以下步骤：

a. 输入以下命令：

# drslot_chrp_pci -a -s slot-name

将显示以下消息：

The visual indicator for the specified
PCI slot has been set to the identify
state. Press Enter to continue or
enter x to exit.

b. 按 Enter 键。将显示以下消息：

The visual indicator for the specified
PCI slot has been set to the action state.
Insert the PCI card into the identified slot,

connect any devices to be configured
and press Enter to continue. Enter x to exit.

c. 将新的 HBA 插入插槽。

d. 输入以下命令以确保该插槽不为空：

# lsslot -c pci -s slot-name

如果插槽不为空，那么所得的输出类似以下示例。

# Slot Description Device(s)
U7879.001.DQD014E-P1-C3 PCI-X capable, 64 bit, 133MHz slot 0001:40:01.0

在 DS3000 存储子系统上重新分配 WWPN
更换 HBA 之后，要在 DS3000 存储子系统上重新分配其新的 WWPN，请完成以下步
骤：

1. 如果已安装了 RDAC，请输入以下命令以识别出新的 HBA：

# mppBusRescan

2. 启动 Storage Manager 软件。

3. 在 Storage Manager Subsystem Management 窗口的 Mappings View 中，选择之前
分配给更换的 HBA 的 HBA 主机端口。

4. 右键单击 HBA 主机端口，然后选择 Replace。这时将打开新的 Storage Manager

窗口。

5. 在新的窗口中，从下拉菜单中选择新的主机 WWPN，或在 New Identifier 字段中
输入 WWPN。

6. 单击 OK，关闭该窗口。

7. 再次输入 mppBusRescan。通过检查 lsscsi 命令输出，确保新更换的 HBA 能识别
LUN。
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第 5 章 完成 Storage Manager 软件的安装和配置

本章提供了使用 Storage Manager 2 软件的 Enterprise Management 和 Subsystem Man-

agement 功能部件完成 AIX 和 Linux on POWER 操作系统环境的安装任务的相关信
息。

要完成 Storage Manager 2 软件安装，请执行以下任务。以下部分将详细讨论这些任务。

1. 执行存储子系统发现。

2. 根据需要添加设备。

3. 根据需要设置警报通知。

4. 命名存储子系统。

5. 下载固件和 NVSRAM。

6. 创建阵列和逻辑驱动器。

7. 配置异构主机。

8. 将逻辑驱动器映射到分区。

9. 执行其他存储子系统任务。

启动 Storage Manager 软件并找到存储子系统
要启动 Storage Manager 软件并找到存储子系统，请完成以下步骤：

1. 选择以下某个命令：

v 对于 AIX：输入 /usr/SMsmclient/SMclient

v Linux：输入 /opt/IBM_DS3000/client/SMclient（缺省情况下）。

将启动客户端软件并打开 Enterprise Management 窗口。然后，在 Enterprise Man-

agement 窗口的顶部会打开 Task Assistant 窗口（如第 74页的图 8 所示）和 Select

Addition Method 窗口（如第 72页的图 6 所示）。
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2. 选择 Automatic 可发现连接到本地子网的所有主机和存储子系统。选择 Manual 可
指定连接到本地子网的设备的 IP 地址。

注：首次自动发现后，刷新 Enterprise Management 窗口最长需要 1 分钟。

3. 确保 Enterprise Manager 窗口中显示了所有主机和存储子系统。

如果某个主机或存储子系统未显示，请完成以下任务：

v 检查硬件和硬件连接是否存在可能问题（请参阅硬件文档获取特定过程）。

v 要获取发现存储子系统的更多信息，请参阅 Enterprise Management 联机帮助。

v 如果正在使用直接管理方法，请确保所有主机和存储子系统都连接到同一子网。
如果正在使用主机代理方法，请确保主机与存储子系统之间已建立 I/O 连接。

v 确保已完成第 15页的第 2 章, 『准备安装』中为直接管理系统设置存储子系统的
所有准备步骤。如果已完成，请使用 Add Device 选项添加存储子系统的 IP 地
址。添加控制器的两个 IP 地址。否则，当您尝试管理存储子系统时，会显示 par-

tially-managed device 错误消息。

v 如果要使用主机代理管理方法，请完成以下步骤：

a. 确保主机上已安装 SMagent。

b. 确保存储子系统与安装 SMagent 的主机之间已建立有效的 I/O 连接。

c. 确保已完成第 15页的第 2 章, 『准备安装』中列出的所有准备步骤。如果已
完成，请完成以下步骤：

图 6. Select Addition Method 窗口
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1) 运行 hot_add 实用程序。

2) 使用第 103 页的『停止并重新启动主机代理软件』中的信息，重新启动
SMagent。

3) 在 Enterprise Management 窗口中单击主机，然后
单击 Tools → Rescan。

注：在特定情况下，自动发现后设备树中可能出现重复的存储子系统。可以使用
Enterprise Management 窗口中的 Remove Device 选项从设备树中除去重复的存
储管理图标。

4. 确保每个存储子系统的状态均为 Optimal。如果某个设备的状态显示为 Unrespon-

sive，请右键单击该设备并选择 Remove Device，从管理域中删除它。然后使用
Add Device 选项将它再次添加到管理域中。要获取除去和添加设备的指示信息，请
参阅 Enterprise Management 窗口联机帮助。

图 7 显示了首次自动发现后的 Enterprise Management 窗口。

使用 Task Assistant
启动 Storage Manager 软件时，将启动客户端软件并打开 Enterprise Management 窗口。
然后，Task Assistant 窗口将打开并提供一个中心位置，您可以从该位置选择执行最常见
的任务。

注：除非您选中 Task Assistant 窗口底部的 Don’t show the task assistant at
start-up again 复选框，否则每次打开 Enterprise Management 窗口时都会自动打
开 Task Assistant 窗口。

图 7. Enterprise Management 窗口
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Task Assistant 提供以下任务的快捷方式：

v 添加存储子系统

v 命名或重命名存储子系统

v 配置警报

v 管理存储子系统

图 8 显示了 Enterprise Management Window Task Assistant。

要在启动 Storage Manager 软件后打开 Task Assistant，请在 Enterprise Management 窗

口中单击 View → Task Assistant，或在工具栏上单击 Task Assistant 图标 。

图 8. Enterprise Management Window Task Assistant
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添加存储子系统
要手动添加更多主机或存储子系统，请在 Enterprise Management 窗口中单击 Edit →
Add Storage Subsystem。您可以使用这个选项有选择地管理 Storage Manager Cli-

ent 的一组存储子系统，还可以添加要进行管理但首次发现过程中未发现的设备。要获取
更多信息，请参阅 Enterprise Management 窗口联机帮助。

要点：

v 当您添加未识别设备时，将打开一个窗口确认该设备已成功添加并且您可以管理该
存储子系统。正确发现未识别设备组中列出的任何设备之前，您无法管理这些设
备。确保已建立连接并再次尝试添加设备。

v 当您将新的存储子系统添加到 SAN 中的现有存储子系统并且通过主机代理软件来管
理 SAN，您必须停止并重新启动主机代理服务。当主机代理服务重新启动时，将检测
到新的存储子系统。要获取更多信息，请参阅第 103页的『停止并重新启动主机代
理软件』。然后，转至 Enterprise Management 窗口并单击 Tools → Rescan，将新
的存储子系统添加到管理域。

v 当您将新的存储子系统添加到通过直接（频带外）管理方法管理的现有存储子系
统，请务必指定两个控制器的 IP 地址。

命名存储子系统
要命名存储子系统，请完成以下步骤：

1. 在 Enterprise Management 窗口中，选择某个存储子系统，右键单击并选择
Rename。这时将打开 Rename Storage Subsystem 窗口。

图 9. Rename Storage Subsystem 窗口
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2. 输入存储子系统的名称（请参阅第 109页的表 9）。然后单击 OK。将显示一条警告消
息，指出更改存储子系统名称可能导致主机应用程序无法访问该存储子系统。单击
Yes 继续，或单击 No 取消命名存储子系统。

3. 为每个未命名的存储子系统重复该过程。要获取更多信息，请参阅 Subsystem Man-

agement 窗口联机帮助中重命名存储子系统的相关主题。

配置警报
将设备添加到管理域后，您可以设置警报通知以报告存储子系统的重大事件。提供以
下警报通知选项：

v 通过简单网络管理协议（SNMP）陷阱向指定网络管理站（NMS）发送通知

v 向指定电子邮件地址发送通知

注：只能在管理域中监控存储子系统。如果未安装 Event Monitor 服务，那么 Enter-

prise Management 窗口必须保持打开。如果关闭该窗口，您将无法从管理的存储子
系统收到任何警告通知。要获取更多信息，请参阅 Enterprise Management 窗口联
机帮助。

要设置警报通知，请在 Enterprise Management 窗口中单击 Edit → Configure Alerts。

要通过使用 SNMP 陷阱将警报通知设置为向网络管理站（NMS）发送通知，请完成以
下步骤：

1. 将主机配件支持 CD 插入 NMS 上的 CD 驱动器。指定管理站只应设置一次。

2. 将文件 SM2.MIB 从 SM2MIB 目录复制到 NMS。

3. 按照 NMS 要求的步骤操作以编译管理信息基本程序（MIB）文件。要获取更多信
息，请与您的网络管理员联系或参阅存储管理软件随附的文档。

Initial Setup Tasks 窗口
从 Subsystem Management 窗口可以打开 Initial Setup Tasks 窗口，其中包含到以下任
务的链接。

v 定位存储子系统

v 重命名存储子系统

v 设置存储子系统密码

v 配置主机访问权

v 管理 iSCSI 设置（仅适用于 DS3300）

v 配置存储子系统

要打开“Initial Setup Tasks”窗口，请完成以下步骤：

1. 在 Enterprise Management 窗口中，双击要执行设置任务的存储子系统。这时将打开
Subsystem Management 窗口。

2. 单击 Summary 选项卡。

3. 在 Summary 页面上，单击 Perform Initial Setup Tasks。这时将打开 Initial Setup

Tasks 窗口，如第 77页的图 10 所示。
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注：除非您选中 Initial Setup Tasks 窗口底部的 Do not show this again for this
storage subsystem 复选框，否则每次打开 Subsystem Management 窗口时都会
自动打开 Initial Setup Tasks 窗口。

创建存储子系统概要文件
要点：当您修改存储子系统中的阵列和逻辑驱动器时，请创建存储子系统概要文件并
妥善保存。这个概要文件包含逻辑和物理磁盘配置信息等具体的控制器信息，它们可
以帮助您在发生故障时恢复配置。请勿将概要文件保存在收集和保存其概要文件的
DS3000 存储子系统中创建的逻辑驱动器中。

要保存存储子系统概要文件，请完成以下步骤：

1. 在 Subsystem Management 窗口中，单击 Summary → Storage Subsystem Pro-
file。这时将打开 Storage Subsystem Profile 窗口。

2. 单击 Save As。

3. 选择要保存的部分并提供用于保存概要文件的文件名。

图 10. Subsystem Management 窗口中的 Initial Setup Tasks 窗口
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您也可以单击 Support → Gather Support Information，如图 11 所示，从存储子系
统收集清单、状态、诊断和性能数据并将它们保存到一个压缩文件中。

配置主机访问
使用主机服务器中的逻辑驱动器之前，您必须定义及配置要访问的主机。

要配置主机访问，请完成以下步骤：

1. 单击 Subsystem Management 窗口中的 Configure 选项卡。选择以下某个选项：

v 要自动配置主机访问，请单击 Configure Host Access (Automatic) 并根据向
导指示信息操作。按照向导中的指示信息完成操作后，本过程结束。

注：要自动检测主机，Storage Manager 2 Agent 服务必须处于运行状态。继续之
前，请确保已安装 SMagent。

v 要手动配置主机访问，请单击 Configure Host Access (Manual) 并继续至步
骤 2。

2. 启动 Configure Host Access (Manual) 向导时，指定主机名和主机类型，然后单击
Next。

注：使用主机服务器中的逻辑驱动器之前，必须指定正确的主机类型。主机类型可
决定存储子系统控制器与控制器所连接主机上的各个操作系统的配合方式。欲
了解支持的主机类型，请参阅 Storage Manager 软件自述文件。

3. 显示 Specify HBA Host Ports 区域时，请在 Selected HBA host port iden-
tifiers/aliases 字段中添加已知或新的主机总线适配器，然后单击 Next。

图 11. Gather Support Information 窗口
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4. （可选）显示 Specify Host Group 区域时，指定将与逻辑驱动器共享访问权的主
机组。指定主机组时，您可以新建主机组或选择已定义的现有主机组。选择 No 或
Yes，然后单击 Next。

定义主机组
主机组是存储分区拓扑中的一个实体，它定义了主机服务器的逻辑集合，这些服务器
要求对一个或多个逻辑驱动器进行共享访问。您也可以向已定义主机组中的个别主机
授予对未由其他节点共享的其他逻辑驱动器的访问权，但这需要额外的存储分区。可
以与主机组或主机组中的个别主机建立逻辑驱动器至 LUN 映射。

要点：如果您已购买存储分区高级功能部件，请确保启用该高级功能部件。如果您无
法启用该高级功能部件，请参阅密钥随附的高级功能部件启用指示信息，或与
您的技术支持代表联系。

注：您可以在定义主机组时配置异构主机。这样，运行于不同操作系统上的主机可以
访问同一个存储子系统。

要定义主机组，请完成以下步骤：

1. 在 Subsystem Management 窗口中，单击 Configure → Create Host Group 启动
Create Host Group 向导。

2. 显示 Create Host Group 区域时，输入主机组的名称并将所有可用的主机添加到
该主机组中。

3. 单击 OK。

注：要在此时将主机添加到主机组，必须已配置用于访问的可用主机。可以首先创
建一个主机组而不添加主机，今后使用 Create Host Access (Manual) 向导添加
主机。要获取更多信息，请参阅第 78页的『配置主机访问』。

创建阵列和逻辑驱动器
独立磁盘冗余阵列（RAID）阵列是一组按逻辑分类的硬盘驱动器。

逻辑驱动器是您为保存存储子系统上的数据而创建的基本逻辑结构。操作系统将逻辑
驱动器识别为单个驱动器。选择相应的 RAID 级别以满足应用程序对数据的可用性需求
并实现 I/O 性能最大化。

一个阵列最多支持 30 个驱动器。每个阵列可以分为 1-256 个逻辑驱动器。
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要创建阵列和逻辑驱动器，请完成以下步骤：

1. 在 Enterprise Management 窗口中，双击存储子系统打开 Subsystem Management 窗
口。

2. 单击 Configure 选项卡。

3. 单击 Create Logical Drives。将启动 Create Logical Drives 向导并打开 Select

Capacity Type 窗口。

4. 选中 Unconfigured capacity 或 Free capacity，然后单击 Next。

注：如果选中 Free capacity，必须首先从现有阵列中选择可用容量节点，然后才
能继续执行向导操作。

如果选择 Unconfigured capacity，请跳至步骤 第 82页的 10。

5. 在 Select drive type 列表中选择 SAS 或 SATA。

图 12. Create Logical Drives 向导窗口
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注：必须使用具有相同磁盘类型的驱动器来创建阵列。您无法在同一个阵列中同
时使用 SATA 和 SAS 驱动器。

6. 显示 Drive Selection Choices 区域时，选择 Automatic 或 Manual，然后单
击 Next。如果选择 Automatic，请继续执行步骤 7。如果选择 Manual，请跳至
步骤 8。

注：建议选择 Automatic，这样可以快速、简便地进行配置。这种方法允许您从自
动生成的驱动器列表和容量选项中进行选择。高级用户可使用 Manual 选项指
定用于新建阵列的驱动器。

7. 显示 Choose Configuration (Automatic Configuration) 区域时，选择 RAID

级别并单击 Finish。

注：自动配置会根据选定的 RAID 级别，配置存储子系统中当前可用的所有剩余未
配置容量。查看 Configuration summary 字段可了解即将配置项的详细信
息。

8. 显示 Manual Drive Selection 区域时，如第 82页的图 14 所示，选择 RAID 级
别。从 Unselected drives 区域中选择驱动器，然后单击 Add 将它们移至
Selected drives 区域中。在 Selected drives 区域中，单击 Calculate Capac-
ity，然后单击 Next。

图 13. 选择容量类型
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9. 显示 Specify Logical Drive 区域时，为逻辑驱动器指定容量、名称和 I/O 特性，
然后单击 Next。

10. 显示 Map Logical Drive To Host 区域时，选择 Map now 立即映射逻辑驱动
器或使用 第 78页的『配置主机访问』 中定义的主机或选择 Map later 稍后映射
逻辑驱动器，然后单击 Next。

注：

a. 如果您之前未配置主机，将显示一条警告消息。阅读消息后单击 OK；然后继续
Create Logical Drives 向导操作。

b. 要现在映射逻辑驱动器，必须先前已配置主机或主机组（继续之前，请确保为
逻辑驱动器指定 LUN 编号）。如果选择 Map later，您可以通过 Create Host-

to-Logical Drive Mappings 向导映射逻辑驱动器。要获取更多信息，请参阅『将
LUN 映射到分区』。

注：对于集群配置，如果添加或删除逻辑驱动器，必须告知节点 A 和 B。

将 LUN 映射到分区
当逻辑单元号（LUN）映射到分区时，它们被指定给各个逻辑驱动器。

要将 LUN 映射到新分区或现有分区，请完成以下步骤：

1. 在 Subsystem Management 窗口中，单击 Configure → Create Host-to-Logical
Drive Mappings 启动向导。

2. 显示 Select Host 区域时，选择主机或主机组，然后单击 Next。

图 14. Manual Drive Selection 区域

82 针对 AIX、Linux on POWER 和 Sun Solaris 的 DS3000 Storage Manager 安装和支持指南



3. 显示 Select Logical Drives 区域时，选择要映射到指定主机的逻辑驱动器，然后
单击 Finish。

配置热备用设备
您可以将存储子系统中的可用物理驱动器指定为热备用驱动器，以使数据保持可用状
态。热备用驱动器不包含任何数据，在阵列中的驱动器发生故障时可作为备用的驱动
器。如果阵列中的驱动器发生故障，那么在存储子系统运行期间，控制器会自动使用
热备用驱动器来更换发生故障的驱动器。该控制器会使用冗余数据将发生故障的驱动
器中的数据自动重建至替换的（热备用）驱动器。这称为重建。

热备用驱动器将另一级别的冗余添加到存储子系统。如果存储子系统中的驱动器发生
故障，那么热备用驱动器会自动进行替代，而无需物理交换。如果在逻辑驱动器发生
故障时热备用驱动器可用，那么控制器会使用冗余数据将发生故障的逻辑驱动器中的
数据重建至热备用驱动器。如果更换了发生故障的驱动器或指定其他驱动器为替换驱
动器，那么热备用驱动器中的数据会回拷到替换驱动器。这称为回拷。

图 15. 选择主机区域
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要指定一个热备用驱动器，请打开 Subsystem Management 窗口，单击 Configure 选
项卡，并选择以下一个选项：

v Automatically assign drives。如果选择该选项，将使用可用的驱动器自动创建热
备用驱动器，以实现最佳的热备用替换。

v Manually assign individual drives。如果选择该选项，将从通过 Configure Hot

Spares 窗口手动选择的可用驱动器中创建热备用驱动器。

如果选择手动指定热备用驱动器，所选择的驱动器的容量要等于或大于想要用该热备
用驱动器替换的驱动器的总容量。要获得最大的数据保护，请勿指定驱动器为热备
用，除非其容量等于或大于存储子系统上最大驱动器的容量。仅使用最大容量的驱动
器，作为混合容量硬盘驱动器配置中的热备用驱动器。

更换硬盘驱动器
如果硬盘驱动器发生故障且热备用驱动器可用，那么热备用驱动器会开始重建过程，
临时更换发生故障的驱动器。按照可配置的驱动器更换策略，可以选择以下一个选
项：

v 使用替换的驱动器更换发生故障的驱动器。替换的驱动器会从热备用驱动器执行回
拷操作，并成为阵列的一部分。

v 从 Replace Drive 窗口中（在 Modify 选项卡上），选择当前属于性能下降阵列的热
备用驱动器，以便成为该阵列的永久成员。

v 从 Replace Drive 窗口中（在 Modify 选项卡上），选择存储机箱中的另一个可用驱
动器，以指定为替换的驱动器。该驱动器会从热备用驱动器执行回拷操作，并成为
阵列的一部分。

注：替换的驱动器的选择直到热备用驱动器完成其重建过程时才可完成。
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管理 iSCSI 设置（仅 DS3300）

注：Subsystem Management 窗口中的 iSCSI 选项卡仅可用于 DS3300 存储子系统。

在 Subsystem Management 窗口中，单击 iSCSI 选项卡。将打开一个类似于下图的窗
口。

iSCSI 页面中具有以下选项：

v Change Target Authentication

v Enter Mutual Authentication Permissions

v Change Target Identification

v Change Target Discovery

v Configure iSCSI Host Ports

v View/End iSCSI Sessions

v View iSCSI Statistics

图 16. Manage ISCSI Settings 页面
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更改目标认证
选择 Change Target Authentication 指定发起方在 iSCSI 登录的安全性协商阶段必
须使用的目标提问握手认证协议（CHAP）密钥。缺省情况下选择 None。要更改此选
择，单击 CHAP，然后输入 CHAP 密钥。如有需要，可以选择此选项生成随机密钥。
这将启用单向 CHAP。

输入相互认证权限
在选择 Enter Mutual Authentication Permissions 之前，必须为启动器定义主机端
口并启用 Target Authentication。列出主机端口后，从列表中选择主机，然后单击
Chap Secret 指定从目标传送到发起方用以认证此主机的密钥。这将启用相互型 CHAP

（双向）。

更改目标认证
选择 Change Target Identification 指定在设备发现期间所使用的目标别名。为目标
指定的名称必须是唯一的且由字符数小于 30 的字符串组成。

注：使用别名上方列出的标准 IQN 连接到目标。

更改目标发现
选择 Change Target Discovery，使用 iSCSI 简单命名服务（iSNS）执行设备发现任
务。选择此选项后，选中 Use iSNS Server 复选框。还可以选择是否使用网络上的
DHCP 服务器来发现 iSNS 服务器，并且可以手动指定因特网协议 V4（IPv4）或 IPv6

地址。在您单击 Advanced 选项卡时，可以为 iSNS 服务器指定其他 TCP/IP 端口，
从而进一步增强安全性。

注：要为正确的设备发现提供所需的端口登录信息，所有的 iSCSI 端口都必须能够与同
一个 iSNS 服务器通信。

配置 iSCSI 主机端口
选择 Configure iSCSI Host Ports 以配置所有的 TCP/IP 设置。可以选择在所有的
端口上启用或禁用 IPv4 和 IPv6。也可以静态分配 IP 地址或使用 DHCP 发现这些地
址。在 Advanced IPv4 Settings 下，可以分配 VLAN 标记（802.1Q）或设置以太
网优先级（802.1P）。在 Advanced Host Port Setting 下，可以为此目标端口指定唯
一的 iSCSI TCP/IP 端口。也可以通过此选项启用超长帧。支持的帧大小是 1500 和
9000。

查看或结束 iSCSI 会话
选择 View/End iSCSI Sessions 查看所有与目标连接的 iSCSI 会话。在此页面上，
还可以通过强制目标 ASYNC 从发起方会话注销来关闭现有会话。

查看 iSCSI 统计信息
选择 View iSCSI Statistics 查看所有 iSCSI 会话数据的列表，例如，标题摘要错误
数、数据摘要错误数以及成功的协议数据单元数。也可以在进行纠正操作之后设置一
个基线计数以确定问题是否得以解决。
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确定固件级别
有两种方法可用于确定 DS3000 存储子系统、扩展单元、驱动器和 ESM 固件的版本。
每种方法都使用 Storage Manager Client，它通过连接的扩展单元来管理 DS3000 存储
子系统。

方法 1
打开 Subsystem Management 窗口，然后单击 Summary 选项卡。在 Hardware Com-
ponents 区域选择 Storage Subsystem Profile。当 Storage Subsystem Profile 窗口
打开时，选择以下某个选项卡来查看固件信息。

注：Storage Subsystem Profile 窗口包含整个子系统的所有概要信息。因此，您可能需要
滚动浏览大量数据才能找到所需的信息。

Summary

v Firmware version（控制器固件）

v NVSRAM 版本

以下示例显示 Summary 页面上的概要信息。

图 17. Summary 页面上的概要信息示例
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Controllers

v 固件版本

v Appware version（Appware 引用控制器固件）

v Bootware version（Bootware 引用控制器固件）

v NVSRAM 版本

以下示例显示 Controllers 页面上的概要信息。

Enclosures

v 固件版本

以下示例显示 Enclosures 页面上的概要信息。

图 18. Controllers 页面上的概要信息示例

图 19. Enclosures 页面上的概要信息示例
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Drives

v Firmware version（驱动器固件）

以下示例显示 Drives 页面上的概要信息。

方法 2
打开 Subsystem Management 窗口，在“支持”页面上选择 Download Firmware。选
择以下某个选项查看固件信息。

注：方法 2 仅用于确保固件版本正确无误。检查固件版本后，请取消或关闭窗口，防止
不慎下载固件。

Download controller firmware

v Firmware version（控制器固件）

v NVSRAM 版本

Download NVSRAM

v NVSRAM 版本

Download drive firmware

v Firmware version（驱动器固件）

Download Environmental Services Monitor (ESM) firmware

v Enclosure firmware version

下载控制器、NVSRAM、ESM 和硬盘驱动器固件
本部分提供下载 DS3000 存储子系统控制器固件和 NVSRAM、EXP3000 ESM 固件以
及驱动器固件的指示信息。DS3000 存储子系统固件下载顺序如下：

v 控制器固件

v NVSRAM

v ESM 固件

v 硬盘驱动器固件

图 20. Drives 页面上的概要信息示例
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要点：将固件和 NVSRAM 下载到 DS3000 存储子系统时，请停止所有 I/O 活动，否
则主机服务器与 DS3000 存储子系统之间的连接会丢失。

注：您可以从 http://www.ibm.com/servers/storage/support/disk/ 下载最新版本的 DS3000

存储子系统控制器固件、NVSRAM、EXP3000 ESM 和硬盘驱动器固件。

下载控制器或 NVSRAM 固件
要下载 DS3000 存储子系统控制器固件和 NVSRAM，请完成以下步骤：

1. 在 Enterprise Management 窗口中，双击存储子系统打开 Subsystem Management 窗
口。

2. 单击 Support → Download firmware → Download Controller Firmware。这时
将打开 Download Controller Firmware 窗口，如图 21 所示。

3. 要选择控制器固件文件，单击 Selected controller firmware file 字段旁的 Select
File，然后浏览到要下载的文件。

4. 要选择 NVSRAM 文件，单击 Selected NVSRAM file 字段旁的 Select File，然
后浏览到要下载的文件。

要使用控制器固件传输 NVSRAM 文件，选中 Transfer NVSRAM file with con-
troller firmware 复选框。

5. 单击 Transfer。

图 21. Download Controller Firmware 窗口
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下载 ESM 固件
要下载 ESM 固件，请完成以下步骤。

注：必须在所有 I/O 静默的情况下才可下载 ESM 固件。

1. 在 Subsystem Management 窗口中，单击 Support → Download firmware → Down-
load Environmental (ESM) Card Firmware。这时将打开 Download Environmen-

tal (ESM) Card Firmware 窗口。

2. 选中 Select All 复选框可对所有机箱执行下载。您也可以选择一个机箱，或通过按
住 Ctrl 键来选择一组机箱。

3. 要选择 ESM 固件文件，请单击 Selected ESM firmware file information字段旁
的 Select File，然后浏览到要下载的文件。

4. 单击 Start 开始 ESM 固件下载。这时将打开 Confirm Download 窗口。

5. 输入 yes 并单击 OK 开始下载过程。

6. 完成所有选定机箱的 ESM 固件下载后，单击 Close。

ESM 固件自动同步
当您将新的 ESM 安装到现有的存储扩展箱中，而该扩展箱又连接到支持 ESM 固件自
动同步的 DS3000 存储子系统时，新 ESM 中的固件将与现有 ESM 中的固件自动同
步。这可以自动解决所有 ESM 固件不匹配的问题。

注：只有将 ESM 固件文件成功下载到存储扩展箱中的 ESM 后，才能执行 ESM 固件
自动同步。

图 22. Download Environmental (ESM) Card Firmware 窗口

第 5 章 完成 Storage Manager 软件的安装和配置 91



要启用 ESM 固件自动同步，请确保您的系统满足以下要求：

v Storage Manager Event Monitor 已安装并处于运行状态。

v 在 Storage Manager Client（SMclient）Enterprise Management 窗口中定义 DS3000 存
储子系统。

下载驱动器固件
本部分提供下载 DS3000 驱动器固件的指示信息。要获取更多信息，请参阅联机帮助。

要点：开始下载驱动器固件之前，请完成以下任务：

v 在向 DS3000 存储子系统下载驱动器固件之前，停止所有 I/O 活动。

v 对于访问要升级固件的驱动器的所有逻辑驱动器，卸装它们的文件系统。

v 为您选择进行固件升级的驱动器执行所有数据的完全备份。

要下载驱动器固件，请完成以下步骤：

1. 在 Enterprise Management 窗口中，双击存储子系统打开 Subsystem Management 窗
口。

2. 单击 Support → Download firmware → Download Drive Firmware。这时将
打开 Download Drive Firmware 窗口。

3. 单击 Add 找到包含待下载固件的服务器目录。

4. 选择要下载的固件文件并单击 OK。该文件随后将列入 Selected Packages 区域
中。

5. 为任何其他驱动器类型选择要下载的固件文件，然后单击 OK。其他文件随后也会
列入 Selected Packages 区域中。最多可选择四种驱动器类型。

6. 单击 Add 重复步骤 5，直至您已选择了要下载的所有固件文件。

7. 指定要下载的固件软件包后，单击 Next。

8. 在 Select Drive 窗口（如第 93页的图 24 所示）中，单击 Compatible Drives 选
项卡。Compatible Drives 页面包含一个驱动器列表，这些驱动器与您选择的固件软

图 23. Download Drive Firmware 窗口

92 针对 AIX、Linux on POWER 和 Sun Solaris 的 DS3000 Storage Manager 安装和支持指南



件包类型兼容。用鼠标依次选择多个驱动器时按住 Ctrl 键，或用鼠标选择系列中列
出的多个驱动器时按住 Shift 键。将您在步骤 第 92页的4 和 第 92页的5 中选择
的兼容固件下载到选定的驱动器。

注：Compatible Drives 页面中应列出您选择下载的固件软件包。如果您的驱动器产
品标识与固件类型匹配，但页面中并未将它作为兼容固件列出，请与您的技
术支持代表联系以获取更多指示信息。

9. 单击 Finish 开始将驱动器固件下载到您在步骤 第 92页的 8 中选择的各个兼容驱
动器。

10. 当显示 Download Drive Firmware 警告窗口和消息 Do you want to continue? 时，
请输入 yes 并单击 OK 开始下载驱动器固件。这时将打开 Download Progress 窗
口，如第 94页的图 25 所示。在下载过程完成之前，请勿干预下载。

图 24. Select Drive 窗口
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计划下载固件的各个驱动器将标为 in progress，直至其状态变为 successful 或
failed。

11. 如果驱动器下载失败，请完成以下步骤：

a. 单击 Save as 按钮保存错误日志。

b. 在 Subsystem Management 窗口中，单击 Support → View Event Log 并完
成以下步骤以保存存储子系统事件日志，然后与您的技术支持代表联系：

1) 单击 Select all。

2) 单击 Save as。

3) 提供用于保存日志的文件名。

Close 按钮激活时，表明驱动器固件下载过程已完成。

12. 单击 Close。

阵列导入和导出功能
阵列导入和导出功能支持在 DS3000 存储子系统之间进行配置传输。

要点：阵列导入和导出功能仅可用于运行控制器固件 V07.35 或更高版本的 DS3000 存
储子系统。该功能不可用于使用控制器固件 V06.xx 的存储子系统或阵列。

导出阵列
要导出阵列，请完成以下步骤：

1. 在 Subsystem Management 窗口中，单击 Advanced Support 选项卡。

2. 单击 Export Array。这时将打开 Export Array 向导。该向导会帮助您准备将阵列
从一个存储子系统导出到另一个存储子系统。

要点：开始导出功能之前，必须针对要导出的阵列停止所有 I/O 操作。

图 25. Download Progress 窗口
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3. 选择要导出的阵列，然后单击 Next。

图 26. 在 Export Array 向导中选择一个阵列

第 5 章 完成 Storage Manager 软件的安装和配置 95



4. 这时会打开 Preparation Checklist 窗口，提供了导出阵列之前必须完成步骤的列表。

5. 完成准备核对表之后，单击 Finish。

6. 在 Confirm Export 窗口中，输入 yes 以开始导出操作过程，然后单击 OK。

7. 完成导出操作之后，就可以从存储子系统中卸下硬盘驱动器。

导入阵列
要导入阵列，请完成以下步骤：

1. 将与导出的阵列关联的硬盘驱动器插入存储子系统。

2. 在 Subsystem Management 窗口中，单击 Advanced Support 选项卡。

图 27. Export Array Preparation Checklist 窗口
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3. 单击 Import Array。这时会打开 Import Report 窗口，并显示您正在导入阵列的详
细信息。

4. 如果报告中的信息是正确的，请在 Confirm Import 窗口中输入 yes，然后单击 OK
以开始导入操作过程。

执行其他存储子系统管理任务
以下列表描述可执行的其他存储子系统管理任务。您可以在 Subsystem Management 窗
口中执行以下任务。

v 创建热备用（Configure → Configure Hot Spares）

v 自动创建逻辑驱动器和热备用（Configure → Automatic Configuration）

v 编辑子系统的主机拓扑配置（Modify → Edit Topology）

v 输入或更改存储子系统密码（Tools → Set or Change Password）

v 查看或更改介质扫描设置（Tools → Change Media Scan Settings）

v 定位存储子系统或其组件（Tools → Locate）

v 查看或启用高级功能部件（Tools → View/Enable Premium Features）

v 更改存储子系统的机箱标识号（Tools → Change Enclosure ID Numbers）

v 同步控制器时钟（Tools → Synchronize Controller Clocks）

图 28. Import Report 窗口
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v 更改网络配置（Tools → Change Network Configuration）

v 重置电池寿命（Tools → Reset Battery Age）

v 继承操作系统的系统设置（Tools → Inherit System Settings）

v 查看主要事件日志（Support → View Event Log）

v 保存所有存储子系统数据（Support → Gather Support Information）

v 使控制器联机或脱机（Support → Manage Controllers）

要获取有关这些任务和其他存储子系统管理任务的更多信息，请参阅 Subsystem Man-

agement 联机帮助中的相应主题。

高级用户：您可以在 Enterprise Management 窗口中，通过单击 Tools → Script Edi-
tor 执行其他存储子系统管理任务。要获取更多信息，请参阅 Enterprise Management 窗
口联机帮助。

注：如果存储子系统出现问题，存储子系统旁的 Enterprise Management 窗口中会显示
Needs Attention 状态图标。在 Subsystem Management 窗口中，Summary 页面的
状态区会显示 Storage Subsystem Needs Attention 链接。您可以单击该链接打开
Recovery Guru 。也可以在 Subsystem Management 窗口中单击 Support → Recover
from Failure 打开 Recovery Guru 。

DS3300 的最佳实践准则
为使 Storage Manager 软件和 DS3300 达到最佳性能，请遵循以下部分中的准则。

iSNS 最佳实践
正确使用 iSNS 服务器有许多注意事项。确保正确分配了在发起方或目标的 DHCP 租
用发现期间提供的 iSNS 服务器地址。当使用基于发起方的软件解决方案时将简化发现
过程。如果您无法做到这一点，而且必须手动将 iSNS 服务器指定给软件或硬件发起
方，那么应该确保 DS3300 目标和 iSCSI 发起方的所有端口在同一网段中（或确保不
同网段间的路由是正确的）。如果这一点也无法实现，将无法在 iSCSI 发现过程中发现
所有端口，因此可能无法正确地进行控制器或路径故障转移。

使用 DHCP
不建议为目标门户网站使用 DHCP。如果您使用的是 DHCP，应该分配保留的 DHCP，
这样在 DS3300 存储子系统重新启动后租用仍有效。如果未提供静态的保留 IP，启动
器端口可能会丢失与 DS3300 控制器的通信，并且可能无法重新连接到设备。

使用支持的硬件发起方
本文档发布时，唯一支持的软件启动器是 IBM Eserver BladeCenter 的 QLogic iSCSI

扩展卡。

所有受支持的硬件发起方都使用相同的基本固件代码和 SANsurfer 管理应用程序。在安
装和配置这些适配器之前，请确保您已安装了最新的管理应用程序和最新的固件代
码。确认此点后，每次配置一台适配器。

要确保正确执行故障转移，通过以下两种基本配置中的一种来连接每台适配器：
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v 如果已进行所有适配器和目标端口都在同一网段中的简单配置，那么每个适配器都
应该能登录到任何目标端口。

v 如果已进行复杂配置，那么每个适配器都有单独的路径连接到每台控制器设备。

要从硬件发起方正确登录到所有可用的目标端口，请完成以下步骤。

注：如果未能执行以下过程中的步骤，可能导致路径故障转移不一致且 DS3300 操作不
正确。

1. 启动 SANsurfer 管理实用程序。

2. 连接到运行 qlremote 代理的系统。

3. 选择要配置的适配器。

4. 为适配器选择端口 0 或端口 1。

5. 单击 Target Settings。

6. 单击窗口最右侧的加号（+）。

7. 输入要连接的目标端口的 IPv4 或 IPv6 地址。

8. 单击 OK。

9. 选择 Config Parameters。

10. 滚动到看见 ISID 为止。

11. 对于连接 0，列出的最后一个字符应该为 0。对于连接 1，应该为 1，对于连接 2，
应该为 2，以此类推。

12. 对于要创建的每个目标连接，重复步骤 6 至 11。

13. 在连接所有会话后，请选择 Save Target Settings。

如果使用用于 IBM System x™ 的 QLogic iSCSI 单端口或双端口 PCIe HBA 支持
IPv6，那么应该允许主机总线适配器固件分配本地链路地址。

使用 IPv6
DS3300 支持因特网协议 V6（IPv6）TCP\IP。请注意，如果您手动分配本地链路地址，
那么仅能配置最后四个八位元。前四个八位元是 fe80:0:0:0。尝试从发起方连接到目标时
需要完整的 IPv6 地址。如果您未提供完整的 IPv6 地址，发起方可能无法连接到目标。

网络设置
在复杂网络拓扑中使用 DS3300 将产生一些问题。如果可能，请尝试将 iSCSI 流量隔
离到专门的网络。如果不可能进行隔离，应该遵循下述建议：

v 如果使用的是基于硬件的发起方，“保持激活状态”超时应该为 120 秒。要设置“保
持激活状态”超时，请完成以下步骤：

1. 启动 SANsurfer 管理实用程序并连接到服务器。

2. 选择要配置的适配器和适配器端口。

3. 选择端口选项和固件。

缺省连接超时是 60 秒。对于简单网络拓扑而言这是正确的设置；但是，如果在较
复杂的配置中未使用快速生成树域和单独生成树域，一旦发生网络汇总您可能会
遇到 I/O 超时问题。
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v 如果是使用 Linux 软件发起方连接 DS3300，请修改 ConnFailTimeout 以解决步骤 第
99页的3 中描述的生成树问题。ConnFailTimeout 值应该设置为 120 秒。

操作系统注意事项
为了实现最佳性能，请勿在同时使用嵌入式软件启动器与 Red Hat Enterprise Linux 4

和 SUSE Linux Enterprise Server 9 操作系统的时候，启用数据和头摘要。如果启用这
些功能，将降低性能，万一有多主机同时访问同一个 DS3300 存储子系统，您可能会发
现路径被错误地标注为已失败。

SATA 磁盘驱动器的最佳实践准则
如果组合分割区大小为 8 KB，就无法在配置有 SATA 驱动器的逻辑驱动器上执行
Linux ext2 文件系统的格式化。为了实现最佳性能，请确保使用 SATA 磁盘驱动器时
的组合分割区大小至少为 32 KB。

光纤通道的最佳实践准则
如果您安装的 Linux 主机中带有 QLogic 主机总线适配器，将安装分发版随附的缺省设
备驱动程序。该设备驱动程序会启用嵌入式故障转移支持，将阻止所有可用控制器路
径的正常发现。您必须安装解决方案中所提供的最新 HBA 设备驱动程序，并确保在安
装 MPP 故障转移驱动器之前使用该设备驱动程序重制 RAM 磁盘映像。如果操作失
败，将导致控制器和路径故障转移错误。

Storage Manager 2 Enterprise Manager 视图和 Subsystem
Management 视图的最佳实践准则

在使用 Storage Manager 2 Enterprise Management 视图和 Application Management 视
图之前，必须注意以下信息：

v 当前用于收集性能统计信息的命令（ s a v e s t o r a g e s u b y s t e m

performancestats=filename.xls;）收集不到任何有效数据。所有值都为零（0）。本文档
发布时，无任何可用的变通方法。

v 要使用 smcli 或 Enterprise Manager 脚本编辑器来创建逻辑驱动器，就必须确保命令
的语法正确。指定逻辑驱动器大小时，正确的语法如下：

create logicalDrive array[array_number] capacity=size_of_logical_drive TB/GB/MB;

注：在 TB/GB/MB 之前必须留有一个空格；否则命令不起作用。

v Storage Manager 2 Application Management 视图仅限于创建至多 64 个 FlashCopies

和 128 个 VolumeCopies。但是使用 Storage Manager 命令行界面最多可创建 128 个
FlashCopies 和 255 个 VolumeCopies。

v 如果您正在更新 DS3000 存储子系统，第一次可能无法下载控制器固件。如果出现这
种情况，请再次启动固件下载并验证固件是否成功下载。如果固件下载仍然失败，
请联系 IBM 技术支持代表。

v 要使用 smcli 或 Enterprise Manager 脚本编辑器来扩展逻辑驱动器，就必须确保命令
的语法正确。指定逻辑驱动器大小时，正确的语法如下：

set logicalDrive[logical_drive_name]
addCapacity=size_to_increase_logical_drive_by TB/GB/MB;
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注：在 TB/GB/MB 之前必须留有一个空格；否则命令不起作用。

v 如果管理客户机和管理控制器或控制器 TCP/IP 地址的主机代理之间正在使用
firewall，请确保已为 TCP/IP 端口 2463 创建独占模式。该端口用于 Storage Man-

ager 软件与管理器子系统之间的通信。

v 如果要将 Storage Manager 软件从先前版本升级到 Storage Manager V02.70.xx.xx，
就必须重新搜索所有存储子系统。无法维护先前的管理域。
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第 6 章 完成存储管理任务

本章提供的信息包括如何使用 SMdevices 实用程序、启动和停止主机代理软件，以及卸
载 Storage Manager 软件。

使用 SMdevices 实用程序
SMutil 软件包含实用程序 SMdevices，您可以使用它查看与操作系统设备名关联的存储
子系统逻辑驱动器。当您要使用 DS3000 LUN 来映射主机系统 LUN 时，这个实用程
序很实用。

注：SMdevices 命令在 DS3300 存储子系统中不可用。

在存储子系统上创建逻辑驱动器后，要使用 SMdevices，请在连接到该存储子系统的主
机上完成以下步骤：

1. 在命令提示符中，转至 util 目录，其中 IBM DS3000 Storage Manager 软件安装在
主机系统上。

2. 输入以下命令：

# SMdevices

该软件将显示以下设备标识信息。

/dev/sdb (/dev/sg1) [存储子系统 CGG_SATA_Test、逻辑驱动器 data-1、
LUN 0、
逻辑驱动器标识<600a0b80001d2b9500004d80469bbb18>、
首选路径（控制器 A）：使用中]

在此示例中：

v /dev/sdb (/dev/sg1) 是“磁盘管理器”中显示的磁盘编号

v CGG_SATA_Test 是 DS3000 存储子系统的名称

v data-1 是逻辑驱动器的名称

v LUN 0 是与逻辑驱动器相关联的 LUN

停止并重新启动主机代理软件
如果要将存储子系统添加到主机代理软件的管理域，必须停止并重新启动主机代理软
件。重新启动服务时，主机代理软件会发现新的存储子系统并将它们添加到管理域。

注：如果重新启动后未检测到任何访问逻辑驱动器，主机代理软件将自动停止运行。
确保主机与 DS3300 或 DS3400 存储子系统连接的 SAN 之间的光纤通道或 iSCSI

连接状态正常。然后重新启动主机或集群节点，以发现新的主机代理管理存储子
系统。

要停止并重新启动主机代理软件，请使用以下命令：

# SMagent start 启动 SMagent

# SMagent stop 停止 SMagent
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卸载存储管理软件组件
使用以下过程卸载 Storage Manager 2 软件的一个或多个组件。软件删除过程中将保留
现有存储阵列映射和存储分区配置，并且新的客户端软件可识别它们。

要点：除非您的技术支持代表要求您卸载 MPIO PCM 或 RDAC MPP 设备驱动程序，
否则不要卸载它。

要卸载 Storage Manager 2 软件，请完成以下步骤：

1. 打开端子窗口并转至 Uninstall IBM_DS3000 目录。

2. 输入以下命令：

# sh Uninstall_IBM_DS3000

3. 选择以下某个卸载选项：

a. 全部除去所有功能和组件

b. 选择已安装的特定功能

4. 选择选项 a 并按 Enter 键完成卸载过程。

5. 选择选项 b，然后选择以下功能进行卸载：

v Storage Manager 2 客户机

v Storage Manager 2 实用程序

v Storage Manager 2 代理程序

输入要卸载的功能编号并按 Enter 键完成卸载过程。
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第 7 章 启用和使用高级功能部件

高级功能部件提供一些增强功能，您可以使用这些功能执行使用基本型号的存储子系
统执行时受限制或无法执行的任务。

您可以购买 DS3000 存储子系统的以下高级功能部件：

v DS3000 FlashCopy 扩展许可证

v DS3000 卷拷贝许可证

v DS3000 FlashCopy 卷拷贝许可证

v DS3000 分区扩展许可证

要获取有关如何购买高级功能部件的信息，请与您的 IBM 销售代表或授权经销商联系。

获取激活密钥文件并启用高级功能部件
请按照您的高级功能部件随附的《激活指示信息》文档操作以获取激活密钥文件。Stor-

age Manager 软件需要激活密钥文件才能启用高级功能部件。

启用 DS3000 分区扩展许可证
您可以升级 DS3000 分区扩展许可证，将存储子系统从 4 个分区升级至 16 个分区。
获得 DS3000 分区扩展许可证密钥后，请完成以下步骤启用 Storage Manager 软件中的
此功能部件：

1. 打开 Subsystem Management 窗口并单击 Tools → View/Enable Premium Fea-
tures。

2. 在 Enabled Premium Features 下，单击 Upgrade a feature，如第 106页的图
29 所示。
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这时将打开 Select Feature Key File 窗口。

3. 选择您从 IBM Web 站点获得的功能部件密钥文件，然后单击 OK。

4. 在 Enable Premium Feature 窗口中单击 Yes。

启用 DS3000 FlashCopy 扩展许可证
获得 DS3000 FlashCopy 扩展许可证密钥后，请完成以下步骤启用 Storage Manager 软
件中的此功能部件：

1. 打开 Subsystem Management 窗口并单击 Tools → View/Enable Premium Fea-
tures。

2. 在 Disabled Premium Features 下，单击 Enable a feature，如图 29 所示。
这时将打开 Select Feature Key File 窗口。

3. 选择您从 IBM Web 站点获得的功能部件密钥文件，然后单击 OK。

4. 在 Enable Premium Feature 窗口中单击 Yes。

启用 DS3000 VolumeCopy 许可证

注：本文档、Storage Manager Client 程序界面和联机帮助中使用的术语 VolumeCopy 和
逻辑驱动器复制可以互换。

要启用 DS3000 VolumeCopy 许可证，请完成以下步骤：

1. 打开 Subsystem Management 窗口并单击 Tools → View/Enable Premium Fea-
tures。

2. 在 Disabled Premium Features 下，单击 Enable a feature，如图 29 所示。
这时将打开 Select Feature Key File 窗口。

3. 选择您从 IBM Web 站点获得的功能部件密钥文件，然后单击 OK。

图 29. View/Enable Premium Features 窗口
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4. 在 Enable Premium Feature 窗口中单击 Yes。

使用 FlashCopy 高级功能部件
FlashCopy 逻辑驱动器是称为“基本逻辑驱动器”的逻辑驱动器的逻辑时间点映像。
FlashCopy 逻辑驱动器具有以下特征：

v 可快速创建，并且所需磁盘空间比实际逻辑驱动器少。

v 可以为它指定主机地址，这样您可以在基本逻辑驱动器联机并可访问时使用 FlashCopy

逻辑驱动器执行备份操作。

v 可以使用 FlashCopy 逻辑驱动器执行应用程序测试或方案开发和分析。这并不影响实
际生产环境。

v 允许的最大 FlashCopy 逻辑驱动器数是控制器型号支持的逻辑驱动器总数的一半。

要获取有关 FlashCopy 功能部件以及如何管理 FlashCopy 逻辑驱动器的更多信息，请
参阅子系统管理联机帮助。

要点：在 Windows Server 2003 或 NetWare 环境中，FlashCopy 驱动器不能添加或映
射到拥有 FlashCopy 逻辑驱动器的基本逻辑驱动器的同一台服务器。您必须将 FlashCopy

逻辑驱动器映射到另一台服务器。

要创建 FlashCopy 逻辑驱动器，请完成以下步骤：

1. 为确保您具有基本逻辑驱动器的正确时间点映像，请停止应用程序并清空基本逻辑
驱动器的高速缓存 I/O。

2. 打开 Subsystem Management 窗口，单击 Configure → Create FlashCopy Logi-
cal Drive，并按照向导中的指示信息操作。

3. 要获取将 FlashCopy 逻辑驱动器添加到主机的指示信息，请参阅子系统管理联机帮
助。

注：要管理已创建的 FlashCopy 逻辑驱动器，请单击 Modify 选项卡并选择 Modify
FlashCopy Logical Drives。选择 Disable FlashCopy Logical Drives、Re-
create FlashCopy Logical Drives 或 Expand the FlashCopy Repository，
然后按照向导中的指示信息操作。

使用 VolumeCopy
VolumeCopy 功能部件是一个基于固件的机制，用于在存储器阵列中复制逻辑驱动器数
据。这个功能部件设计为一个系统管理工具，用于执行将数据转移到其他驱动器以实
现硬件升级、性能管理、数据备份或快照卷数据复原等任务。您可以通过指定两个兼
容的驱动器来提交 VolumeCopy 请求。一个驱动器指定为源驱动器，另一个则指定为目
标驱动器。VolumeCopy 请求为持久请求，因此复制进程的所有相关结果都会传递给您。

要获取有关 VolumeCopy 功能部件以及如何管理 VolumeCopy 逻辑驱动器的更多信息，
请参阅子系统管理联机帮助。

要创建 VolumeCopy，请打开 Subsystem Management 窗口，单击 Configure → Cre-
ate Volume Copy，并按照向导中的指示信息操作。

注：要管理已创建的 VolumeCopy 逻辑驱动器，请单击 Modify → Manage Logical
Drive Copies。将显示 VolumeCopy 请求的列表。对于每个 VolumeCopy，请选
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择 Re-Copy 或 Stop，如果要修改属性，请选择 Permissions 和 Priority。图
30 显示了该工具。

图 30. Manage Logical Drive Copies 窗口
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附录 A. 存储子系统和控制器信息记录

表 9 提供一个数据表，用于记录存储子系统名称、管理类型、以太网硬件地址和 IP 地
址。请将此表复印一份并填入您的存储子系统和控制器信息。使用这些信息来设置网
络服务器和主机的 BOOTP 表或域名系统（DNS）表。在初次安装后，若要添加存储子
系统，这些信息也很有用。每个列标题包含一个页码索引，它指向获取信息的详细指
示信息。信息记录样本请参阅第 18页的表 8。

表 9. 存储子系统和控制器信息记录

存储子系统名称
（第 17 页）

管理方法（第 6
页）

控制器：以太网和 IP 地址、主机名（第 17 和
19 页）

主机：IP 地址和主机名（第
19 页）
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附录 B. 使用 IBM System Storage DS3000 控制器固件升级工
具

要点：
仅在将 DS3000 控制器从 V06.22 或 V06.24 升级到 V07.35 时使用 IBM Sys-

tem Storage DS3000 控制器固件升级工具。

请勿使用控制器固件升级工具为控制器、ESM 或硬盘驱动器固件执行标准升级过
程。要为 DS3000 控制器、EXP3000 ESM 或硬盘驱动器执行标准固件升级过程，
请参阅第 89页的『下载控制器、NVSRAM、ESM 和硬盘驱动器固件』。

概述
警告： 为防止数据丢失，在使用控制器固件升级工具从固件 V06.22 或 V06.24 升级到
V07.35 之前，必须备份所有数据并保存现有系统配置。升级工具完成固件升级之后，
DS3000 控制器无法返回到之前的固件版本级别。

使用升级工具之前，请阅读以下重要信息：

v 脱机执行升级。

v 联机在现有主机环境中执行 Storage Manager 软件的全部安装。

v 要使大多数故障转移驱动程序生效，请重新启动主机。

v 确保所有设备在下载固件之前都处于 Optimal 状态。

v 检查当前固件级别，确保固件级别为 06.22.xx.xx 或 06.24.xx.xx。固件升级工具仅支
持从固件 V06.22.xx.xx 或 V06.24.xx.xx 升级到 07.xx 级别固件。

警告： 要避免潜在的数据访问丢失，请检查 Storage Manager 自述文件，确保下载的
固件与安装在存储子系统上的 Storage Manager 软件兼容。如果下载了不兼容的固件，
可能导致不能访问存储子系统中的驱动器，因此先要升级 Storage Manager 软件。请勿
在升级过程中对配置进行更改或卸下驱动器或机箱。

检查存储子系统的运行状况
要确定存储子系统的运行状况，请完成以下步骤：

1. 在 Storage Manager 软件的 Array Management 窗口中，右键单击存储子系统。Stor-

age Manager 软件会与每个受管设备建立通信，并确定当前状态。存在六种可能的状
况：

Optimal
存储子系统中的每个组件都处于所希望的运行状况。

Needs Attention
存储子系统中存在问题，需要进行干预以便纠正问题。

Fixing 已纠正了 Needs Attention 问题，存储子系统当前正在进入 Optimal 状态。

Unresponsive
管理站无法与存储子系统中的一个或两个控制器通信。
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Contacting Device
Storage Manager 软件正与存储子系统建立联系。

Needs Upgrade
存储子系统正在运行的固件级别不再受 Storage Manager 软件支持。

2. 如果状态为 Needs Attention，请记下该情况。与 IBM 技术支持代表联系，获取故
障解决方案。

注：Storage Manager 软件中的 Recovery Guru 还提供情况和恢复过程的详细说明。

安装控制器固件升级工具
要安装控制器固件升级工具，请完成以下步骤：

1. 根据操作系统的过程，打开 DS3000 Storage Manager 10 安装文件。IBM System Stor-

age DS3000 控制器固件升级工具会作为 Storage Manager 10 安装的一部分而安装。

2. 单击 Next。

3. 接受许可协议，然后单击 Next。

4. 选择要在其中安装该工具的文件夹，然后单击 Next。

5. 单击 Install。

6. 单击 Done。

添加存储子系统
要使用升级工具添加存储子系统，请完成以下步骤：

1. 单击 Add。这时将打开 Select Addition Method 窗口。

2. 选择 Automatic 或 Manual。

3. 单击 OK，开始添加存储子系统。

4. 要查看已添加的存储子系统存在的可能阻止升级固件的任何问题，请单击 View
Log。

下载固件
要下载固件，请完成以下步骤：

1. 选择希望针对其下载固件的存储子系统，然后单击 Download Firmware。这时将
打开 Download Firmware 窗口。

2. 要从计算机或网络上的目录中选择要下载的控制器固件文件，请单击 Browse。

3. 要从计算机或网络上的目录中选择要下载的 NVSRAM 文件，请单击 Browse。

4. 单击 OK。固件将开始下载。 Controller Firmware Upgrade 窗口中会显示状态栏。

下载了固件文件之后，固件将开始激活过程，控制器固件升级工具中的状态栏中会显
示状态 Activating。

注：固件激活过程最多需要 30 分钟完成。如果 30 分钟后，Activating 状态消息未发
生变化，请使用 Storage Manager 10 软件来检查控制器概要文件数据，确定固件
下载是否成功完成。
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查看控制器固件升级工具日志文件
如果在更新控制器固件时遇到任何问题，请完成以下步骤以查看控制器固件升级工具
日志文件：

1. 单击 View Log。这时将打开 View Log 窗口。该日志记录了存储子系统存在的可
能阻止更新固件的任何问题。

2. 如果日志中记录了任何问题，请在尝试下载固件之前先纠正这些问题。
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附录 C. Solaris 故障转移驱动程序

故障转移驱动程序将监视 I/O 路径。如果一个光纤通道路径中的某个组件出现故障，故
障转移驱动程序会将所有 I/O 重新传递到其他路径。

Solaris 主机系统需要 Solaris Multiplexed I/O（MPxIO）故障转移驱动程序。

安装 MPxIO 驱动程序
Multiplexed I/O（MPxIO）是一个 Sun Solaris 多路径驱动程序体系结构。该故障转移驱
动程序使得可以通过单个存储阵列实例的多个主机控制器接口访问存储阵列。MPxIO 有
助于保护存储子系统，避免其因控制器故障而停止运作。如果一个控制器发生故障，
MPxIO 会自动切换至备用控制器。MPxIO 已完全整合到 Solaris 10 操作系统中。

要获取更多信息，请转至 http://sun.com/docs 并查看以下 Sun 文档：

v Sun Solaris Fibre Channel and Storage Multipathing Administration Guide

v Setting Up Solaris iSCSI Multipathed Devices

针对 MPxIO 的设备名更改注意事项
在 /dev 和 /devices 树中，启用 MPxIO 时设备的名称与其初始名称不同。例如：

禁用 MPxIO 时的设备名

/dev/dsk/c1t1d0s0

启用 MPxIO 时的设备名

/dev/rdsk/c0t600A0B800011121800006B31452CC6A0d0s2

必须配置直接使用设备的应用程序，以便不论是启用还是禁用 MPxIO 配置都使用新名
称。

另外，/etc/vfstab 文件和转储配置也包含对设备名的引用。在使用 stmsboot 命令启用
或禁用 MPxIO 时，如接下来的部分所述，会自动使用新的设备名更新 /etc/vfstab 和转
储配置。

下载最新的 MPxIO 驱动程序版本
MPxIO 已完全整合到 Solaris 10 操作系统中，无需单独安装。使用定期的 Solaris 10

补丁更新其带有的 MPxIO，这些补丁位于：http://sun.com/sunsolve。

注：安装定期的内核 jumbo 补丁，这是因为构成驱动程序堆栈的不同补丁之间存在依赖
性。

启用 MPxIO 故障转移驱动程序
可以通过使用 stmsboot 命令启用 MPxIO。 Stmsboot 命令还会在下一次重新启动
期间更新 /etc/vfstab 文件和转储配置文件中的设备名。

注：在 Solaris 10 中，stmsboot 命令用于在所有设备上启用或禁用 MPxIO。
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开始之前：

1. 安装 Solaris 操作系统和最新的补丁。

2. 定义主机时，确保选择 Solaris 作为主机类型。

3. 牢记 stmsboot -e [enable] -d [disable] and -u [update] 的以下注意事项：

v 在运行 stmsboot 命令时，必须选择 Reboot the system now（缺省值）。

v Stmsboot 命令在修改原有 /kernel/drv/fp.conf 和 /etc/vfstab 文件之前会先保存其
副本，因此您可以使用已保存的文件从任何意外的问题中进行恢复。

v 确保将 eeprom 引导设备设置为从当前引导设备启动。

要在所有 I/O 设备上启用 MPxIO，请完成以下步骤：

1. 运行 stmsboot -e 命令，并选择 y（缺省值）以重新启动系统：

# stmsboot -e

WARNING: This operation will require a reboot.
Do you want to continue ? [y/n] (default: y) y
The changes will come into effect after rebooting the system.
Reboot the system now ? [y/n] (default: y) y

注：在重新启动期间，将更新 /etc/vfstab 和转储配置以反映设备名的更改。

2. 重新启动后，配置您的应用程序以使用新的设备名，如第 115页的『针对 MPxIO 的
设备名更改注意事项』中所述。

3. 如有必要，编辑 /kernel/drv/fp.conf 配置文件以确保设置了以下参数：

mpxio-disable=”no”;

编辑 /kernel/drv/scsi_vhci.conf 配置文件以确保设置了以下参数：

load-balance=”none”;
auto-failback=”enable”;

4. 如果在上一步骤中对配置文件进行了任何更改，请保存文件，并通过输入以下命令
重新启动服务器：

# shutdown -g0 -y -i6

5. 如有需要，请更新 HBA 固件。

6. 创建 DS3000 逻辑驱动器，并将它们映射到 Sun 服务器中的主机端口。

验证设备并为映射的 LUN 配置故障转移/自动恢复路径
要验证设备并为映射的 LUN 配置故障转移路径，请完成以下步骤：
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1. 使用 cfgadm –al 命令来验证设备，以显示有关主机端口及其所连接设备的信息。

# cfgadm -al
Ap_Id Type Receptacle Occupant Condition
PCI0 vgs8514/hp connected configured ok
PCI1 unknown empty unconfigured unknown
PCI2 unknown empty unconfigured unknown
PCI3 mult/hp connected configured ok
PCI4 unknown empty unconfigured unknown
PCI5 unknown empty unconfigured unknown
PCI6 unknown empty unconfigured unknown
PCI7 mult/hp connected configured ok
PCI8 mult/hp connected configured ok
c0 scsi-bus connected configured unknown
c0::dsk/c0t6d0 CD-ROM connected configured unknown
c1 fc-private connected configured unknown
c1::500000e0106fca91 disk connected configured unknown
c1::500000e0106fcde1 disk connected configured unknown
c1::500000e0106fcf31 disk connected configured unknown
c1::500000e0106fd061 disk connected configured unknown
c1::500000e0106fd7b1 disk connected configured unknown
c1::500000e0106fdaa1 disk connected configured unknown
c1::50800200001d9841 ESI connected configured unknown
c2 fc-fabric connected configured unknown
c2::201400a0b811804a disk connected configured unusable
c2::201400a0b8118098 disk connected configured unusable
c2::201700a0b8111580 disk connected configured unusable
c3 fc-fabric connected configured unknown
c3::201500a0b8118098 disk connected configured unusable
c3::201600a0b8111580 disk connected configured unusable
c3::202500a0b811804a disk connected configured unusable
c4 fc-fabric connected configured unknown
c4::200400a0b80f1285 disk connected configured unknown
c4::200400a0b8127a26 disk connected configured unusable
c5 fc-fabric connected configured unknown
c5::200400a0b82643f5 disk connected unconfigured unknown
c5::200500a0b80f1285 disk connected configured unknown
c5::200500a0b8127a26 disk connected configured unusable
c5::200c00a0b812dc5a disk connected configured unknown
usb0/1 usb-kbd connected configured ok
usb0/2 usb-mouse connected configured ok
usb0/3 unknown empty unconfigured ok
usb0/4 unknown empty unconfigured ok
#

2. 您还可以显示有关系统上的连接点的信息。在以下示例中，c0 表示光纤连接的主机
端口，c1 表示回路连接的专用主机端口。（使用 cfgadm 命令来管理光纤连接的主
机端口上的设备配置。）

缺省情况下，回路连接的专用主机端口上的设备配置由 Solaris 主机管理。

注：cfgadm -1 命令显示有关光纤通道主机端口的信息。您还可以使用 cfgadm -al
命令来显示有关光纤通道设备的信息。在 Ap_ID 字段中包含端口全球名称
（WWN）且与 c0 关联的行表示光纤设备。使用 cfgadm configure 和
cfgadm unconfigure 命令来管理那些设备，并使它们可用于 Solaris 主机。

# cfgadm -l
Ap_Id Type Receptacle Occupant Condition
c0 fc-fabric connected unconfigured unknown
c1 fc-private connected configured unknown
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3. 使用以下命令配置设备：

cfgadm –c configure Ap-Id

Ap_ID 参数指定所配置光纤通道设备的连接点标识。该标识可以是设备的控制器编
号和 WWN（例如，c3::50020f230000591d）。

请参阅步骤 第 117页的 1 中的输出示例。同时也可以参阅 cfgadm 联机帮助页，了
解连接点的说明。

注：类型为 fc-private 的 Ap_Id 不能取消配置。只有类型 fc-fabric 可以进行
配置或取消配置。

4. 使用 luxadm probe 命令列出所有已映射的 LUN：

# luxadm probe
luxadm probe
No Network Array enclosures found in /dev/es

Node WWN:200400a0b8111218 Device Type:Disk device
Logical Path:/dev/rdsk/c0t600A0B800011121800006ADE452CBC62d0s2

Node WWN:200400a0b8111218 Device Type:Disk device
Logical Path:/dev/rdsk/c0t600A0B800011121800006ADF452CBC6Ed0s2

Node WWN:200400a0b8111218 Device Type:Disk device
Logical Path:/dev/rdsk/c0t600A0B800011121800006AE0452CBC7Ad0s2

Node WWN:200400a0b8111218 Device Type:Disk device
Logical Path:/dev/rdsk/c0t600A0B800011121800006AE1452CBC88d0s2

Node WWN:200400a0b8111218 Device Type:Disk device
Logical Path:/dev/rdsk/c0t600A0B800011121800006AE2452CBC94d0s2

Node WWN:200400a0b8111218 Device Type:Disk device
Logical Path:/dev/rdsk/c0t600A0B800011121800006AE3452CBCA0d0s2

Node WWN:200400a0b8111218 Device Type:Disk device
Logical Path:/dev/rdsk/c0t600A0B800011121800006AE4452CBCACd0s2

Node WWN:200400a0b8111218 Device Type:Disk device
Logical Path:/dev/rdsk/c0t600A0B800011121800006AE5452CBCB8d0s2

Node WWN:200400a0b8111218 Device Type:Disk device
Logical Path:/dev/rdsk/c0t600A0B800011121800006AE6452CBCC4d0s2

Node WWN:200400a0b8111218 Device Type:Disk device
Logical Path:/dev/rdsk/c0t600A0B800011121800006AE7452CBCD2d0s2

Node WWN:200400a0b8111218 Device Type:Disk device
Logical Path:/dev/rdsk/c0t600A0B800011121800006AE8452CBCDEd0s2

Node WWN:200400a0b8111218 Device Type:Disk device
Logical Path:/dev/rdsk/c0t600A0B800011121800006AE9452CBCEAd0s2

Node WWN:200400a0b8111218 Device Type:Disk device
Logical Path:/dev/rdsk/c0t600A0B800011121800006AEA452CBCF8d0s2

Node WWN:200400a0b8111218 Device Type:Disk device
Logical Path:/dev/rdsk/c0t600A0B800011121800006AEB452CBD04d0s2

Node WWN:200400a0b8111218 Device Type:Disk device
Logical Path:/dev/rdsk/c0t600A0B800011121800006AEC452CBD10d0s2

Node WWN:200400a0b8111218 Device Type:Disk device
Logical Path:/dev/rdsk/c0t600A0B800011121800006AED452CBD1Ed0s2

Node WWN:200400a0b8111218 Device Type:Disk device
Logical Path:/dev/rdsk/c0t600A0B800011121800006B2A452CC65Cd0s2

Node WWN:200400a0b8111218 Device Type:Disk device
Logical Path:/dev/rdsk/c0t600A0B800011121800006B2B452CC666d0s2

Node WWN:200400a0b8111218 Device Type:Disk device
Logical Path:/dev/rdsk/c0t600A0B800011121800006B2C452CC670d0s2

Node WWN:200400a0b8111218 Device Type:Disk device
Logical Path:/dev/rdsk/c0t600A0B800011121800006B2D452CC67Ad0s2

Node WWN:200400a0b8111218 Device Type:Disk device
Logical Path:/dev/rdsk/c0t600A0B800011121800006B31452CC6A0d0s2

Node WWN:200400a0b8111218 Device Type:Disk device
Logical Path:/dev/rdsk/c0t600A0B800011121800006B32452CC6ACd0s2

Node WWN:200400a0b8111218 Device Type:Disk device
Logical Path:/dev/rdsk/c8t201400A0B8111218d7s2
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5. 然后，可以使用 luxadm display logical path 命令列出有关每个已映射的 LUN 的
更多详细信息，包含到达每个 LUN 的路径数。以下示例使用了之前示例中的逻辑路
径。

# luxadm display /dev/rdsk/c0t600A0B800011121800006B31452CC6A0d0s2
DEVICE PROPERTIES for disk: /dev/rdsk/c0t600A0B800011121800006B31452CC6A0d0s2

Vendor: IBM
Product ID: 1742-900
Revision: 0914
Serial Num: 1T51207691
Unformatted capacity: 1024.000 MBytes
Write Cache: Enabled
Read Cache: Enabled

Minimum prefetch: 0x0
Maximum prefetch: 0x0

Device Type: Disk device
Path(s):

/dev/rdsk/c0t600A0B800011121800006B31452CC6A0d0s2
/devices/scsi_vhci/ssd@g600a0b800011121800006b31452cc6a0:c,raw
Controller /devices/pci@7c0/pci@0/pci@8/SUNW,qlc@0,1/fp@0,0
Device Address 201400a0b8111218,1e
Host controller port WWN 210100e08ba0fca0
Class secondary
State STANDBY
Controller /devices/pci@7c0/pci@0/pci@8/SUNW,qlc@0,1/fp@0,0
Device Address 201500a0b8111218,1e
Host controller port WWN 210100e08ba0fca0
Class primary
State ONLINE
Controller /devices/pci@7c0/pci@0/pci@8/SUNW,qlc@0/fp@0,0
Device Address 201400a0b8111218,1e
Host controller port WWN 210000e08b80fca0
Class secondary
State STANDBY
Controller /devices/pci@7c0/pci@0/pci@8/SUNW,qlc@0/fp@0,0
Device Address 201500a0b8111218,1e
Host controller port WWN 210000e08b80fca0
Class primary
State ONLINE

#

取消配置故障转移/自动恢复路径
在取消配置光纤设备之前，停止针对该设备的所有活动，并卸装该光纤设备上的所有
文件系统。（请参阅 Solaris 管理文档，了解卸装过程。）

要取消配置故障转移/自动恢复路径，请完成以下步骤：

1. 运行 cfgadm -al 命令，以显示有关主机端口及其所连接设备的信息。

2. 通过运行以下命令来取消配置 LUN：

cfgadm –c unconfigure Ap-Id

其中 Ap-Id 是希望取消配置的 LUN。

3. 再次运行 cfgadm -al 命令，以确保 LUN 现在已取消配置。

4. 如有必要，请使用 newfs 命令定义文件结构。将条目添加到 /etc/vfstab 文件中。
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5. 使用以下命令来重新启动服务器：

# shutdown -g0 -y -i6

禁用 MPxIO 多路径驱动程序
对于 Solaris 10，通过输入 cfgadm –c unconfigure AP-id Ap-id 命令来取消配置所有
设备。然后，输入 stmsboot –d 命令，并接收缺省值为 Reboot the system now。
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附录 D. 辅助功能选项

本部分提供备用键盘导航的相关信息，这是 DS3000 Storage Manager 软件的一个辅助
功能选项。辅助功能选项可以帮助有生理残障（如行动不便或视力不佳）的用户正常
使用软件产品。

使用本部分描述的备用键盘操作，您可以使用键或组合键执行 Storage Manager 任务，
以及执行鼠标也可以完成的许多菜单操作。

除了本部分描述的键盘操作外，DS3000 Storage Manager 2 软件 Windows 安装包还包
含一个屏幕朗读器软件界面。要启用屏幕朗读器，请在 Windows 主机或管理站上使用
安装向导安装 Storage Manager 2 软件时选择 Custom Installation。然后，在 Select

Product Features 窗口中选择 Java Access Bridge 以及其他必需的主机软件组件。

帮助查看器窗口的窗格中有时可能无法清晰显示键盘焦点。如果看不清键盘焦点的位
置，请按 Ctrl+F1。如果焦点在工具栏中的 Back、Forward、Print 或 Page Setup 按钮
上，将显示相应按钮的备用文本。如果未显示备用文本，表示键盘焦点不在按钮上。
按 Ctrl+Tab 查看焦点是否在某个导航器选项卡上（Contents 选项卡、Index 选项卡
或 Search 选项卡）。如果焦点在某个导航选项卡上，请按 Shift+Tab 将焦点切换到工
具栏窗格。

表 10 定义可用于浏览、选择或激活用户界面组件的键盘操作。此表中使用以下术语：

v 浏览表示将输入焦点从一个用户界面组件移至另一个。

v 选择表示选择一个或多个组件，通常之后将进行操作。

v 激活表示执行组件操作。

组件之间的导航通常需要使用以下键：

v Tab：将键盘焦点移至下一个组件或下一组组件中的第一个组件

v Shift+Tab：将键盘焦点移至上一个组件或上一组组件中的第一个组件

v 方向键：将键盘焦点在一组组件中的各组件之间移动

表 10. DS3000 Storage Manager 软件的备用键盘操作

快捷键 操作

F1 打开帮助。

F10 将键盘焦点移至主菜单栏并显示第一个菜单；使用方向键
浏览可用选项。

Alt+F4 关闭管理窗口。

Alt+F6 在窗口（非模态）和管理窗口之间移动键盘焦点。

Alt+underlined_letter 使用加下划线的字母的相关键访问菜单项、按钮和其他界
面组件。

对于菜单选项，可按 Alt+ 加下划线的字母访问主菜单，然
后按加下划线的字母访问个别菜单项。

对于其他界面组件，可按 Alt+ 加下划线的字母。

Ctrl+F1 当键盘焦点在工具栏上时，显示或隐藏工具提示。

空格键 选择某项或激活某个超链接。
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表 10. DS3000 Storage Manager 软件的备用键盘操作 (续)

快捷键 操作

End、Page Down 将键盘焦点移至列表中的最后一项。

Esc 关闭当前窗口（不需要键盘焦点）。

Home、Page Up 将键盘焦点移至列表中的第一项。

Shift+Tab 在各组件之间反向移动键盘焦点。

Ctrl+Tab 将键盘焦点从一个表移至下一个用户界面组件。

Tab 在各组件之间浏览键盘焦点或选择超链接。

向下箭头 在列表中将键盘焦点向下移动一项。

向左箭头 向左移动键盘焦点。

向右箭头 向右移动键盘焦点。

向上箭头 在列表中将键盘焦点向上移动一项。
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附录 E. 获取帮助和技术协助

如果您需要帮助、服务或技术协助，或者仅希望了解有关 IBM 产品的更多信息，则可
从 IBM 找到各种可用的资源来帮助您。本部分包含以下信息：到何处寻找有关 IBM 和
IBM 产品的更多信息，在系统出现问题时该采取什么措施，以及在需要时该向谁请求服
务。

致电请求服务之前
在致电请求服务之前，请确保已采取以下步骤来尝试自行解决问题：

v 检查所有电缆，确保其已连接。

v 检查电源交换器，确保系统和任何可选设备已打开。

v 使用系统文档中的故障诊断信息，并使用系统随附的诊断工具。有关诊断工具的信
息位于系统随附的 IBM 文档 CD 上的《问题确定与维护指南》中。

v 请转至 IBM 支持 Web 站点 http://www.ibm.com/systems/support/ 查看技术信息、技
巧、提示和新的设备驱动程序或提交请求以获取信息。

通过遵循 IBM 在联机帮助或 IBM 产品文档中提供的故障诊断过程，您无需外界帮助
就可以解决许多问题。IBM 系统随附的文档还描述了您可以执行的诊断测试。大多数系
统、操作系统和程序都随附有包含故障诊断过程以及错误消息和错误代码解释的文
档。如果怀疑有软件问题，请参阅操作系统或程序的文档。

使用文档
您可以通过产品随附的文档了解有关 IBM 系统和预装软件（如果有）或可选设备的信
息。这些文档包括印刷文档、联机文档、自述文件和帮助文件。有关使用诊断程序的
说明，请参阅系统文档中的故障诊断信息。故障诊断信息或诊断程序可能会告诉您还
需要其他或更新的设备驱动程序或其他软件。您可以从万维网上 IBM 维护的页面中获
取最新的技术信息并下载设备驱动程序和更新。要访问这些页面，请转至 http://

www.ibm.com/systems/support/ 并按照指示信息进行操作。另外，某些文档可以通过位于
http://www.ibm.com/shop/publications/order/ 上的 IBM Publications Center 获得。

从万维网获取帮助和信息
在万维网上，IBM Web 站点提供有关 IBM 系统、可选设备、服务和支持的最新信息。
有关 IBM System x 和 xSeries® 的信息位于 http://www.ibm.com/systems/x/。有关 IBM

BladeCenter 的信息位于 http://www.ibm.com/systems/bladecenter/。有关 IBM IntelliStation®

的信息位于 http://www.ibm.com/intellistation/cn。

您可以在 http://www.ibm.com/systems/support/ 查找IBM 系统和可选设备的服务信息。

软件服务和支持
通过 IBM 支持热线，您可以获取付费电话支持，得到有关 System x 和 xSeries 服务
器、BladeCenter 产品、IntelliStation 工作站和设备的使用、配置及软件问题的帮助。有
关您所在国家或地区支持热线支持哪些产品的信息，请访问 http://www.ibm.com/support/

cn/。
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有关支持热线和其他 IBM 服务中心的更多信息，请访问 http://www.ibm.com/

support/cn 或 http://www.ibm.com/planetwide/cn 以获取支持电话号码。在中国，请拨打
免费咨询热线 800-810-1818 转 5300 或 010-84981188 转 5300 查询相关信息。

硬件服务和支持
您可通过 IBM 经销商或服务中心获得硬件服务。要查找 IBM 授权经销商提供的保修
服务，请访问 http://www.ibm.com/partnerworld/ ，然后单击页面右边的 Find a Busi-
ness Partner。要获取 IBM 支持电话号码，请参阅 http://www.ibm.com/planetwide/。
在中国，请拨打免费咨询热线 800-810-1818 转 5300 或 010-84981188 转 5300 查询
相关信息。

在中国，硬件服务和支持一般为每周 5 天，每天上午 8:30 至下午 5:30（国家法定节
假日除外）。为获得电话技术支持，客户需要首先拨打 IBM 技术支持电话；在 IBM 技
术人员通过电话进行故障诊断后认为必要时，IBM 将根据与您签署的服务协议的条款安
排您系统的维修事宜。

IBM 台湾产品服务

IBM 台湾产品服务联系信息：
IBM Taiwan Corporation

中国台湾台北市
松仁路 7 号 3 楼
电话：0800-016-888
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附录 F. 声明

本信息是为在美国提供的产品和服务编写的。

在其他国家或地区，IBM 可能不提供本文档中所讨论的产品、服务或功能。有关您目前
所在国家或地区的产品和服务的信息，请向您当地的 IBM 代表咨询。任何对 IBM 产
品、程序或服务的引用并非意在明示或默示只能使用 IBM 的产品、程序或服务。只要
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